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1. Introduction

The examples in this manual can be made in a full licensed as well as in a tryout or student version of
SCIA Engineer.

Here follows an overview of the required SCIA Engineer modules / editions, per subject:

- Eigen frequency calculations
esas.21 (Dynamics (natural frequencies) - Frames) Professional edition
esas.22 (Dynamics (natural frequencies) - Surfaces) Professional edition

- Advanced dynamic calculations
esas.23 (Dynamics (advanced) - Frames) Professional edition
esas.24 (Dynamics (advanced) - Surfaces) Professional edition

- Non uniform damping characteristics
esas.25 (Non uniform damping - Frames) Not part of an edition

Dynamic calculations are not so frequent in civil engineering as static calculations. On the other hand,
they are inevitable in certain projects. Wind effects on high-rise structures, transverse vibration of
towers and chimneys, structures located in seismic regions,...

SCIA Engineer contains specialized modules covering common dynamics-related issues. In this
course, the different aspects of these modules are regarded in detail.

First, the foundation of dynamic calculations is examined: the eigen frequency calculation. Eigen
frequencies form the basis for all types of dynamic analysis.

In the third chapter the eigen frequency calculation is extended with harmonic loads: the influence of
for example vibrations due to machinery, can be calculated using these principles.

Two chapters are devoted to seismic calculations and the influence of damping on the seismic action.
The final chapter of the course discusses the aspects of Vortex Shedding, used for example to
calculate chimneys.

All chapters are illustrated with examples. The relatively easy examples have been purposefully
chosen to provide a clear understanding of what actually happens in the dynamic calculations. To this
end, nearly all calculations have been verified by manual calculations to give a good insight into the
application of the theory in SCIA Engineer.

When the principles are clearly understood, they can be applied to more complex structures without
difficulties.

The project files can be found on the accompanying CD and have been divided into two groups:

- Initial Projects: The project files without the dynamic input, used throughout the course.

- Final Projects: The project files completed with the dynamic calculations, thus representing the final
results at the end of the course.
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In this chapter, the calculation of eigen frequencies in SCIA Engineer is explained in detail.
Eigen frequencies can be required to verify comfort criteria for buildings, to analyze wind-
induced resonance for bridges, to check requirements for sensitive equipment,...

First, the theory behind the calculation is discussed and illustrated with an example. The
procedure is then used for both frame and slab structures. The results of all examples are
compared with manual calculations to provide a clear understanding of the applied principles.

2.1 Theory

To understand what is going on during the dynamic analysis of a complex structure with frames
or finite elements, the free vibration of a SDOF (Single Degree Of Freedom) system is regarded
in detail. A complete overview can be found in reference [1].

Consider the following system:

A body of mass m is free to move in one direction. A spring of constant stiffness k, which is fixed
at one end, is attached at the other end to the body.
The equation of motion can be written as:

m-y(D)+k- y(t) =0 @1)
A solution for this differential equation is: y(t) = A-cos(w-t)
Inserting this in (2.1) gives:

(-m-w* + k)-A-cos(w-t) = 0 2.2)
This implies that:

k
w = — (2.3)
m
Where ¢ is called the natural circular frequency.

The natural period T can be written as:

T - Z 2.4)
@
The natural frequency (or eigen frequency) f can be written as:
f -1 _ o (2.5)
T 2

For a general, MDOF (Multiple Degree Of Freedom) structure, equation (2.1) can be written in
matrix notation:

M-U+K-U=0 (2.6)

Where: U is the vector of translations and rotations in nodes,
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U is the vector of corresponding accelerations,

K is the stiffness matrix assembled for the static calculation,

M is the mass matrix assembled during the dynamic calculation.
From this equation it is clear that the calculation model created for a static analysis needs to be
completed with additional data: masses.
The solutions of (2.6) are harmonic functions in time. A possible solution can have the following
form:

U = ®-sin(e-(T-T,)) 2.7)
Notice that in this solution a separation of variables is obtained:
- Thefirst part, (D), is a function of spatial co-ordinates,

- The second part,sin(@- (T —T,)), is a function of time.

When substituting (2.7) in (2.6), an equation is obtained which is known as the Generalized
Eigenproblem Equation:

K®d - oM -d= 0 (2.8)

The solution of (2.8) yields as many eigenmodes as there are equations.
Each eigenmode consists of 2 parts:

- Aneigenvalue: value o,

- An eigenvector: vector CDi , which is not fully determined. The deformation shape

is known, but the scale factor is unknown.
This scale factor can be chosen in different ways. In the next paragraph this will be explained
further.

An overview of the mathematical (matrix) approach behind the calculation of eigenvalues and
eigenvectors can be found in reference [25].



2.2 Eigen Frequencies in SCIA Engineer

In SCIA Engineer, as scale factor, a M-orthonormalisation has been implemented. This is
shown in the following relation:

o M- ®, =1 (2.9)
Some of the characteristics of M-orthonormalisation are:

@ -M-®; = 0,When i# ] (2.10)

O -K-O, = o (2.11)
The M-matrix (the mass matrix) can be computed in different ways. SCIA Engineer uses the so-
called lumped mass matrix representation of the M-matrix. The lumped mass matrix offers
considerable advantages with respect to memory use and computational effort because in this
case the M-matrix is a diagonal matrix. The masses are thus guided to the nodes of the Finite
Element mesh.

This principle is illustrated on the following figure [28]:

| | | | | M=3m

b @ @ |
¢ m & i

The calculation of eigenmodes and eigen frequencies is thus made on a discretised finite
element model of the structure. This means that instead of a general structure with an infinite
number of degrees of freedom, a calculation model with a finite number of degrees of
freedom is analyzed.

The number of degrees of freedom can generally be determined by a simple multiplication: the
number of mesh nodes is multiplied by the number of possible displacements in the node.

It is important to know that the accuracy of the model is in proportion to the "precision of
discretisation", i.e. to the number of elements of the finite element mesh. This refinement has
almost no practical meaning in static calculations. However, for dynamic and non-linear
analyses, it significantly affects the accuracy of the results.

Consider the following example. A beam on two supports is loaded by its self-weight. By default
(for a static calculation) there is only one finite element for the beam. Taking the above into
account, the mass M of the beam will be guided to the two end nodes of the beam since these
correspond with the mesh nodes of the finite element mesh.

M/ 2 M/ 2

o N

In this case, this means that the entire mass will be located in the supports so no mass can go
into vibration and the dynamic calculation cannot be executed. As indicated, a mesh refinement
is required here to attain results.
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The following diagram shows the required steps to perform a Free Vibration calculation:

Activate the Dynamics functionality

l

Create a Mass Group

Input Masses Generate Masses from Static Load cases

o~ =

Create a Mass Combination

'

Refine the Finite-Element Mesh if required

'

Specify the number of Eigenmodes to be calculated

'

Perform a Free Vibration Calculation

The analogy between a static and dynamic calculation is clear:

- In a static calculation, Loads are grouped in Load cases and the Load cases are used in
Combinations.

- Inadynamic calculation Masses are grouped in Mass Groups and the Mass Groups are
used in Mass Combinations.

The required steps from this diagram are illustrated in the following example.

10



Example 2-1: Free_Vibration_1.esa

In this example, a beam on two supports is modeled. The beam has a cross-section type IPE
200, a length of 6m and is manufactured in S235 according to EC-EN. A node has been added
to the middle of the beam, which will make it possible to add a nodal mass in that location.

IPE200

6000

Only one static load case is created: the self weight of the beam.

Step 1: Functionality

The first step in the Dynamic calculation is to activate the functionality Dynamics on the
Functionality tab in the Project Data.

Project data ﬁ

Basic data Functionality | Actions Protection

S(I:Ii”alll ||I Dynamics 4 +| |Z Dynamics

Enginesr Initial stress Seismic
Subsoil Harmonic band analysis
Monlinearity General dynamics
Stability Maon proportional damping
Climatic loads = Steel
Prestressing Fire resistance
Pipelines Connection modeller
Structural model E Frame rigid connections
BIM properties Frarne pinned connections
Parameters Grid pinned connections

When this is done, a new group will appear in the Main menu:
Kain o =

----- Project

H# Line grid and storeys
..... 88 BIM toolbox

5 Structure

.h] Load

[3--@ Load cases, Combinations
=-f&) Design groups

[=- - Dynamics
e @ Masses >:|
: " D i
b JW* Mass groups ynamies

e J#* Combination of mass groups

-[ Calculation, mesh

_[FlE| Design Forme Checks
----- Engineering report
m-ff Drawing Tools

5B Libraries

[}ﬁ Tools

11
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Step 2: Mass group

The second step is to create a Mass Group.
.

B | Mass groups @

KL < Sl=E A -
Description
Bound to load case Yes -
Load case LCT - Self Weight T .

Keep masses up-to-date with loads

Actions

Create masses from load case o
| Mew || [nzert || Edit || Delete | | Cloze |
. )

As indicated in the diagram, a Mass Group is used to group masses in a same way a Load Case
is used to group Loads. When a Mass Group is defined, masses can be inputted.
SCIA Engineer also allows the user to create masses from a static load case.

When for example a roof weight is inputted as line loads, the action “Create masses from load
case” will automatically generate masses from these line loads. It is clear that this provides a
quick input of necessary data. When the option “Keep masses up-to-data with loads” is ticked
on, then the action to create masses will create masses which remain linked to the loads of the
load case. The amount of mass in a ‘linked’ mass is updated each time you click on the action
button “Create masses from load case” or each time you perform a calculation.

Note:

- The self-weight of a structure is always taken into account automatically for a dynamic calculation.
Even if there is no mass group linked to self weight. The mass of the self-weight is not displayed.

- When specifying a load case but not using the action ‘Create masses from load case’ nothing will
happen: no masses will be created.

- When creating masses from loads, SCIA Engineer will use the acceleration of gravity specified on the
Loads tab of the Project Data. By default this value is 9,81 m/s2.

- The mass is generated only from vertical force components.

- Free loads cannot be converted into masses.

Step 3: Masses

When Mass Groups are created, Masses can be inputted on the structure. SCIA Engineer
allows the input of

- Massin node

- Point mass on beam

- Line mass on beam

- Surface mass

- Line mass on surface edge

- Point mass on surface edge

12



For 1D members: For 2D members:

Masses =
MG1 a| BN
Masses bt
. 1
Mass in node MG1 |

=#= Ppint mass on beam
-3 | ine mass on beam

- @ Mass in node

& Surface mass

-~ |ine mass on surface edge
“-=a= Point mass on surface edge

Close

In this example, a mass of 500 kg will be inputted on the middle node of the beam using Mass
in node.

[ B Mass in node &J
Mame M3
5000

Koeff mx 1
Koeff my 1
Koeff mz 1
Irnx [kgm*2] 0,0
Imy [kgm*2] 0,0

._ ,H\/ Imz [kgm 2] 0,0

|~ OK-—[] Cancel [

b

The parameters Koeff mx, Koeff my and Koeff mz specify how much of the mass will
participate in the vibration according to the global X, Y or Z axis.

This can be used when calculating for example a chimney: when Koeff mx is put on 1 and Koeff
my and Koeff mz are taken 0, then the mass can only vibrate in the global X-direction so only
eigenmodes in that direction will be obtained.

Imx, Imy and Imz specify the moment of inertia around the global X, Y or Z axis. By default a
nodal mass is concentrated so it has no inertia. When the mass represents a large machine, it is
possible to input the moment of inertia of this machine.

13
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The nodal mass of 500 kg is inputted on the middle node of the beam:

500.0

5 )

N

Note:

- To display masses and mass labels, go to Set View Parameters For All > Loads/Masses.
- Masses are Additional Data, which can be moved/copied to other entities.

Step 4: Mass matrix

Next, the Mass groups can be combined within a Combination of Mass Groups.
This is actually the mass matrix M which has been mentioned in the beginning of this chapter.

rl Combkinations of mass groups @1
KL 4 9 | & A v
[Name e
Description
= Contents of combination
MGEL [-] 1,00
| New || Insert || Edit || Delete | | Close |

| ™

The Combination of Mass Groups works in the same way as a linear Load Combination.

A multiplication coefficient can be inputted for each Mass Group. This coefficient can be used
when the mass of a structure changes during its lifetime. Consider for example a water tank.
One Combination of Mass Groups can be created with a coefficient 1,00 to specify a full tank
and another Combination of Mass Groups can be created with a coefficient 0,50 to specify a
tank, which is half-full. In this way, both cases can be calculated in one time. As stated in step 2:
the self-weight is automatically taken into account for each Combination of Mass Groups.

Step 5: Mesh setup

After executing the previous steps, the calculation can already be started. However, as stated in
2.2 it can be required to refine the Finite Element mesh.
This can be done through Calculation, Mesh > Mesh Setup.

14



B Mesh setup @

Mame

= General mesh settings

Minimal distance between two points [m] 0,001
Average number of tiles of 1d element 1

Average size of 2d element/curved element [m] 1,000
Definition of mesh element size for panels Autemnatic
Average size of panel element [m] 1,000
Elastic mesh

= 1D elements

Minimal length of beam element [m] 0,100
Maximal length of beamn element [m] 100,000
Average size of cables, tendons, elements on subseil, nenlinear soil spring [m] 1,000
Generation of nodes in cennections of beam elements v

Generation of nodes under concentrated loads on beam elements

Generation of eccentric elements on members with variable height

Division on haunches and arbitrary members 5
Division for 2D-10 upgrade 50
Mesh refinement foellowing the beam type MNone

Hanging nodes for prestressing

———@ i o] |'| Cancel '_

For 1D members (beams) the Average number of tiles of 1D element can be augmented. In
general, 5 to 10 tiles are sufficient for a dynamic calculation. When specifying a too high amount,
the calculation will take a long time to complete. For 2D elements (plates & shells) the Average
size of 2D element needs to be altered.

Scia Engineer 15.0.79 =S

In this example, due to the inserting of the middle node,
there is already a mesh node there, so it is not required
to have a denser Finite Element Mesh.

This can be seen after mesh generation & Mesh generatior 0,

Mesh successfully created
Murmber of nodes: 3

Mumber of 2D elements: 0
Mumber of 10 elements: 2

The created mesh elements and mesh nodes are shown with their number:

™

jL'\ N 2,

Note:

- To display the numbering of finite elements:
1. Go to Set View Parameters For All > Structure > Mesh and tick Draw mesh on.
2. Go to Set View Parameters For All > Labels > Mesh and tick Display Label & Elements 1D on.

15
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Step 6: Solver Setup

Another important step before launching the calculation is to specify the amount of eigenmodes
that need to be calculated and with which method they can be calculated.
This can be done through Calculation, Mesh > Solver Setup.

“
B Solver setup @

MName

= General
Run one nonlinear combination
Meglect shear force deformation ( Ay, Az =» A)
Type of solver Direct -
Mumber of sections on average member 10
Warning when maximal translation is bigger than [rmm] 10000

Warning when maximal rotation is bigger than [rrad] 100,0
W

Print time in Calculation Protocol
Cocfficient for reinforcement 1
= Dynamics
Type of eigen value solver Lanczos
1

MNumber of eigenmodes
Use IRS (Improved Reduced Systern) method

Produce wall eigenmode results (needed for ECtools)

—_—@ i OK |'| Cancel I_

w

By default, the Lanczos method is used. This method is set as default even in older projects
where originally another method was used. In comparison with older methods, the Lanczos
method is faster and more stable.

As explained above, the number of eigen frequencies is dependent of the number of degrees of
freedom of the structure which are on their turn dependent of the discretisation.

In this example, only the mesh node located in the middle of the beam can vibrate vertically.
Therefore only one eigenmode needs to be calculated. The Number of Frequencies can thus
be lowered to 1.

The options “Use IRS (Improved Reduced System) method” requires floors to be defined first, so

this option cannot be used now. “Produce wall eigenmode results (needed for ECtools)” is only
used if you are using the extra program ECtools to analyse seismic effects in masonry.

Note:

When the number of frequencies is higher than the amount of degrees of freedom, a message will
appear during the calculation, stating the calculation cannot be executed. The solution is to lower the
number of frequencies to be calculated or to apply a mesh refinement so more degrees of freedom are
created.

"-.

FE-Calculation 64 - Warning 2

Mumber of the nonzero numbers in the mass vector
b I % should be at least twice as big as it is.

16



Step 7: Modal Analysis

The last step is to perform the Modal Analysis calculation through
Calculation, Mesh > Calculation.

-~

FE analysis

i

I-I.II |I| |I|| 5”1 . .
gle analysis | Batch analysis
Scia

Enginesar

™ Linear calculation

Manlinear calculation

G

Modal analysis

Linear stability

Concrete - Code Dependent Deflections [CDD

Construction stage analysis

OO0 000 030

b S T I

Monlinear stage analysis
£ Monlinear stability

" Test of input data

Mumber of eigenmodes: 1

Solver setup Mesh setup

OK Cancel

After performing the calculation, the Results menu shows the option Dynamics >Eigen
Frequencies:

Results b4

----- ¥ Displacement of nodes
""" i Deformed Structure
% 3D displacement

ﬂ 3D stress

- £ Supports

Fl-== Beams

=0 Dynamics

itb Eigen frequencies
L5 fcceleration of nodes
-] Bill of material

E;Il Calculation protocol

- 05151
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The preview shows the following result:

Eigen frequencies

N |f omega | omega® |T
[Hz] |[1/s] |[1/s°] |[s]
Mass combination: CM1
1 6,31 (39,67 |1573,66 (0,16

According to this calculation, the natural frequency of the first mode is shown to be 6,31 Hz.

Step 8: Calculation protocol

To view the results in more detalil, it is possible to look at the Calculation Protocol for the Eigen
Frequency calculation:

Properties =
Calculation protocol (1) | = \jﬁ V
Mame Calculation protocel

Linear calculation
Monlinear calculation
Eigen frequency

I/\\Y Buckling

Actions
Preview L
Calculation protocol
Solution of Free Vibration
Number of 2D elements 0
Number of 1D elements 2
Number of mesh nodes 3
Number of equations 18
Combination of mass groups [MC 1 CM1
Number of frequencies 1
Method Lanczos
Type of analysis model Standard
Start of calculation 03.04.2015 11:18
End of calculation 03.04.2015 11:18
Sum of masses
kgl X Yoz
Combination of mass groups 1 |600.68 |0.00 |567.12
Modal participation factors
Mode |Omega Period Freq. Wi / Wi / Wri / Wxi_ R/ |Wyi_ R/ |Wzi R/
[rad/s] [s] [Hz] Wixtot Wytot Wiztot Wixtot R |Wytot R |Spectral
1 35.6705 0.1584 6.3138 0.0000 0.0000 1.0000 0.0000 1.0000 0.0000
0.0000 0.0000 1.0000 0.0000 1.0000 0.0000

18



Now we will go more in detail about the results in the calculation protocol:

Solution of the Free Vibration:
- The model was divided in 2 finite elements, resulting in 3 mesh nodes.
- Each node has a 6 degrees of freedom (X, Y, Z, Rx, Ry, Rz) resulting in 18 equations.
- The combination of mass groups for the results was CM1.
- The number of frequencies set in the solver settings is 1.

- The Lanczos method was used to perform this calculation.

Sum of masses

The Sum of masses shows the amount of mass, which can vibrate for this Combination of Mass

Groups (CM1). In this example, this is governed by the mass of 500 kg and the mass of the
beam.

The mass of the beam can be calculated as follows:
- The beam is an IPE 200 with cross-section A= 0,00285 m?2
- The length of the beam is 6 m
- The volumetric mass of S235 is 7850 kg/m3
5 kg kg
m = 0,00285m” * 7850 — = 22,3725 —
m m

Now to find the total mass, we must assign the masses to the mesh nodes and take into account
the vibrations which are possible:

- Fornode 1: 1,5m + 22,3725 "2 = 3355875 kg
(¥ of the beam mass goes to the left node)

- For node 2: 3,0m = 22,3725%’ + 500kg = 67,1175 kg + 500 kg = 567,1175 kg
(%2 of the beam mass goes to the middle node along with the nodal mass in the node)
- For node 3: 1,5m * 22,3725 “2 = 3355875 kg
(¥ of the beam mass goes to the right node)
~N
i -
/ 1 2 \
X-direction Y-direction Z-direction
Node 1 Fixed (Frame XZ) Fixed
Node 2 567,1175 kg (Frame XZ) 567,1175 kg
Node 3 33,55875 kg (Frame XZ) Fixed
TOTAL 600,67625 kg X 567,1175 kg
Calc. Protocol 600,68 kg 0kg 567,12 kg

As you can see, the sum of masses in the calculation protocol corresponds to the sum of
masses in all mesh nodes, taking into account the degrees of freedom in each node.

It is clear that a denser mesh will provide a more accurate participation of the beam mass.

19
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Modal Participation Factors

The Modal Participation Factors show the amount of mass that is vibrating in a specific
eigenmode as a percentage of the total mass. In this example W.i/W: is equal to 1 which
means that 100% of the mass is vibrating in the vertical direction for the first eigenmode. This
means that in the other degrees of freedom, no mass will be displaced in the Z-direction.

The Wy r/Wyior r is equal to 1 means that this first eigenmode the only eigenmode in which
mass can rotate around the global Y-axis.

As a side note, we must indicate that these results will strongly alter once we use a finer mesh.

Since more nodes will add more degrees of freedom and thus more possible eigenmodes.
These factors will be looked upon in more detail during the Seismic calculations.

Step 9: In this step we will check the eigenmodes

The eigenmode can be visualized through Displacement of Nodes.

Properties ®
Displacement of nodes (1) Y :IY
Mame | Deformation of nodes
Selection All -
Type of loads Mass combinations -
Mass combinations  CML/1-6,31 -
Filter Mo -
Values Deformed mesh -
Extreme Mode -
Actions

E5-%.%
Preview -

- Selection is set to All

- Type of loads is set to Mass Combinations

- For each eigenmode a specific Mass combination can now be chosen.

- The Values field is set to Deformed Mesh so the deformation of the mesh nodes is shown.
- The Values field is set to U; to view the displacement of nodes (Table on the next page)

™~

20



Displacement of nodes

Eigen solution, Extreme : Node

Selection : All

Mass combinations : CM1/1 - 6,31

Modal shapes are dimensionless, units are printed for consistency purposes.

Node Case Ux Uz
[mm] | [mm]
N1 CM1/1-6,31 0,0 0,0
N2 CM1/1-6,31 0,0 0,0
N3 CM1/1-6,31 0,0 -42,0

The result is as expected, the inner node is vibrating. A denser mesh will provide a much better
representation of the Eigenmode. It is important to bear in mind that a vibration is in two
directions: in this case the eigenmode is shown moving up, however half a period later it will be
moving down.

Free vibration gives only the conception of structure properties and allows predicting the
behavior of the structure under time varying load conditions. In nature, each body prefers to
remain in a standstill. If forced to move, it prefers the way requiring minimal energy consumption.
These ways of motion are the eigenmodes.

The eigenmodes do not represent the actual deformation of the structure. They only show
deformation that is "natural” for the structure. This is why the magnitudes of calculated
displacements are dimensionless numbers. The numbers provided are orthonormed, i.e. they
have a particular relation to the masses in the structure. The absolute value of the individual
numbers is not important. What matters is their mutual proportion.

The vibration of the structure can be shown through View > New Animation Window.

p
Animation
B 5 o | ||| Frames per second : 100 Mode of caleulation : sinus -

\ Flay time (s : 1

Activating the option ‘Preset minimal ratio to invert MAX’ will show the actual vibration in both
directions.

Note:

Using CTRL+Right mouse button, the structure can be rotated in the Animation Window.

21
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Manual Calculation

In order to check the results of SCIA Engineer, the eigen frequency of this structure is calculated
by a manual calculation.

Following reference [1], the circular frequency of a beam on two supports with a mass in the
middle can be calculated as follows:

El
o’ =48 VIE (2.7)
With:
o = Circular frequency
E = Modulus of Young
| = Moment of inertia of the beam
L = Length of the beam
M = Mass in the middle of the beam
In this example E =210.000 N/mm?
ly = 19430000 mm*
L = 6000 mm
M = 500 kg
210.000 '\y , - 19430000mm* )
—> 0 =48 mm - _181347'ad / ,
500kg - (6000mm) s

_ _ rad
— w=14258 A

= f =2 _6,78 Hz

2r

The result calculated by SCIA Engineer was 6,31 Hz.
The difference in results is caused by two assumptions in the manual calculation:

- The manual calculation does not take into account the self-weight of the beam

[k
Since @ = — alower mass will lead to a higher o and a higher f.
m

- The manual calculation does not take into account shear deformation
A lower deformation leads to a higher stiffness k, a higher o and a higher f.
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These two assumptions can also be implemented in the calculation model of SCIA Engineer:
- In order not to take the self-weight into account, the volumetric mass of S235 can be set
to 1 kg/m3 in the Material Library:

F' Materials ﬂ‘
AiaeBBL oo g @z A - Y
5235 MName 5235
= Code independent
Material type Steel
Thermal expansion [m,/mk 0,00
i —
E modulus [MPa] 210000,00
Poisson coeff, 03
Independent G modulus
G modulus [MPa] 80769,23
Log. decrement (non-uniform damping only) 015
Colour I
Thermal expansion (for fire resistance) [m/mk] 0,00
Specific heat [J/gK] 5,0000e-01
Thermal conductivity [W/mkK] 4,5000e+01
B [ Y] =1 ek - 'or 13, -J| =
Material behaviour Elastic -
= EC3
Ultimate strength [MPa] 360,0
Yield strength [MPa] 2350
Thickness range
| New " Insert " Edit | Delete | Close |

- To neglect the shear deformation, activate this option through Calculation, Mesh >
Solver Setup:

-
B Solver setup M

Mame

= General

Run one nonlingar combination

Neglect shear force deformation ( Ay, Az == A) v

Type of solver Direct ~
Murmnber of sections on average member 10
Warning when maximal translation is bigger than [mm] 10000
Warning when maximal rotation is bigger than [mrad] 1000
Print time in Calculation Protocol v

Coefficient for reinforcement 1

= Dynamics

Type of eigen value solver Lanczos -
MNumber of eigenmodes 1

Use IRS (Improved Reduced System) method

Produce wall eigenmode results (needed for ECtools)

IEREC] o«
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To obtain a correct and precise result, the mesh must also be refined. By refining the mesh to 10
finite elements. This can be done through Calculation, Mesh > Mesh Setup:

=l General mesh settings
Minimal distance between two points [m]
Average number of tiles of 1d element
Average size of 2d element/curved element [m]
Definition of mesh element size for panels
Average size of panel element [m]
Elastic mesh

= 1D elements
Minimal length of beam element [m]
Maximal length of beam element [m]
MAverage size of cables, tendons, elements on su...
Generaticn of nodes in connections of beam ele..
Generation of nodes under concentrated loads ...
Generation of eccentric elements on members ...
Division on haunches and arbitrary members

1' Division for 2D-1D upgrade

Mesh refinement following the beam type

1' Hanging nodes for prestressing

Now when the calculation is performed again, the following results are obtained:

Eigen frequencies

N |f omega | omega® (T
[Hz] ([ifs] |[d/s%1  |[s]

Mass combination : CM1

1 |67 258 [181335 o015

These results correspond exactly to the manual calculation.

0,001

10

1,000
Automatic
1,000

0,100
100,000
1,000

7

Mone

This example clearly shows the importance of checking the assumptions behind the applied
theories. When comparing results between two calculations, always make sure the same

assumptions/hypotheses are used.
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2.3 Frames

In this paragraph, the Free Vibration calculation is illustrated for frame structures. The principles
of the theory are applied in detail and verified by means of manual calculations.

Example 2-2: Free_Vibration_2.esa

In this example a two-storey frame is modeled.

; 5000
The members have cross-section HEA 240 and are K A
manufactured in S235 according to EC-EN. S— HEA240
The height of each storey is 4m.
The width of the frame is 5m. o o
The column bases are inputted as fixed supports. 9 § §
(o]
S| W Ll
One static load case is created: self-weight. T T
On the beams of the floor and roof level, a line mass of
500 kg/m will be introduced. N HEA240
3 g
o
gl g 3
AR T
Step 1: Mass group
ST

The activation of the Dynamics Functionality and the creation of a Mass Group are identical to
the previous example.

Step 2: Masses

When the Mass Group is created, the line masses of 500 kg/m can be inputted on the roof and
floor beams of the frame.

B ' Line mass on beam lér
Distribution Uniform -
M [kg/m] 500,0
Koeff mx 1
Koeff my 1
*— M — Koeff mz 1
@ @ = Geometry
Extent full -
| x1 l Coord. definition Rela -
x2 Position 11 0,000
Position 32 1,000
Origin From start -
oK | | Cancel
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<
o
o
et

ks

Note:

To render the display of masses, go to Set View Parameters For All > Miscellaneous > Drawing style
for Model + Loads

Step 3: Mass matrix

Next, a Combination of Mass Groups can be created.

F N
# ' Combinations of mass groups u
Al B0 =& A -
[Name CML
Description
= Contents of combination
MG1 [-] 100

| Mew ” Ingert u Edit ” Delete ‘

Step 4: Mesh setup

To obtain precise results for the dynamics calculation, the Finite Element Mesh is refined.
This can be done through Calculation, Mesh > Mesh Setup.
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F A
B 7 Mesh setup ﬁ

= General mesh settings

Minimal distance between two peints [m 0,001
Average number of tiles of 1d element 10

Mverage size of 2d element/curved elemen... 1,000

Definition of mesh element size for panels ~ Automatic -
Average size of panel element [m] 1,000
Elastic mesh
El 1D elements
Minimal length of beam element [m] 0,100
Mazxirnal length of beam element [m] 100,000

Mverage size of cables, tendons, elements ... 1,000

Generation of nodes in connections of bea... ¥

Generation of nodes under concentrated lo...

Generation of eccentric elements on mem...

Division on haunches and arbitrary members 5

Division for 2D-10 upgrade 50

Mesh refinement following the beam type  None ~

Hanging nedes for prestressing

A= n ] [ ok Cancsl =

The Average number of tiles of 1D element is set to 10 to obtain a good distribution of the line
masses and the mass of the members.

Step 5: Solver setup

The last step before launching the calculation is setting the amount of eigenmodes to be
calculated. The default value in Calculation, Mesh > Solver Setup is 4. This is sufficient for this
example.

-
B Solver setup ﬁ

= General

Meglect shear force deformation ( Ay, Az =..

Type of solver Direct -
Mumber of sections on average member 10

Warning when maximal translation is bigg... 1000,00

Warning when maximal rotation is bigger t.. 100,0

Print time in Calculation Protocol v
Coefficient for reinforcement 1
= Dynamics
Type of eigen value solver Lanczos -

Mumber of eigenmodes 4

Use IRS (Improved Reduced System) method

Produce wall eigenmode results (needed f...

= &= [—ok Cancsl »
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Step 6: Modal analysis

The Free Vibration calculation can now be executed through Calculation, Mesh > Calculation.
The following results are obtained:

Eigen frequencies

N [f omega | omega® |T
[Hz] |[L/s]  |[L/s%] Is]

Mass combination : CM1

1 288 1815 32932 0,35

2 1952 59,83 3579,23 0,11

3 |451 1,18 [B31422  |oo07

4 [15,94 hosas [1133253 |o0.06

As stated in the previous example, using Deformation of Nodes, the Deformed Mesh can be

shown to view the eigenmodes:

™

Ao

Eigenmode 1: f = 2,89 Hz

I\.

L T

i

Eigenmode 3: f = 14,51 Hz
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The Calculation Protocol for the Eigen Frequency calculation shows the following:

Sum of masses

[kgl X Y |z
Combination of mass groups 1 [6543.37 |0.00 |6543.37
Modal participation factors
Mode |Omega Period Freq. Wi f Wyi / wizi f Wxi R/ |Wyi RS (wzi R/
[rad/s] [s] [Hz] Witot Wytot Witot Whxtot_R |Wytot_R |Spectral
1 18.1477 0.32462 2.BEE3 0.2628 0.0000 0.0000 0.0000 0.0793 0.0000
2 59.8285 0.1050 9.5220 0.1108 0.0000 0.0000 0.0000 0.4223 0.0000
3 51.1850 0.0689 14.5125 0.0000 0.0000 0.1554 0.0000 0.0000 0.0000
. 106.4575 0.0550 16.9432 0.0000 0.0000 0.5360 0.0000 0.0000 0.0000
0.5736 0.0000 0.6514 0.0000 0.2014 0.0000

The Sum of masses shows the amount of mass, which can vibrate for this Mass combination. In
this example, this is governed by the line masses of 500 kg/m and the mass of the members.
This value can be calculated as follows:
- The members are of type HEA 240 with cross-section A= 0,00768 m?
- The volumetric mass of S235 is 7850 kg/m3
- The total length of the members is 4 x 4m + 2 x 5m = 26m

However, as stated in 2.2 the masses are guided to the mesh nodes. The Finite Element Mesh
was refined to 10 1D elements per member.
This implies that for the two lower columns, half the mass of a 1D element is guided to a support
and does not take part in the free vibration.
- The length of the columns is 4m
- The length of a 1D element is 4m / 10 = 0,4m
- The length of half a 1D elementis 0,4m /2 =0,2m
= The total length of the members taken into account for the mass is
26m —0,2m —0,2m = 25,6m
= Total member mass = 0,00768 m2 x 25,6 m x 7850 kg/m3 = 1543,37 kg
This mass is added to the line masses of 500 kg/m
= Vibrating Mass = 2 x 500 kg/m x 5m + 1543,37 kg = 6543,37 kg

The Modal Participation Factors show the amount of mass that is vibrating in a specific
eigenmode as a percentage of the total mass.

- For Eigenmode 1: 86% of the total mass is vibrating in the X-direction

- For Eigenmode 2: 11% of the total mass is vibrating in the X-direction

- For Eigenmode 3: 16% of the total mass is vibrating in the Z-direction

- For Eigenmode 4: 54% of the total mass is vibrating in the Z-direction

The lower row shows the total percentage when these four modes are combined: 97% is taken
into account for the X-direction and 69% for the Z-direction.

These factors will be looked upon in more detail during the Seismic calculations in Chapter 4.

For a seismic calculation, it is required that sufficient eigenmodes are included in the calculation
so that at least 90% of the total mass is being taken into account [7].
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Manual Calculation

In order to check the results of SCIA Engineer, the lowest eigen frequency, or natural frequency
of this structure is calculated by a manual calculation.

The method used here is described in the literature as Rayleigh’s Energy Method. [1], [13].

In this method, the structure is idealized as a cantilever beam with lumped masses at each floor
level:

Fi+1] —= () (—‘\/\

/

The structure is then loaded with a set of linearly increasing horizontal loads on each floor
level. Due to this loading, the structure will deform and thus the rigidity of the system is known.
The eigen frequency of the structure can then be approximately calculated as follows:

= —
P ‘\\ s

Fi— K
_

777777

f=— (2.8)

With:
n = Number of floors
Fi= Horizontal force acting on floor level i
di = Horizontal deformation of floor level i
Mi = Idealized mass of floor level i

[k
The analogy between this formulaand @ = — can clearly be seen.
m
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To use this formula, the frame needs to be idealized to a cantilever:

M2

e 1 O
E—

>/V

M1

/ Ss

The mass of the lower part of the structure is idealized to the support of the cantilever so it takes
no part in the vibration.
The mass M; can be calculated as follows:
0,00768 m2 x (5 + 4 + 4) m x 7850 kg/m3 + 500 kg/m x 5m = 3283,74 kg
The mass M can be calculated as follows:
0,00768 m2 x (5 + 4) m x 7850 kg/m3 + 500 kg/m x 5m = 3042,59 kg

In order to calculate the horizontal deformations d; of each floor level due to a linearly increasing
load Fi, a static load case is calculated with SCIA Engineer consisting of loads of 100 kN and
200 kN. The following results are obtained for the nodal deformations:

Fz /200,00 199.58 mm

F1,/ 100,00 95,79 mm
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F1 =100 kN = 100000 N

F2 =200 kN = 200000 N
di=95,79 mm = 0,09579 m
dz = 199,58 mm = 0,19958 m

4340343

Applying formula (2.8):
~ 1 | 100000N -0,09579m + 200000N -0,19958m
27\ 3283,74kg - (0,09579m )’ +3042,59kg - (0,19958m )’

=2,88 Hz

This result corresponds to the 2,89 Hz calculated by SCIA Engineer.
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2.4 Combining mass groups

Mass Groups are combined in a Combination of Mass Groups.
According to Eurocode 8 [7] article 3.2.4, all gravity loads appearing in the following combination
of actions need to be taken into account for an eigenmode calculation:

sz +Z‘//E,i Q. (2.9)

Where: Gk = Characteristic value of the permanent load
Qx,i = Characteristic value of the variable load i

yei = Combination coefficient for load i = @ -/, ;

The combination coefficient e, takes into account the likelihood of the variable loads not being
present over the entire structure during the occurrence of an earthquake.

Eurocode 8 [7] indicates that W ; should be calculated in the following way:

WE =@ -y

NOTE The values to be ascribed to ¢ for use in a country may be found in its National Annex.
The recommended values for @ are listed in Table 4.2.

Table 4.2: Values of @ for calculating yg;

Type of variable Storey @

action

Categories A-C’ Roof 1,0
Storeys with correlated occupancies 0.8
Independently occupied storeys 0,5

Categories D-F 10

and Archives

* Categories as defined in EN 1991-1-1:2002.

For example, if a first mass group MG1 represents the mass of permanent loads and a second
mass group MG2 represents the mass of a variable load case with a Category B imposed load
and independently occupied storeys, then ¢ is taken as 0,5 and 2, as 0,3.

This gives a value of 0,15 for Wg ;.

The Combination of Mass Groups CM1 can then be formulated as 1,00 MG1 + 0,15 MG2.

# ' Combinations of mass groups ﬁ
KLIR 4 & A -
ome o

Description

= Contents of combination
MGL [-] 1,00
MG2 [-] 015
Mew || Inzert || Edit || Delete Close
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Example 2-3: Free_Vibration_3.esa

In this example an office building is modeled as a frame. The office is manufactured in C30/37
according to EC-EN. The building has four storeys with a storey height of 4m. In horizontal
direction, the frame is made up of four columns with a distance of 6m between them. In the
direction out of plane, the frames are spaced 5m. The column bases are inputted as fixed
supports.
The members of the frame have following cross-sections:

- Columns: Rectangular 300 x 450

- Floor Beams: Rectangular 250 x 500

- Roof Beams: Rectangular 150 x 300
The vertical loads acting on the structure are:

- The self-weight of the concrete members

- The weight of the floors: 5 kN/m?2

- The weight of the roof: 2 kN/m2

- A category B (Office) imposed load of 3 kN/m2

v 6000 v 65000 v 5000 »
/I Rool Beam /‘ Fuoof Beam Rool Beam /I
N—
c L= C c
sl £ £ £ 3
o = 3 ju ju |
= G o 1=}
o 5] [ o
Flaor Beam Floar Bearn Flaar Bearn
o M S— — — —
(= (= (=3 c
2 £ £ £ £
ol = = = =
Rl o 5] 53
[ O [ &
Floor Beom Floar Bearn Flaar Bearn
N - L -
= [l < =
g £ £ £ £
= =] = 3 =
T = o =] 5
& [&] L&) O
Floor Beam Floor Bearn Flaar Beam
3 - L -
L= f= k= =
3| ¢ £ £ £
=4 =] =] 3 =
T o= =1 o a
& O 0 [

This gives 3 static Load-Cases:

LC1: Self-Weight

LC2: Permanent Load: 25 kN/m on the floor beams, 10 kN/m on the roof beams
LC3: Variable Load: 15 kN/m on the floor beams

Step 1: Functionality

The first step in the Dynamic calculation is to activate the functionality Dynamics on the
Functionality tab in the Project Data.
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Step 2: Mass groups

The second step is to create Mass Groups, the third step the creation of Masses.

Since the self-weight is automatically taken into account in a Combination of Mass Groups,

two Mass Groups are created here, one for each Static load case.

For the Mass Group MG1, the load case LC2 is chosen: the weight of the floors and roof. Using

the option “Keep masses up-to-date with loads” and then the action “Create masses from

load case” automatically generates masses from the already inputted loads which remain linked

to the loads.

B ' Mass groups

e

Alde @ BB 9 == =

[ | Name
MiG2

Description
Bound to load case

Load case

Keep masses up-to-date with loads

MG1

Yes ~
LC2 - Floor + Roof Weight =~ ..
v

Actions

Create masses from load case

]

| New || Insert || Edit || Delete |

| Close |

[

In the same way, the Mass Group MG2 is created in which masses are automatically created

from load case LC3: the imposed load.

B ' Mass groups

B

Ais £ BB SlFE A

MG1 Mame
(MG2 [
Bound to load case

Load case

Keep masses up-to-date with loads

MG2

Yes ~
LC3 - Imposed Lead on Floor ~ ..
)

Actions

Create masses from load case

e

| New || Insert || Edit || Delete

| Close |

Note:

- As stated in the first example: When creating masses from loads, SCIA Engineer will use the

acceleration of gravity specified on the Loads tab of the Project Data. By default it is 9,81 m/s2.

- In versions previous to SCIA Engineer 2013, the mass will always remain unchanged after any
modification or removal of the original force. If the mass is supposed to correspond to the modified

force, it is necessary to remove the mass and to create it once more.
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Step 3: Masses

In the Masses menu, the contents of both Mass Groups can be visualized.

- Mass Group MG1:

Floor mass:

1014,37

2548.,42 254842

254842

Ao

P
[AnaNn]
=) 2>
= O O
= — =
=
oy ey
AN
o |og
< |
[he} relite]
= el e
—

LM2

LM1

10000 N
Roof mass: —A]

- Mass Group MG2:
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= - =
=
o ey
RANS
od |00
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= e
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LM5

LM4

2548,42
2548,42

254842

254842

LMg

L8

LM7

2548,42 2548,42 1012,37

254842

1529,05

1229,05

Abox

Mass of imposed load:

LM14

LM13

15000 % _

152905
1529,05

1529,65
152965

STTITTT

LMITY

LM18

152905
152905

1529.05
152905

Veciced

9,81%2

kg
1529197

LM20 ‘

LMI19

7 ‘

25000 N/ g

9,81—”‘82m -2,
= kg

o 1019,4K9/

29,05

5

1

1529,65

!
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Step 4: Mass matrix

Both Mass Groups can now be combined in a Combination of Mass Groups.
According to Eurocode 8 [7] article 3.2.4, all gravity loads appearing in the following combination
of actions need to be taken into account for an eigenmode calculation:

§:Gk4_§:WEJ'QKi

For this example, with a Category B imposed load and independently occupied storeys, ¢ is

taken as 0,5 and vy, as 0,3. This gives a value of 0,15 for W ;.

The Combination of Mass Groups CM1 can then be formulated as 1,00 MG1 + 0,15 MG2.

(2.9)

-
B | Combinations of mass groups

2]

Ae gBE o = & A

=

Description
E Contents of combination
MGL [-]
MG2 [-]

CML

1,00
0,15

| Mew " Insert || Edit || Delste |

| Cloge |

Step 5: Mesh setup

To obtain precise results for the dynamics calculation, the Finite Element Mesh is refined. This

can be done through Calculation, Mesh > Mesh Setup.

B Mesh setup &J

poere |

=l General mesh settings
Minirmal distance between two peints [m] 0,001

lAveragE number of tiles of 1d element 10 ]

Mverage size of 2d element/curved elemen... 1,000
Definition of mesh element size for panels  Automnatic -
Average size of panel element [m] 1,000
Elastic mesh

= 1D elements
Minimal length of beam element [m] 0,100
Maximal length of beam element [m] 100,000
Mverage size of cables, tendons, elements ... 1,000
Generation of nodes in connections of bea... V'
Generation of nodes under concentrated lo..,
Generation of eccentric elements on mem...
Division on haunches and arbitrary members 5
Division for 2D-10 upgrade 50
Mesh refinement following the beam type  None -

Hanging nodes for prestressing
___@ i OK H Cancel '_

The Average number of tiles of 1D element is set to 10 to obtain a good distribution of the line

masses and the mass of the members.
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Step 6: Solver setup

The last step before launching the calculation is setting the amount of eigenmodes to be

calculated. The default value in Calculation, Mesh > Solver Setup is 4. This is sufficient for this

example.

p

B Solver setup

E=X)

MName
= General
Meglect shear force deformatien ( Ay, Az =..
Type of solver Direct
Mumber of sections on average member 10
Warning when maximal translation is bigg... 1000,0

Warning when maximal rotation is bigger t... 100,0

Print time in Calculation Protocol W
Coefficient for reinforcement 1
= Dynamics

Type of eigen value solver Lanczos
Mumber of eigenmodes _
UseIRS (Improved Reduced System) method Iy

Produce wall eigenmode results (needed f...

= (= (E

| oK

|'| Cancel '_

Step 7: Calculation

The Free Vibration calculation can now be executed through Calculation, Mesh > Calculation.

The following results are obtained:

Eigen frequencies

Mo|f omega | omega® |T
[Hz] |[1/s]  [[4/5%1  |[s]

Mass combination : CWMI1
1 |1,28 [g01 64,19 0,78
3,70 [23,26 [s41,06 [0,27
6,01 [37.76 |142565 |0,17
B,26 [51,89 |269246 (0,12

R
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With corresponding Eigenmodes:

|

Lo x

A x L A J
Eigenmode 1: f=1,28 Hz Eigenmode 2: f = 3,70 Hz

/

Eigenmode 4: f = 8,26 Hz

Eigenmode 3: f = 6,01 Hz
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The Calculation Protocol for the Eigen Frequency calculation shows the following:

Sum of masses

[kgl X Y z
Combination of mass groups 1 |208578.62 |0.00 (208578.62
Modal participation factors
Mode |Omega Period Freq. Wi [ Wyi [ wazi / Wxi R/ |Wyi R/ ([wzi R/
[rad/s] [s] [Hz] Wixtot Wrytot Witot Wxtot R (Wytot R |Spectral
1 8.0122 0.7842 1.2752 0.8347 0.0000 0.0000 0.0000 0.0547 0.0000
2 23.2614 0.2701 3.7022 0.0979 0.0000 0.0000 0.0000 0.2153 0.0000
3 37.7589 0.1664 6.0095 0.0422 0.0000 0.0000 0.0000 0.0466 0.0000
= 51.8905 0.1211 8.2586 0.0000 0.0000 0.0019 0.0000 0.0000 0.0000
0.9748 0.0000 0.0019 0.0000 0.3166 0.0000

The Sum of masses can be calculated as follows:

According to the Bill of Material, the self-weight of the frame is 40500 kg.
Bill of material

Mame Mass Surface Volume
[kgl [m?] [mm?]
Total results : 40500,00| 193,200( 1,6200e+10

However, for the four lower columns, half the mass of a 1D element is guided to a support and
does not take part in the free vibration.
The length of the columns is 4m
Since 10 1D elements per member were used, the length of a 1D element is 4m /10 =

40

0,4m

The length of half a 1D elementis 0,4m /2 =0,2m

The columns have a cross-section of 0,135 m2 and a volumetric mass of 2500 kg/m?3

= The mass of the columns not taken into account is:

4 x 0,135 m2x 0,2 m x 2500 kg/m3 = 270 kg
= The mass of the self-weight taken into account is: 40500 kg - 270 kg = 40230 kg

For MG1 the mass of the floors is 9 x 2548,42 kg/m x 6m = 137614,68 kg

For MG1 the mass of the roof is 3 x 1019,37 kg/m x 6m = 18348,66 kg

For MG2 the mass of the imposed load is 9 x 1529,05 kg/m x 6m = 82568,7 kg

However only 15% was taken into account => 0,15 x 82568,7 kg = 12385,31 kg
= Vibrating mass= 40230 kg + 137614,68 kg + 18348,66 kg + 12385,31 kg
=208578,65 kg




Manual Calculation

In order to check the results of SCIA Engineer, the lowest eigen frequency of this structure is
calculated by means of the Rayleigh Method.

As specified in the previous example, the frame is idealized as a cantilever:

L L] L L >4{>

: f f | o

The masses M1, M; and M3 can be calculated as follows:

- Self-Weight of three floor beams and four columns:
= 3x0,125 m2x 2500 kg/m3x 6 m =5625 kg
= 4x0,135 m2x 2500 kg/m3 x 4 m = 5400 kg
= 5625 kg + 5400 kg = 11025 kg

- Floor weight of mass group MG1.:
= 3x2548,42 kg/m x 6 m = 45871,56 kg

- Weight of Imposed load of mass group MG2 (15%)
= 0,15 x 3 x1529,05 kg/m x 6 m = 4128,44 kg

- Total: 11025 kg + 45871,56 kg + 4128,44 kg = 61024,995 kg

The mass M4 can be calculated as follows:
- Self-Weight of three roof beams and half of four columns:
= 3x0,045 m2x 2500 kg/m3x 6 m = 2025 kg
= 0,5x4 x0,135 m2 x 2500 kg/m3 x 4 m = 2700 kg
= 2025 kg + 2700 kg = 4725 kg

- Roof weight of mass group MG1:
= 3x1019,37 kg/m x 6 m = 18348,66 kg

- Total: 4725 kg + 18348,66 kg = 23073,66 kg
In order to calculate the horizontal deformations d; of each floor level due to a linearly increasing

load Fi, a static load case is calculated with SCIA Engineer consisting of loads of 100 kN, 200
kN, 300 kN and 400 kN. The following results are obtained for the nodal deformations:
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F4 /400,00 151,71 mm
F3 /300,00 115,88 mm
Fo /200,00 77,92 mm
F1 /100,00 33,07 mm
N B

F1 =100 kN = 100000 N

F> =200 kN = 200000 N

Fz = 300 kN = 300000 N

Fs = 400 kN = 400000 N

d1 = 33,07 mm = 0,03307 m
d2=77,92 mm =0,07792 m
d3=115,88 mm =0,11588 m
ds=151,71 mm =0,15171m

430330300730

Applying formula (2.8):
- 100000N -0,03307m + 200000N - 0,07792m -+ 300000N - 0,11588m -+ 400000N -0,15171m B
27 \ 61024,995kg - (0,03307m)* + 61024,995kg - (0,07792m ) + 61024,995kg - (0,11588m )’ + 23073,66kg - (0,15171mY’
f=1,27 Hz

This result corresponds to the 1,28 Hz calculated by SCIA Engineer.
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2.5 Slabs

The last paragraph of this chapter illustrates the procedure for the Free Vibration calculation of
slabs. The applied method is entirely the same as for frames. This is shown in the following
example.

Example 2-4: Free_Vibration_4.esa

In this example, a multi-span rectangular slab is modeled. The slab has a length and width of
6m. The slab has a thickness of 0,06m and is manufactured in S235 according to EC-EN. On
two sides the slab is simply supported, on the other two, the slab is free. In the middle of the
slab, perpendicular on both simply supported edges, a line support is introduced.

One static load case is created: the self-weight of the slab.

JOOO

o

Step 1: Functionality

The first step in the Dynamic calculation is to activate the functionality Dynamics on the
Functionality tab in the Project Data.

Step 2: Mass group

The second step is to create a Mass Group

Since the Free Vibration calculation will be executed for the self-weight of the slab, no additional
masses need to be inputted.

B | Mass groups &J
A e BB 0 =S =HE A E
[N | Name MG1
Description
Bound to load case Yes -
Load case LC1 - Self-Weight o

Keep masses up-to-date with loads |

% Actions
Create masses from load case 3-8
| New | Inset | Edt | Delete | | Close |
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Step 3:

Mass matrix

Next, a Combination of Mass Groups can be created.

Step 4:

7
# | Combinations of mass groups

Ais BB g =& A

Neme o
Description
= Contents of combination
MGL [-] 1,00

Mesh setup

To obtain precise results for the dynamics calculation, the Finite Element Mesh is refined.
Analogous as for frames, this can be done through Calculation, Mesh > Mesh Setup.

.
B Mesh setup

===

MName
= General mesh settings
Minimal distance between two points [m] 0,001

Uetiniticn of mesh element size tor panels
Average size of panel element [m] 1,000
Elastic mesh

= 1D elements
Minimal length of beam element [m] 0,100
Maxirnal length of beam element [m] 100,000
MAverage size of cables, tendons, elements on subsail, nonlinear soi... 1,000
Generation of nodes in connections of beam elements J
Generation of nodes under concentrated loads on beam elements

Generation of eccentric elements on members with variable height

Division an haunches and arbitrary members 5
Division for 2D-1D upgrade 50
Mesh refinement following the beam type None

= 2D elements

To generate predefined mesh v
To smooth the border of predefined mesh

Maxirnal out of plane angle of a quadrilateral [mrad] 30,0
Predefined mesh ratio 15

Hanging nodes for prestressing

IERCC]

OK Cancel

The Average size of 2D elements is set to 0,25m.
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Step 5: Solver setup

The last step before launching the calculation is setting the amount of eigenmodes to be
calculated. The default value in Calculation, Mesh > Solver Setup is 4. This is sufficient for this

example.

-

Solver setup

S

MName

= General

MNeglect shear force deformation ( Ay, Az >> A)

MNumber of eigenmodes
Use IRS (Improved Reduced System) method

Produce wall eigenmode results (needed for ECtools)

Bending theory of plate/shell analysis Mindlin
Type of solver Direct
Mumber of sections on average member 10
Warning when maximal translation is bigger than [mm)] 1000,0
Warning when maximal rotation is bigger than [rmrad] 100,0
Print time in Calculation Protocol v
= Effective width of plate ribs
MNumber of thicknesses of rib plate 20
Parallelism tolerance for automatic calculation [deg] 10,00
Span length ratio L/beff,max (1 side) for automatic calculation [-] 8,00
= Span length correction
Simply supported beam [-] 1,00
Inner span [-] 0,70
End span [-] 0,85
Cantilever [-] 2,00
Coefficient for reinforcement 1
= Dynamics
Type of eigen value solver Lanczos
4

IEREC]

ok Cancel |

Step 6: Modal analysis

The Free Vibration calculation can now be executed through Calculation, Mesh > Calculation.

The following results are obtained:

Eigen frequencies

N (f omega | omega® |T
[Hz] |[1/s]  |[L/s%] Is]

Mass combination : CM1

1 |p68 |19 |1760,78 | 0,15

2 [pas |[s932 [351837 |01

3 |1%,35 [121,B5 |1424646 | 0,05

4 [21,05 [132,25 |17489,08 |0,05

The same way as for frames, the Eigenmodes can be visualized through Deformation of nodes

now under 2D Members. The Deformed structure for value Uz shows the following:

Eigenmode 1: f = 6,68 Hz

el

45



Advanced Professional Training - Dynamics

]

Eigenmode 4: f =21,05 Hz |

Eigenmode 3: f =19,39 Hz 7

Note:

- Viewing 2D Members > Deformation of nodes > Deformed Mesh shows the deformation of both
2D and 1D elements. This allows seeing the complete eigenmode for a structure containing both
element types i.e. General XYZ projects.

- To generate all eigenmodes quickly, the document can be used: The picture of one eigenmode can
be set as a nested table for the Combinations of Mass Groups:

= dp Default
=1-[] Combinations of mass groups {Combination of mass groups)
E Eigenmode

This way, all Eigenmodes are generated automatically.

The Calculation Protocol for the Eigen Frequency calculation shows that the following Sum of
masses is accounted for:
Sum of masses

[ke] X Y z
Combinationof massgroups 1 000 |0.00 (1557244

This value can be calculated as follows:
- The total weight of the slab is 6 m x 6 m x 0,06 m x 7850 kg/m3 = 16956 kg
- Half of the mass of the elements near the two externally supported edges is carried to the
supports and does not participate in the vibration. Since the mesh size was set to 0,25 m,
half the size of a 2D element is 0,125 m.
= 2x6mx0,125 m x 0,06 m x 7850 kg/m3 = 706,5 kg

- The same applies for the internal edge, 6000
however the mass of the two elements on the start  # — — — — 4
and end nodes has already been taken into @ A A= A~ ST
account in the above calculation for the externally
supported edges. e
This leaves a length of 6 m — 0,125 m — 0,125 m =
5,75 m. The following figure illustrates this length. P
= 2x5,75mx0,125 m x 0,06 m x 7850
kg/m3 = 677,06 kg A3
TS
_ )
- The total mass taken into account for the Free
Vibration calculation: -~
= 16956 kg — 706,5 — 677,06 = 15572,44 kg N
—_—
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Manual Calculation

In order to check the results of SCIA Engineer, the eigen frequencies of the slab are calculated
by a manual calculation.

The method used here is described in reference [14] In this reference; the eigen frequency of a
multi-span slab is expressed in terms of a non-dimensional parameter A.

2
A= % ﬂ (2.10)
V4 D
Where:
o = Circular frequency
L = Distance between the two simply supported external edges
p = Density of the slab material
h = Slab thickness

Eh®

D = flexural rigidity of the slab = (2.11)
12(1—0?)

E = Modulus of Young
v = Poisson’s Ratio

In this example, the material properties are the following:

L=6m
p = 7850 kg/m3
h=0,06 m

E =210.000 N/mm?2 = 2,1 e'! N/m?

v=0,3
N/ . g
- 2,1et %n ,-(0,06m)
12-(1-0,3%)

=4153846,15 Nm

The values for A for the first four modes, for a slab with two edges simply supported and two
edges free, a h/L ratio of 0,01 and an internal edge on position 0,5L are given in reference [14]:
Mode 1: A = 1,6309
Mode 2: A = 2,3050
Mode 3: A = 4,7253
Mode 4: 1 =5,1271

Using these parameters in formula (2.10), the circular frequencies can be calculated:
Mode 1: ® =41,99rad/s =>f=6,68 Hz
Mode 2: ® =59,34 rad/s =>f=9,45Hz
Mode 3: » = 121,66 rad/s =>f=19,36 Hz
Mode 4: o = 132 rad/s =>f=21,01Hz

The results correspond perfectly to the results calculated by SCIA Engineer:
Mode 1: f = 6,68 Hz
Mode 2: f=9,44 Hz
Mode 3: f=19,39 Hz
Mode 4: f = 21,05 Hz
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3. Forced Vibration: Harmonic Load

In this chapter, the forced vibration calculation is examined. More specifically, the structure will now be
loaded with an external harmonic load, which will cause the structure to vibrate.

A forced vibration calculation can be required to check the response of a building near a railroad or
major traffic lane, to check vibrations due to machinery, to verify structural integrity of a floor loaded by
an aerobics class,...

As in the previous chapter, first the theory will be discussed. The theory will then be illustrated by
examples, which will again be verified by manual calculations.

3.1 Theory

To understand what is going on during the dynamic analysis of a complex structure with frames or finite
elements, the forced vibration of a SDOF (Single Degree Of Freedom) system is regarded in detail. A
complete overview can be found in reference [1].

Consider the following system:

F(t)

A body of mass m can move in one direction. A spring of constant stiffness k, which is fixed at one
end, is attached at the other end to the body. The mass is also subjected to damping with a damping
capacity c. An external time dependant force F(t) is applied to the mass.

The equation of motion can be written as:

m-yt) + c-y(t) + k-yit) = F(@) (3.1)
When the acting force on this system is a harmonic load, equation (3.1) can be rewritten as follows:

m-y®) + c-y(t) + k-y(t) = F-sin(v-t) (3.2)

Where: F = Amplitude of the harmonic load
v = Circular frequency of the harmonic load

A solution to this equation is the following:

Y = e (Acos(ay 1)+ Bsin(w, 1) + Y, ——mt=0) (3.3)
Ja-r’y +rey
Where:

Ys = E The static deflection (3.4)
E = _c The damping ratio (3.5)

2-m-w
O, = O 1-¢£2 The damped circular frequency (3.6)

2-&-r
tan(@) = 3.7
© = 55 (37)
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r = v The frequency ratio (3.8)

The angle 6 signifies that the displacement vector lags the force vector, that is, the motion occurs after
the application of the force. A and B are constants which are determined from the initial displacement

and velocity.
The first term of equation (3.3) is called the Transient motion. The second term is called the Steady-

state motion. Both terms are illustrated on the following figure:

Combined motion

Steady-state
-
motion

B

.

‘. v Al AJAV’. \
R
Transient
motion % L\p

The amplitude of the transient response decreases exponentially (€ ). Therefore, in most practical
applications, this term is neglected and the total response y(t) can be considered as equal to the
steady-state response (after a few periods of the applied load).

Equation (3.3) can then be written in a more convenient form:

A ! (3.9)
Yo o JA-r?)?+(2ré)’

% is known as the Dynamic Magnification factor, because Ys is the static deflection of the system
S

\

ot

under a steady force F and Y is the dynamic amplitude.

The importance of mechanical vibration arises mainly from the large values of % experienced in
S

practice when the frequency ratio r has a value near unity: this means that a small harmonic force can
produce a large amplitude of vibration. This phenomenon is known as resonance. In this case, the

dynamic amplitude does not reach an infinite value but a limiting value of Y%é .
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3.2 Harmonic Load in SCIA Engineer

In SCIA Engineer, a Harmonic Load can be inputted after creating a Combination of Mass Groups. This
implies that the steps used to perform a Free Vibration calculation still apply here and are expanded by
the properties of the Harmonic Load.

Conform the theory, a Harmonic Load is defined by a forcing frequency and an amplitude. To specify
the damping ratio of the structure, the logarithmic decrement can be inputted. [1]

The logarithmic decrement A is the natural logarithm of the ratio of any two successive amplitudes in
the same direction. This is illustrated on the following figure:

A= InL (3.10)

11

X
N

I
[LZ,\--\J?:E;—E%-__ t

y v Exponential decay Xe~$«w?!

X Circular frequency \/(1 — ¢t 2)w = w,
"

-

The logarithmic decrement A is related to the damping ratio & by the following formula:

A= 27¢ (3.11)

J1-&2

The damping ratio and the logarithmic decrement are looked upon in more detail in Chapter 5.
Harmonic Loads in SCIA Engineer are always defined as nodal forces i.e. a nodal load or a nodal
moment. More than one node of the structure can be loaded in a load case, but the frequency of all
solicitations is equal to the forcing frequency specified for that load case.

As specified in the theory, the static results are multiplied by the dynamic magnification factor. The
dynamic calculation is thus transformed to an equivalent static calculation. Therefore, a Linear
Calculation needs to be executed. During this calculation, the Free Vibration Calculation will also be
performed since this data is needed for the result of the Harmonic Load.
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The following diagram shows the required steps to perform a Forced Vibration calculation:

Activate the Dynamics functionality

l

Create a Mass Group

Input Masses Generate Masses from Static Load cases

~, =

Create a Mass Combination

A 4
Create a Harmonic Load case

h 4
Input Harmonic Loads

l

Refine the Finite-Element Mesh if required

'

Specify the number of Eigenmodes to be calculated

'

Perform a Linear Calculation

This diagram is illustrated in the following examples.

52



Example 3-1: Harmonic_Load_la.esa

In this example, a beam on two clamped supports is modeled. The beam has a cross-section type IPE
200, a length of 6m and is manufactured in S235 according to EC-EN. A node has been added to the
middle of the beam, in which a mass of 200 kg will be inputted.

IPE200
STT7777 7777777

6000

/1 71

One static load case is created: the self-weight of the beam. However, in order not to take the self-
weight into account for the dynamic calculation, the volumetric mass of S235 can be setto 1 kg/m3in
the Material Library. This will render it easier to check the results through a manual calculation.

The mass of 200 kg is vibrating with a frequency of 5 Hz. The damping ratio of the system is taken as
5%.

Step 1: Functionality

The first step in the Dynamic calculation is to activate the functionality Dynamics on the Functionality
tab in the Project Data.

Step 2: Mass group

The second step is to create a Mass Group

B ° Mass groups [ﬁ
it e BEk v - & FH A -

CE | Name MG1
Description
Bound to load case Mo -

Step 3: Masses

After the Mass Group has been created; the mass of 200 kg can be inputted in the middle of the beam.

M1/ 2000

i
ST

Step 4: Mass matrix

Next, the Mass Group is put within a Combination of Mass Groups, which can be used for defining
the harmonic Ioag.

B ' Combinations of mass groups ﬁ

=8 & O & A -
Ccml M1
Description
=l Contents of combination
MGL [-] 1,00
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Step 5: Harmonic load case

After creating a Combination of Mass Groups, an harmonic load case can be defined through Load
cases, Combinations > Load Cases.

- Action Type = Variable
- Load Type = Dynamic
- Specification = Harmonic
i | Load cases ﬁ
Ao s BB 0 Sl A -
L1 - Self-Weight MName LC2
LC2 - Harmonic Load Description Harmonic Load
Action type Variable -
LoadGroup LG2 o
Load type Dynamic -
Specification Harmonic -

=l Parameters
Logutimcsecement  ETTITTE T
Frequency [Hz] F, 0314553
Master load case Mone -
Mass combi Chl -

Actions

Delete all loads -

Copy all loads to another loadcase 2o

| Mew ” Insert || Edit || Delete | | Close |

The damping ratio was given to be 5%. Applying formula (3.11), the logarithmic decrement can be
calculated:

A 27§ 2-7-0,05
V1-&* J1-(0,05¢
This formula can also be inserted in the value field. It is not necessary to do a manual calculation to

insert only the result in SCIA Engineer.The forcing frequency of the harmonic load is 5 Hz. This must
be inserted in the Frequency [HZz] field.

=0,31455270229
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B Load cases e
Ara g BbBi= o = &l=E A - &
LC1 - Self-Weight Beme = 220
LC2 - Harmonic Load Description Harmonic Load
Action type Variable -
LoadGroup La2 -
Load type Dynamic v
Specification Harmonic -
=l Parameters
Lagarithmic decrement 0,314553
Frequency [Hz] 5,00
Master load case Mone -
Mass combi Ch A
Actions
Delete all loads LRSS
Copy all loads to another loadcase 2o

| MNew ” Insert ” Edit " Delete ‘

Close

The last option, Mass Combi shows which Mass Combination (mass matrix) will be used for the
calculation of the harmonic load case.
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Step 6: Load

The parameters of the load case have been defined, what is left is inputting the amplitude of the load.
The mass was 200 kg.

This corresponds to a load of 1,962 kN using 9,81 m/s2 for the acceleration of gravity.

This load can be inputted through Load > Point Force > In Node

=

1L,
ST

Note:

As specified in the theory, more than one harmonic load can be inputted in the same harmonic load case
however the harmonic parameters like damping and forcing frequency are defined on the level of the load
case. This implies that, for example, when several harmonic loads are vibrating with different frequencies,
different load cases have to be created.

Step 7: Mesh setup

To obtain precise results for the dynamic calculation, the Finite Element Mesh is refined.
This can be done through Calculation, Mesh > Mesh Setup.

B | Mesh setup ﬁ

MName

= General mesh settings

IMinimal distance between twe peints [m] 0,001
IAverage number of tiles of 1d element 10 l

HAverage size of 2d element/curved element [m] 1,000

Definition of mesh element size for panels Autematic -
Average size of panel element [m] 1,000

Elastic mesh

= 1D elements
Minirmal length of beam element [m] 0,100
Mazximal length of beam element [m] 100,000
Average size of cables, tendons, elements on subsoil, nenlinear soi... 1,000
Generation of nodes in connections of beam elements v
Generation of nodes under concentrated leoads on beam elements

Generation of eccentric elements on members with variable height

Division en haunches and arbitrary members 5
Division for 2D-1D upgrade 50
Mesh refinement following the beam type Mone ~

Hanging nodes for prestressing

___@ N |~ 0K Cancel '—

The Average number of tiles of 1D element is set to 10.

56



Step 8: Solver setup

The last step before launching the calculation is setting the amount of eigenmodes to be calculated.
For this example, only one eigenmode is required so in Calculation, Mesh > Solver Setup the
number of frequencies is set to 1.

To compare the results with a manual calculation, the shear force deformation is neglected.

) 1 7 Salver setup ﬁ‘
e |
= General
Type of solver Direct w2
Murmber of sections on average member 10
Warning when maximal translation is bigger than [mm] 1000,0000
Warning when maximal rotation is bigger than [mrad] 100,0
Print time in Calculatien Protocol v
Coefficient for reinforcement 1
= Dynamics
Type of eigen value solver Lanczos s
MNumber of eigenmodes 1
Use IRS (Improved Reduced System) method
Produce wall eigenmode results (needed for ECtools)

Step 9: Calculation

All steps have been executed so the Linear Calculation can be started through Calculation, Mesh >
Calculation.

[ |

FE analysis

Scia

Enginger

Single analysis | Batch analysis

' Linear calculation
Manlinear calculation
Modal analysis

Linear stability

Concrete - Code Dependent Deflections [CDD

Construction stage analysis

0 IS TS T DS B
I A R R B

Manlinear stage analysis
= Monlinear stability

™ Test of input data

Mumber of load cases: 2

Solver setup Mesh setup

OK | Cancel |
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This gives the following results:

(RRRNARRRRRRINRY

Eigen frequencies

M |f omega | omega® |T

[Hz] |[1fs]  |[1fs*] [s]

Mass combination : CM1

1 2143 Ji3ess 1813311 [005 |
The deformation for the harmonic load shows the following:

~
V ——
—0,5719 mMm
(NRRRNRARARRANRY

Deformations on member

Linearcalculation Extreme :© Global System : LCS

Selection: All

Load cases: LC2

Member dx | Case ux uz fiy Resultant

[m] [mm] [mm] | [mrad] [mm]

Bl 0,000 Lc2 0,0000( 0,0000 0,0 0,0000

B1 3,000 Lc2 0,0000| -0,5719 0,0 0,5718

Bl 4,500 |Lc2 0,0000| -0,2860 -0,3 0,2860

B1 1,500 Lc2 0,0000| -0,2860 0.3 0,2860

It is however very important to keep in mind that this is a vibration: half a period later the deformation is
to the upper side of the beam instead of the lower side.

The moment diagram for the harmonic load would give the next diagram:
—1.556 kNm

1,556 kNm
(ARRNRRNRRNRRRNY

Internal forces on member
Linearcalculation,Extreme : Global System : LCS
Selection: All
Load cases: LC2
Member [==3 dx Case N Vz My

[m] [kMN] | [kN] | [kMNm]
Bl C51 - IPE200D 0,000 |LC2 0,000 1,037 -1556
Bl C51 - IPE200D 4 BOO|LC2 0,000 -1,037| -0,311
Bl CS1 - IPE200 0,900 |LC2 0,000| 1,037 -0622
Bl CS1 - IPE200 3,000 |LC2 0,000| 1,057 1556
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This diagram is completely analogous to the moment diagram which one finds for a simple point load.

However, when performing dynamic calculations, one must always take into account both directions of
the loading since the load vibrates in both directions.

In SCIA Engineer, this double sided deformation can easily be checked by creating combinations of
type code or envelope. In these combinations, the dynamic load cases will be accounted for with both
a positive and a negative combination coefficient and thus both sides of the vibration amplitude are
taken into account.

In this example, a combination of type Envelope - ultimate is created which contains only the
harmonic load case.

' -
i | Combinations ﬁ

H 3’? _{ 9] % Input combinations -

o1 [Name co1

Description

Type Envelope - ultimate
= Contents of combination
LC2 - Harmonic Load [-] 1,00

Actions

Explode to linear SN

| Mew || Insert || Edit || Delete | | Cloze |

L

The moment diagram for this combination shows the following:
—1.556 kNm

L

x

1,556 kNm

The vibration effect is correctly taken into account: both sides of the vibration are visible. This is also
shown in the Combination Key of the Document; which shows the two generated Linear
combinations from the Envelope combination (Local Extremes):

2. Combination key
Combination key

Name Descriptionof combinations
1 LC2*-1,00
2 LC2¥1,00
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Manual Calculation

In order to check the results of SCIA Engineer, a manual calculation is performed.

First, the calculated eigen frequency is checked using formula (2.3).

Using default engineering tables [11], the maximum static deformation of a beam with length L,
clamped at both sides and loaded with a load F in the middle is given as:

FL©
max = 92| (312)
Where:

F=1,962 kN = 1962 N

L =6m = 6000 mm

E = 210000 N/mm?2

| = 19430000 mm*

3

. 1962 N -(6000mm) _ 054095 mm

~192-210.000 '\y , -19430000 mm*
mm

The rigidity k of this system can then be calculated:

F 1962N

- - -362693N/  —362693333N

Omax  0,54095mm %nm A"
Applying formula (2.3):
3626933 ,33 N
o = |- ' ~134,677ad//
m 200kg S
> f = 2 _2143Hz
27

This result corresponds exactly to the result calculated by SCIA Engineer.

Now the eigen frequency is known, the results of the harmonic load can be verified.
The harmonic load had a forcing frequency of 5 Hz, which corresponds to a circular frequency of
31,416 rad/s.

Applying formula (3.8) the frequency ratio can be calculated:

rad
, 3L4167ad/

yf = —=—w-v-— 72
rad
® 134,67 A

=0,233289

The frequency ratio can then be used in formula (3.9) to calculate the Dynamic Magnification Factor:
Y 1 1

Yoo Ja-ry e J-0,233289f +(2-0,233289- 0,05)

=1,0572

This implies that the static results need to be multiplied by 1,0572 to obtain the dynamic results.
The static deformation was calculated as 0., = 0,54095mm
= Dynamic deformation = 1,0572 x 0,54095 mm = 0,5719 mm

This result corresponds exactly to the result calculated by SCIA Engineer.

In the same way the moment in the middle of the beam can be calculated.
Using default engineering tables [11], the maximum static moment in the middle of a beam with length
L, clamped at both sides and loaded with a load F in the middle is given as:

FL 1962kN-6m
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= Dynamic moment = 1,0572 x 1,4715 kNm = 1,556 kNm

This result corresponds exactly to the result calculated by SCIA Engineer.
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3.3 Resonance

As specified in the theory, resonance occurs when the frequency ratio r has a value near unity. In this
case, large values for the Dynamic Amplification factor are obtained.

To illustrate this, the calculation of the Dynamic Amplification Factor is repeated for different frequency
ratios and different damping percentages. The results are given in the following table:

In order to draw conclusions, the numerical results are plotted graphically:

Frequency Forcing Mag. factor | Mag. factor | Mag. factor Mag. factor Mag. factor Mag. factor
Ratio Frequence [Hz] | Damping 5% ] Damping 8% ] Damping 10% | Damping 15% | Damping 25% | Damping 50%
0,0 0,00 1,0000 1,0000 1,0000 1,0000 1,0000 1,0000
0,2 4,29 1,0414 1,0411 1,0408 1,0396 1,0361 1,0198
0,4 8,57 1,1891 1,1870 1,1851 1,1785 1,1581 1,0748
0,6 12,86 1,5557 1,5452 1,5357 1,5041 1,4148 1,1399
0,8 17,15 2,7116 2,6173 2,5384 2,3113 1,8582 1,1399
1,0 21,43 10,0000 6,2500 5,0000 3,3333 2,0000 1,0000
1,2 25,72 2,1926 2,0830 1,9952 1,7590 1,3440 0,7824
14 30,01 1,0308 1,0144 1,0000 0,9543 0,8417 0,5891
1,6 34,29 0,6377 0,6326 0,6280 0,6127 0,5704 0,4475
18 38,58 0,4450 0,4428 0,4408 0,4340 0,4142 0,3480
2,0 42,87 0,3326 0,3315 0,3304 0,3269 0,3162 0,2774
2,2 47,15 0,2600 0,2593 0,2587 0,2567 0,2503 0,2260
2,4 51,44 0,2098 0,2094 0,2090 0,2077 0,2037 0,1876
2,6 55,73 0,1734 0,1732 0,1729 0,1720 0,1694 0,1582
2,8 60,01 0,1461 0,1459 0,1457 0,1451 0,1432 0,1353
3,0 64,30 0,1249 0,1248 0,1246 0,1242 0,1229 0,1170
3,2 68,59 0,1082 0,1081 0,1080 0,1076 0,1066 0,1023
34 72,87 0,0946 0,0946 0,0945 0,0943 0,0935 0,0901
3,6 77,16 0,0836 0,0835 0,0835 0,0833 0,0827 0,0801
3,8 81,45 0,0744 0,0743 0,0743 0,0741 0,0737 0,0716
4,0 85,73 0,0666 0,0666 0,0666 0,0665 0,0661 0,0644
4,2 90,02 0,0601 0,0600 0,0600 0,0599 0,0596 0,0583
4,4 94,31 0,0545 0,0544 0,0544 0,0543 0,0541 0,0530
4,6 98,59 0,0496 0,0496 0,0496 0,0495 0,0493 0,0484
4,8 102,88 0,0454 0,0453 0,0453 0,0453 0,0451 0,0443
5,0 107,17 0,0417 0,0416 0,0416 0,0416 0,0414 0,0408

Amplitude-Frequency Response

7

6 —— Damping 5%
S Damping 8%
3 5 _
= Damping 10%
o
S 4 —— Damping 15%
% —— Damping 25%
=
> 3 .
= Damping 50%
@
c
>
a 2

Frequency Ratio
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First of all, the resonance phenomenon is clearly visible. When the frequency ratio equals unity, the
Dynamic Magnification factor becomes very large indicating that a small harmonic load can produce a
large amplitude of vibration.

Second, the influence of the damping ratio on the system response in resonance is significant.

With a damping ratio of 5%, the magnification factor is about 10; with a damping ratio of 50%, the
magnification factor is reduced to 1.

In general, the following can be concluded from this graphic [1]:

The system response at low frequencies is stiffness-dependent. In the region of resonance, the
response is damping-dependent and at high frequencies, the response is governed by the system
mass: mass-dependent.

It is important to keep this in mind when attempting to reduce the vibration of a structure. For example,
the application of increased damping will have little effect if the excitation and response frequencies are
in a region well away from resonance, such as that controlled by the mass of the structure.

The effect of resonance can also be illustrated in SCIA Engineer.
In the project “Harmonic_Load_1”, the excitation frequency is 5Hz. The eigenfrequency is 21.43 Hz.
So this is not in the resonance area.

To see the response in function of the frequency, we can create several load cases with other

excitation frequency. You can easily do this by copying the existing load case and changing the
excitation frequency. This is shown in the next example.
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Example 3-2: Harmonic_Load_1b 5-30Hz.esa

This example is a continuation of the previous example.
We have copied the harmonic load case and changed the name, description and frequency in each

load case.
" ~

B Load cases ﬂ
Al e BBEI=a & @FHEl A - Y
LC1 - Self-Weight MName

5Hz-5Hz Description

GHz-6Hz - N
THz-7Hz Action type anable

8Hz-8Hz LoadGroup LG2 =
JHz-9Hz Load type Dynamic -
10 Hz -10 Hz Specificati N . .
11 Hz - 11 Hz pecification armonic

12Hz-12Hz E Parameters

13Hz-13Hz ithmic d 455270229

14 Hz-14 Hz

15 Hz - 15 Hz Frequency [Hz]

16 Hz - 16 Hz Master load case Mone -
17Hz -17 Hz Mass combi Ch1 -
18 Hz-18 Hz

19 Hz -19 Hz

20Hz-20Hz

A Hz-21Hz

22Hz-22Hz

23Hz-23Hz

24 Hz - 24 Hz

25Hz-25Hz

26 Hz- 26 Hz

27 Hz- 27T Hz

28 Hz- 28 Hz Actions

29Hz-29Hz

30 Hz - 30 Hz Delete all loads S

Copy all loads to another loadcase S
| Mew " Insert " Edit " Delete | | Close |

Those load cases can then be grouped in a class. ]
M7 Result classes ﬂ
Al BB =& A AT
AllULS [Name 5-30 He

Description

B st

5Hz

6 Hz

THz

8Hz

9Hz

10 Hz
11 Hz
12 Hz
13 Hz
14 Hz
15 Hz
16 Hz
17 Hz
18 Hz
19 Hz
20 Hz
21 Hz
22 Hz
23 Hz
24 Hz
25 Hz
26 Hz
2T Hz
28 Hz
I 20 Hz I
30 Hz

| New ” Insert ” Edit " Delete | | Close |
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In the result menu, we can for instance ask for the Uz
displacement of the middle node.

By asking the result for the class of the load cases 5-30 Hz,

we can see clearly the effect of resonance if the excitation
frequency is near the eigenfrequency.

Preview

Properties

Displacement of nodes (1)

RERT:RY

Mame Displacement of nodes
Selection Current -
Type of loads Class -
Class 5-30 Hz -
Values Uz -
Text output Graph -
Extreme MNode -
Actions

Rl ¥esh B
Preview 3

BE BE | A0 W T defaun L= i - B
Displacement of hodes
Linear calculation, Extreme : Node
Class : 5-30 Hz
Uz [mm]
6,0000
5,0000 5.3714
4,0000
3,0000
2.0000
1,0000
1
0,0000
N N N N N N N 3] N N N N 3] N N 3] N N N N 5] N N 3] N N
==~ == R« =i n < A s R =~ < R~ < T =~ <= == R~ =~ <~ B = SR <~ = < R =}
e S L =
— = A4 A A A A A A ~ & M~ M~ &~ ofAsmms s

[ Ready [en]

Note:

Minunum
Maximum

[mm]

In SCIA Engineer, the logarithmic decrement is limited between 0,0001 and 10. The lower limit corresponds to
a damping ratio ~0,0016%. Zero damping is impossible since this would lead to an infinite response (division

by zero) in resonance.

The upper limit corresponds to a damping ratio ~85%. For structural vibrations, this is an extreme value,
which, in nearly all cases, will never be attained. Damping will be discussed in more detail in Chapter 5.
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Example 3-3: Harmonic_Load_2.esa

Another common application of a harmonic load is a structure loaded with a plunger system or a motor.
Both the reciprocating effect of the plunger and the rotating unbalance of the motor produce an exciting
force of the inertia type on the system.

For an unbalanced body of mass my, at an effective radius e, rotating at an angular speed v, the
exciting force F can be written as [1]:

F=m e-v? (3.13)

This is illustrated in the following example.

An electric motor with a mass of 500 kg is mounted on a simply supported beam with overhang. The
beam has a cross-section type HEA 240 and is manufactured in S235 according to EC-EN. The beam
has a length of 4m and the overhang is 3m.

The motor has an unbalance of 0,6 kgm. The damping ratio of the system is taken as 10%.

é\vt

HEA240

4000 1500 1500
A

The motor can operate at speeds of 800, 1000 and 1200 rpm. For each of these speeds, the amplitude
of forced vibration needs to be calculated to check, for example, if the vibrations induced by the motor
are acceptable.

One static load case is created: the self-weight of the beam. However, in order not to take the self-
weight into account for the dynamic calculation, the volumetric mass of S235 can be set to 1 kg/m3in
the Material Library. This will render it easier to check the results through a manual calculation.

A node has been added to the middle of the overhang to specify the location of the motor.

Step 1: Functionality

The first step in the Dynamic calculation is to activate the functionality Dynamics on the Functionality
tab in the Project Data.

Step 2: Mass group

The second step is to create a Mass Group.

B | Mass groups L&J
I 4 CoORNER— Ry = -
(S | Name MGL
Description
Bound to load case Mo -
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Step 3: Masses

After the Mass Group has been created; the 500 kg mass of the motor can be inputted in the middle of
the overhang.

©
o
!
g

L.

Step 4: Mass matrix

Next, the Mass Group is put within a Combination of Mass Groups, which can be used for defining
the harmonic loads at the different speeds.

B | Combinations of mass groups &J

KLY 4 9} & A -
eme R
Description
=l Contents of combination
MGL [-] 1,00

Step 5: Load cases

After creating the Mass Combination, three harmonic load cases can be defined, one for each speed.
Each load case uses the same Mass Combination and has the same damping specifications.

The damping ratio was given to be 10%. Applying formula (3.11) the logarithmic decrement can be
calculated:

278 _ 2:7-010 _ 631483883309

N J1- (010}

The forcing frequency is different for each load case and can be calculated from the given speeds:

27r rad 1m|n
_ _ rad -
Vgoo =800rpm Trev B0 =83,78 / = fgpo =13,33Hz

Viooo =1000rpm- zfr:\i/d _ légl: ~104,72 ra(y = 1000 =16,67 Hz

Viaeo =1200rpm- zfr'(:/d : l(;])l: =125,66 racy = 1500 = 20,00 Hz
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#

B | Load cases ﬁ
Mis LB Bci= ) El=El A =

LCI - Self-Weight |Name LC4
LC2 - Speed 800 rpm

Description Speed 1200 rpm

LC3 - Speed 1000 rpm . .

LC4 - Speed 1200 rpm Action type Variable -
LoadGroup LG2 B
Load type Dynarnic -
Specification Harmaonic -

= Parameters

Logarithmic decrement 0631483883399
Frequency [Hz] 20,00
Master load case MNone -
Mass combi Chil -
Actions
Delete all loads B
Copy all loads to ancther loadcase B
| Mew || Ingert || Edit || Delete | Close |

Step 6: Harmonic force

The parameters of the harmonic loads have been defined. What is left is inputting the amplitude of the
three exciting forces.

Using formula (3.13) these forces can be calculated from the forcing circular frequency and the mass
unbalance.

Fupp =M, € Vg, = 0,6kgm- (83,78 rad/ )2 = 4211,03N = 4,21kN
Flops =M, €+ V00, = 0,6kgm- (104,72 rad/ )Z =6579,74N = 6,58kN

Fito =M, - Vin:” = 0,6kgm- (125,66 rad/ f —047482N = 9.47kN

The loads are inputted through Load > Point Force > In Node

F3/—-9.47

Lo

=
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Step 7: Mesh setup

To obtain precise results for the dynamic calculation, the Finite Element Mesh is refined.

This can be done through Calculation, Mesh > Mesh Setup.

-

1 Mesh setup

===

= General mesh settings

Minimal distance between two peints [m 0,001
Average number of tiles of 1d element 10
Average size of 2d element/curved element [m] 000

3

Definition of mesh element size for panels Automatic
Average size of panel element [m] 1,000
Elastic mesh

= 1D elements
Minimal length of beam element [m] 0,100
Maxirmal length of beam element [m] 100,000

Average size of cables, tendons, elements on subsoil, nenlinear soi.. 1,000
Generation of nodes in connections of beam elements i
Generation of nodes under concentrated loads on beam elements

Generation of eccentric elements on members with variable height

Division on haunches and arbitrary members 5
Division for 2D-1D upgrade 50
Mesh refinement following the beam type None

Hanging nodes for prestressing

pEiRChC]

|- oKk [ Cancel |

The Average number of tiles of 1D element is set to 10.

Step 8: Solver setup

The last step before launching the calculation is setting the amount of eigenmodes to be calculated.

For this example, only one eigenmode is required so in Calculation, Mesh > Solver Setup the

number of frequencies is set to 1.

To compare the results with a manual calculation, the shear force deformation is neglected.

-
B Solver setup

===

e |

= General
Neglect shear force deformation [ Ay, Az »> A) v
Type of solver Direct
Warning when maximal translation is bigger than [mm] (00,00
Warning when maximal rotation is bigger than [mrad] 100,0
Print time in Calculation Protocol v

Coefficient for reinforcement 1
= Dynamics

Type of eigen value solver Lanczos
Mumber of eigenmodes 1
Use IRS (Improved Reduced System) method

Produce wall eigenmode results (needed for ECtools)

= (==

|-okf Cancel |
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Step 9: Calculation

All steps have been executed so the Linear Calculation can be started through
Calculation, Mesh > Calculation.

This gives the following results:

(ARRRRRRRRRR Y]
Eigen frequencies

N |f omega | omega® |T
[Hz] ([1/s] |[1/s°] |[s]
Mass combination : CM1

1 [1415 jpsss [7399,95 [0,07 |

The nodal deformations for the harmonic loads at the location of the motor are the following:

At 800 rpm:

N

i
N

At 1000 rpm:

4.8]
ﬂA[,GG

7

At 1200 rpm:

2,31
L ﬁ

/N

As stated in the previous example, it is important to keep in mind that the signs are not relevant since a
vibration occurs on both sides of the equilibrium position.
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Manual Calculation

In order to check the results of SCIA Engineer, a manual calculation is performed [15].

First, the calculated eigen frequency is checked using formula (2.3)

Using default engineering tables [11], the maximum static deformation of a simply supported beam with
length L, an overhang with length a and loaded with a load F at the end of the overhang is given as:

_ Fa’(L+a)

3.14
max 3E| (3.14)

AN

L a
/1
The rigidity k of this system can then be calculated:
_F _ 3EI
5. a‘(L+a)

Where: L =4m =4000 mm
a=1,5m=1500 mm
E = 210000 N/mm?2
| = 77600000 mm*

: N/ . 4
- 3-210000 Amz 77600000mm
(1500mm)? - (4000mm +1500mm)

_ N/ _ N
—3950,55 %nm — 3950545,45 %n

Applying formula (2.3):

3950545 ,45 N
o = X ' -ggggrad/
m 500kg S
2> f = 2 =14,15Hz
27

This result corresponds exactly to the result calculated by SCIA Engineer.

Applying formula (3.8) the frequency ratios can be calculated for each motor speed:

o = 7, :88,89ra% e
rad
oo = Yoo =1O4,72 dA =11781
ra '
© 88839 4
125,66rad
o = 2= radA =14137
© 8889 A

The frequency ratios can then be used in formula (3.9) to calculate the Dynamic Magnification Factors.
When also applying formula (3.4) the Dynamic Amplitude can be calculated for each speed:
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- 421103y
800 3950545,45N
4 = /n =4,86mm

Ya00 :\/ N > v >
(L= Tap0 )" + (215006) \/(1—0,9425 ) +(2-0,9425-0,10)
6579,74N
FlOOO/ %950545,45 '\y
Yioo = > K = m =3,67mm
V@) + (2h)*  J(1-1,1782f +(2-11781-0,10)
9474,82N
Fiaco | %950545 45N
Y200 4 = ’ %n =2,31Imm

) ) J-1,41372 +(2-1,4137.0,10)

These results correspond exactly to the results calculated by SCIA Engineer.
In the same way as in the previous example, the calculation can be repeated for several angular
velocities. The result is shown graphically on the following figure:

Amplitude - Velocity Response
6
5 4
€
E
04
O
2
£3 1
<
c
2
22
2
>
3
st
o
LL
0 ‘ ‘ ‘
0 500 1000 1500 2000
Angular Velocity [rpm]

The main feature to notice is the decrease in vibration amplitude when the forcing frequency increases
due to moving away from resonance. [15]
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4. Spectral Analysis: Seismic Load

In this chapter the seismic analysis in SCIA Engineer is explained in detail.

During an earthquake, the subsoil bearing a structure moves. The structure tries to follow this
movement and as a result, the masses in the structure begin to move. Subsequently, these masses
subject the structure to inertial forces. When these forces are determined, they can be applied to the
structure and thus, like with the harmonic load, the dynamic calculation is transformed to an equivalent
static.

In the first part of the chapter, the theory will be explained. The theory will then be illustrated by
examples, which are again verified by manual calculations.

4.1 Theory

General

Analogous to the previous chapters, before examining the dynamic analysis of a complex structure, the
Seismic analysis of a SDOF (Single Degree Of Freedom) system is regarded in detail. A complete
overview can be found in references [2], [3].

Generally, this paragraph deals with the analysis of structures that are submitted to a harmonic ground
motion. The most important harmonic ground motions are earthquakes (seismic loads), but this
calculation method can also be applied to the analysis of underground or surface explosions and
vibrations generated by heavy traffic or machinery.

The following figure illustrates the displacement of a system that is submitted to a ground motion:

‘ y(t)
‘ >
u(t)
®
.
Yq(h)

Where:  yqy(t) is the ground displacement
y(t) is the total displacement of the mass
u(t) is the relative displacement of the mass

The total displacement can thus be expressed as follows:

y® = vy, + u(®) (4.2)
Since yyis assumed to be harmonic, it can be written as:

y (1) = Y, -sin(v-t) 4.2)
The equilibrium equation of motion can now be written as:

m-yt) + c-u(t) + k-u@t) = O (4.3)

Since the inertia force is related to the total displacement (y) of the mass and the damping and spring
reactions are related to the relative displacements (u) of the mass.
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When (4.1) is substituted in (4.3) the following is obtained:
m-ulty+y, () + c-ult) + k-ut) = 0

or

m-u@®) + c-ut) + k-u) = -m-y, () (.4)

This equation is known as the General Seismic Equation of Motion. This equation can be used to
illustrate the behavior of structures that are loaded with a seismic load:

Substituting (4.2) in (4.4) gives the following:

m-u.(.t) + c-u(t) + k-ut) = —-m-Y,-v2sin(v-t)

This equation can be compared with equation (3.2) of the previous chapter. As a conclusion, the
ground motion can also be replaced by an external harmonic force with amplitude:

F = -mY, v

But an earthquake will be a combination of many harmonic loads acting on different frequencies
simultaneously. The load represented in these harmonic loads is the acceleration of the structure
multiplied with the mass of the structure. The frequencies of these harmonic loads are the frequencies
on which this acceleration occurs in the earthquake.

The combination of all the accelerations over the different frequencies in the earthquake will be given
by a response spectrum. A response spectrum is therefore nothing more than a list of accelerations
and the frequencies on which they occur.

Response Spectra

When a structure has to be designed for earthquakes, in most cases spectral analysis is used because
the earthquake loading is often described as a response spectrum.
This response spectrum can either be a displacement, velocity or acceleration spectrum.

The relation of an earthquake (given by an acceleration time-history) and the corresponding
displacement response spectrum is given by [16]:

1 e :
Sq(§) = —-[I Yy (2)- €50 sin(eo(T —r))-dr} @5)
w max
Where: Yo (T) is the ground acceleration in function of time
& is the damping factor

T is the period 27/®

Instead of the displacement response spectrum Sq, also the velocity response spectrum Sy or the

acceleration response spectrum Sacan be used. These three spectra are related by w:
S, = oS, = a)Z-Sd (4.6)

a

In Eurocode 8 [7] the earthquake motion at a given point on the surface is represented by an elastic
ground acceleration response spectrum or “Elastic Response Spectrum Se” This spectrum is
illustrated in the following figure:
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2,550

I'n Te Ip r
A commonly used way of describing an earthquake magnitude is the so-called Richter scale. Annex A
gives a relation between the magnitude on the Richter scale and the Peak Ground Acceleration.
Spectral Analysis

For MDOF (Multiple Degree Of Freedom) systems, equation (4.4) can be written in matrix notation as a
set of coupled differential equations:

MU + CU + KU = —-M-{t}-Y, @.7)

The matrix {1} is used to indicate the direction of the earthquake. E.g. for a two-dimensional structure
(three degrees of freedom) with an earthquake that acts in the x-direction, the matrix is a sequence like
{1,0,0,1,0,0,1,0,0,...}

The resulting set of coupled differential equations is reduced to a set of uncoupled differential equation

by a transformation U = Z.Q, where Z is a subset of @ (the eigenvectors) and Q is a vector, which is
time-dependent.

M-ZQ + C-Z-Q + K:Z:Q = —M-{}-Yg;or

ZTM-Z-Q + 27-C-ZQ + ZT-K-Z:Q = -Z"-M-{L}-Y,
This can be simplified to a set of uncoupled differential equations:

Q + C-Q + QQ = -2"-M-{1}-Y, 4.8)

Where C” is a diagonal matrix containing terms like 2., .
Each equation j has a solution of the form:
1 o (1)
Q = -Z"-M -{1}-—-jvg(r)-e =) sin(w, (T - 7)) - d7 (4.9)
w 0

To obtain the maximum displacements, the displacement response spectrum Sq of equation (4.5) can
be substituted:

Qj,max = -Z"-M {1}Sd (gjia)j) (4.10)
Since U =Z.Q:

Uj,max = —Z'ZT-M'{l}-Sd(fj,a)j);or

Ujmxw = —Z-¥-5,(&j,0)) (4.11)

Where ¥ =Z" -M - {1 } is known as the modal participation factor.
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4.2 Seismic Load in SCIA Engineer

Response Spectra in SCIA Engineer

In SCIA Engineer, a Seismic Load can be inputted after creating a Combination of Mass Groups. This
implies that the steps used to perform a Free Vibration calculation still apply here and are expanded by
the properties of the Seismic Load.

As specified in the theory, Eurocode 8 [7] specifies an Elastic Response Spectrum Se. For design
purposes, this spectrum is reduced to a Design Spectrum Sq. This Design Spectrum is dependent on
several parameters: the Ground Type, the Ground Acceleration, the Behavior Factor and the
Damping.

When defining a spectrum in SCIA Engineer, the spectrum can be defined either by combinations of
Frequencies & accelerations, or Periods & accelerations, or by simply inputting the parameters that
define this spectrum according to Eurocode 8. If the user wishes to compose the spectrum based on
the parameters in Eurocode 8, then he will have the next input window:

-

Seismic spectrum Y
a1 b £
o2 8" Code parameters Iﬁ
013
coeff accel. ag 0,015
010 ag - design acceleration [m/s~2] 0,150
q - behaviour factor 1,500
e beta 0,200
a0l I S, Th, Tc, Td manually? No = | WA
= a Subsail type A - b} =
Spectrum type type 2 -
— Direction Harizontal -
Frequency[Hz] N
Direction factor 1 ,m
_1 |000 U1 | s- <ol factor 1,000
_2 |05 Al | 1o 0,050 Period -
3 |05 Al | 1c 0,250
4 0,25 3 Td 1,200 Eurocode -
5_ 0.5 3 Mote MA not supported W Hz
6 |05 3 =
0,25 H
—? 025 1 lTl Cancel | 5
g8 025 3
9 |0,26 3,“
10 0,26 3,90 0,03 %
<l ¢ oK Cancel

[

For a detailed description of these parameters, reference is made to Eurocode 8 [7]. The following is a
brief overview for understanding the input needed for SCIA Engineer.

- Damping: The Design Spectra of Eurocode 8 are defined for a damping ratio of 5%. If the
structure has another damping ratio, the spectrum has to be adapted with a damping correction
factor n. This will be looked upon in more detail in Chapter 5.

- Ground Acceleration: The ground acceleration ag or the coefficient of acceleration a can be
calculated from agr by means of an importance factor.

= The ground acceleration ag can be calculated from the importance factor and the peak
ground acceleration (PGA) agr:

Y1 * Qgr (4.12)

77



Advanced Professional Training - Dynamics
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= The Coefficient of Acceleration a is defined as the ground acceleration divided by the
acceleration of gravity g:

a = Eg (4.13)

= The importance factor is derived from the return period of the seismic action and the
importance of the structure. An importance factor y, equal to 1,0 is assigned to the
reference return period.

= The peak ground acceleration (PGA) agr can be found from the seismic zones in
which a country is divided. By definition, the seismic hazard within each zone is
assumed to be constant. The hazard is described by a single parameter: the peak
ground acceleration (PGA) agr. The following figure illustrates the division in seismic
zones for the map of Belgium [9]:

JZONE 2

ZONE |

ZONE O

- Behavior Factor (EN1998, 3.2.2.5): To avoid explicit inelastic structural analysis in design, the
capacity of the structure to dissipate energy, mainly through ductile behavior of its elements, is
taken into account by performing an elastic analysis based on a response spectrum reduced
with respect to the elastic one. This reduction is accomplished by introducing the behavior factor

g.

= For the vertical component of the seismic action a behavior factor q up to 1,5 should
generally be adopted for all materials and structural systems. The adoption of values of
g greater than 1,5 in the vertical direction should be justified through proper analysis.

= The values of the behavior factor g, which also account for the influence of the viscous
damping being different from 5%, are given for various materials and structural systems
according to the relevant ductility classes in the various Parts of EN 1998. The value of
the behavior factor g may be different in different horizontal directions of the structure,
although the ductility classification shall be the same in all directions.

- Beta: The lower bound factor (g) for the horizontal design spectrum. The recommended value
for (B) is 0,2 but can be overruled by the relevant national annex.

= If you plot the spectrum as acceleration to frequency, then the most left value would be
the lower bound factor multiplied with the ground acceleration.

0250
[TTTT I T H

myl

013
m/s?
0 8 ' Code parameters
ol coeff accel. ag 0,015
ag - design acceleration [m/s*2] 0,150
. q - behaviour factor 1,500
. beta 0,200
i =00 18+0.1 5, Tb, Tc, Td manually? No
o0l Subsoil type A
h - S Hz = Spectrum tvpe type 2



— S, Th, Tc, Td manually?: If you set this to ‘No’, then the values to compose the spectrum are
calculated automatically from the other properties in this window.

— Ground Type: The Ground Type is dependent on the soil characteristics and is specified by
letters Ato E.

Ground | Description of stratigraphic profile Parameters
type
Vs (M/s) | Ngpr ¢, (kPa)
(blows/30cm)
A Rock or other rock-like geological > 800 _
formation, including at most 5 m of
weaker material at the surface.
B Deposits of very dense sand, gravel, or |360 —800 |= 50 = 250

very stiff clay, at least several tens of
metres in thickness, characterised by a
gradual increase of mechanical
properties with depth.

C Deep deposits of dense or medium- 180 -360 |15-50 70 - 250
dense sand, gravel or stiff clay with
thickness from several tens to many
hundreds of metres.

D Deposits of loose-to-medium < 180 <15 <70
cohesionless soil (with or without some
soft cohesive layers), or of
predominantly soft-to-firm cohesive
soil.

E A soil profile consisting of a surface
alluvium layer with v values of type C
or D and thickness varying between
about 5 m and 20 m, underlain by
stiffer material with v > 800 m/s.

- Type of spectrum: If the earthquakes that contribute most to the seismic hazard defined for the
site for the purpose of probabilistic hazard assessment have a surface-wave magnitude, Ms, not
greater than 5,5, it is recommended that the Type 2 spectrum is adopted. A simple formula to
find the surface wave magnitude from the Richter magnitude scale ([29]) is:

M, = —3,2 + 1,45 M, (4.14)

- Direction: If the spectrum is applied in X or Y direction, then this must be set to ‘Horizontal’. If
the spectrum is to be applied in the Z direction, then this property must be set to ‘Vertical'.

Calculation Protocol

In the calculation protocol of SCIA Engineer the intermediate results that were determined while
calculating the global effect of a spectral loading can be found.

This paragraph describes the formulas that have been used to determine those intermediate results.

Natural circular frequency and modal shape

Mass matrix M],

Mass vector {m}=[M], - {1}
Natural circular O, .

frequency of mode W

shape j
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- : =
mitg;iﬂggga“md {8}y, With {¢};) -[M1p ¢}, =M, =1
Total mass in ki M

direction fotot

Acceleration response S.. )

spectrum

Direction k

Total number of NK

directions

Participation factor of the mode shape j in direction k

{43 Am}
Participation factor Vi) = = :{¢k}T -{m}
M. .
(J)

. 2 2
Effective mass My ey =7 M) =7
Participation mass L _ M k.ef,(J)

i k() —
ratio M ot
Mode coefficient for mode j
Mode coefficientink®™ | 5 _ Sakii) Tk
direction k() w?
(J)
NK
- 2 Sakiiy i
Total mode coefficient G, . = k=t
) — (02
()

Response of mode shape j

{u}) =G, {8}
{uely) =Gy ol

Displacement

{uy;, = “’(21) -Gy {d})

Acceleration . )
{uk}(j) = Oj) 'Gk,(j) '{¢k}(j) = Sa,k,(j) V) '{¢k}(1)

Lateral force in node i — . . .
for direction k Fi,k,(/') - mi,k,(/‘) Sa,k,(j) 7k,(/') ¢i,k,(j)

F . .. =>SF,, .. =fti.V.. .fm=S., . - . T .Im
Shear force in direction | “Y .z ey =UUd) AM=Sawgy 7 Ao M

K _ 2
Fiiiy = Sanihy Vit

Overturning momentin | M. . =m., -S_, .. . @2
node i for direction k Hell) " Zaki) ) ¢I'k’m I

Mgy = Z.: Miwi) = Z(mi.k “Sak.(y YeGy P Zi)

Overturning moment in

direction k My = Sakisy Vi 2 (Mo by - 21)

i

The calculation of these parameters will be illustrated with an example further in this chapter.
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Modal combination methods

Modal combination methods are used to calculate the response R of a seismic analysis. The term
"response” (R) refers to the results obtained by a seismic analysis, i.e. displacements, velocities,
accelerations, member forces and stresses.

Because the differential equations were uncoupled, a result will be obtained for each mode j.

To obtain the global response R Of the structure, the individual modal responses R have to be
combined.

The modal combination methods that are used in SCIA Engineer are:

1. SRSS-method (Square Root of Sum of Squares)

N
Rt = ,/ZR(ZD
j=1

Where:
R, : The response of mode j

2. CQC-method (Complete Quadratic Combination)

N N
Rt = \/ZZRU) PRy

i=L j=1

Where:
R(i), R(j) . The response of mode i and j

Pi.j: Modal Cross Correlation coefficients.

o8& lawrg)r

M gl ) g e

&, &;: Damping ratio for mode i and .

This method is based on both modal frequency and modal damping. The CQC-method thus requires
the input of additional data: a Damping Spectrum to define the damping ratio for each mode.

In many cases however, there is no procedure to calculate the damping ratio for the higher modes.
Most of the time, the same damping ratio is then used for all modes [17].

3. MAX-method

N
_ 2 2
RtOt - \/R(jMAX) + Z R(j)
=

Where:

R(j) . The response of mode j
R

Gax ) - The maximum response of all modes

Eurocode 8 [7] prescribes the SRSS-method. However this method may only be applied if all relevant
modal responses are independent of each other. This is met if the period of mode j is smaller or equal
to 90% of the period of mode i.

If modal responses are not independent of each other a more accurate procedure like the CQC-
method needs to be used.

The following numerical example shows this difference between SRSS and CQC.
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Example 4-1: Spectral_Analysis_1.pdf

A four-storey symmetrical building is modeled in a 3D analysis (from [18], p.15-9). The building is
symmetrical; however, the centre of mass of all floors is located 25 inches from the geometric centre of

the building.
Frame # 1
[ » » N ! |
‘4— 200" —»|+1 50"—>|<— 200" —>|
Frame # 3 —\ T
-\ Frame # 2 » g
£ <t
uCg [}
¥ e C.G. Te} ?:)
(] [ ] =
o ®
o Frame # 4 ‘ M
Y » '/7- u = = = ———L
«— 250" —
«—+—— B50" —

The structure has the following natural frequencies for the first 5 modes:
Mode 1: f = 13,87 Hz
Mode 2: f = 13,93 Hz
Mode 3: f = 43,99 Hz
Mode 4: f = 44,19 Hz
Mode 5: f = 54,42 Hz

Itis clear that modes 1 & 2 and 3 & 4 are very closely spaced. It is typical for most three-dimensional
building structures that they are designed to resist earthquakes from both directions equally. Therefore
the similar eigenmodes in X and Y-direction have almost the same natural frequencies.

Because of the small mass eccentricity, which is normal in real structures, the fundamental mode
shape has x, y, as well as torsion components. Therefore, the model represents a very common three-
dimensional building system.

The building was subjected to one component of the Taft 1952 earthquake. An exact time history
analysis using all 12 modes and a response spectrum analysis were conducted. The maximum modal
base shears in the four frames for the first five modes are shown in the figure below.

47.33k 52.30k

The maximal base shear forces are: 2 veme | |3 F|| Vamm | |8

Mode 1: F =-57,53 kN © S @

Mode 2: F = 52,30 kN ! -

Mode 3: F = -9,02 kN EED 52204

Mode 4: F = 8,12 kN

Mode 5: F = 0,33 kN 742k 812k 0.40k

A
g J§ 3 o ‘§ E{ vs, - }é
\J
Temk Tenk Tomk

To obtain the Global Response, these modal responses are combined using both the SRSS-method
and the CQC-method as well as a sum of the Absolute Values.
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Now the maximum total base shears using different methods are compared.

The time history base shears are exact.

The SRSS method produces base shears that under-estimate the exact values in the direction
of the loads by approximately 30 percent and overestimate the base shears normal to the loads

by a factor of 10.

The sum of the absolute values grossly over-estimates all results.

The CQC-method produces very realistic values that are close to the exact time history solution.

102.1 k
—_—

X
<
-
w0
B ——
112.4Kk
(a) Time History
116 k
e
©
127 k

(c) Sum of Absolute Values

Results for the global Base Shear:

In this example, the SRSS-method overestimates the Base Shear by a factor of 10.

4.85k

127 k

Exact solution using Time-History Analysis:
Global Base Shear using SRSS:
Global Base Shear using CQC:

714k

-

788k

8.4k

78.8 k
(b) SRSS

100.8 k

-
1M1.1k

(d) cac

Lateral
112,4 kN
78,8 KN
111,12 kN

714 k

8.0k

Transversal
5,44 kN
78,8 KN
6,37 kN

For the CQC-method, the following Modal Cross Correlation coefficients p;; are used with a damping

ratio & ; of 5%.

Mode 1 2 3 4 5
1 1,000 0,998 0,006 0,006 0,004
2 0,998 1,000 0,006 0,006 0,004
3 0,006 0,006 1,000 0,998 0,180
4 0,006 0,006 0,998 1,000 0,186
5 0,004 0,004 0,180 0,186 1,000

It is of importance to note the existence of the relatively large off-diagonal terms that indicate which
modes are coupled.

If one notes the signs of the modal base shears shown on the previous page, it is apparent how the
application of the CQC method allows the sum of the base shears in the direction of the external

motion to be added directly. In addition, the sum of the base shears, normal to the external motion,
tend to cancel.

The ability of the CQC-method to recognize the relative sign of the terms in the modal response is the
key to the elimination of errors in the SRSS-method.
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4.3 Seismic calculation in SCIA Engineer

The following diagram shows the required steps to perform a Spectral Analysis calculation:

Activate the functionalities - Dynamics

- Seismic

Create a Mass Group

Input Masses Generate Masses from Static Load cases

~, =

Create a Mass Combination

'

Define a Seismic Spectrum

l

Create a Seismic Load case

h 4
Refine the Finite-Element Mesh if required

h 4
Specify the number of Eigenmodes to be calculated

'

Perform a Linear Calculation

As specified in the theory, the dynamic calculation is transformed to an equivalent static calculation.
Therefore, a Linear Calculation needs to be executed. During this calculation, the Free Vibration
Calculation will also be performed since this data is needed for the Seismic results.

The diagram is illustrated in the following examples.
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Example 4-2: Spectral_Analysis_2.esa

In this example a three-storey structure is modeled as a cantilever. The members have cross-section

IPE 200 and are manufactured in S235 according to EC-EN. The height of each storey is 4m. At each
storey-level, the structure carries a mass of 500 kg.

IPE200 IPE200
4000 4000

IPE200
4000

One static load case is created: the self-weight of the structure. However, in order not to take the self-
weight into account for the dynamic calculation, the volumetric mass of S235 can be setto 1 kg/m3in

the Material Library. This will render it easier to check the results through a manual calculation.
The structure will be subjected to an earthquake in X-direction according to Eurocode 8, using a
Design Response Spectrum for Ground Type B with a behavior factor of 2. The coefficient of

acceleration is 0,35.

Step 1: Functionality

The first step in the Dynamic calculation is to activate the functionality Dynamics on the Functionality
tab in the Project Data. In order to execute a Seismic calculation, also the Seismic functionality needs

to be activated:

Project data

Basic data | Functionality | Actions

Protection

,,_'T

soa T [z
Enginees Initial stress
Subsoil
Menlinearity
Stability

Climatic loads

Prestressing

Pipelines

Harmonic band analysis

General dynamics

MNeon proporticnal damping
Steel

Fire resistance

Connection modeller
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Step 2: Mass group

The secong step is to create a Mass Group.

Step 3: Masses

B | Mass groups ﬂ
A eBEk 0 ElFHEH A - ¥
Nome MGL

Description

Bound to load case Mo -

After the Mass Group has been created; the 500 kg masses can be inputted on each

storey level:

Step 4: Combination of mass groups

Next, the Mass Group is put within a Combination of Mass Groups,

which can be used for defining the Seismic load case.

# ' Combinations of mass groups

Aia g | & aA

- Y
[Name [
Description
= Contents of combination
MGL [-] 1,00

Step 5: Seismic load case

After creating a Mass Combination, a Seismic load case can be defined through
Load cases, Combinations > Load Cases.

- Action Type = Variable.
- Load Type = Dynamic.
- Specification = Seismicity.
r B
B’ Load cases ﬂ
A g BRI &S =zE A - 7
LC1 - Self-Weight MName LC2
LC2 - Seismic X Description Seismic X
Action type Variable -
LoadGroup L&2 “ oo
Load type Dynamic -
scsmicty -
=l Parameters
B Direction X Karman yibration
L Harmonic

86

500.0

=¥l

INatalial

L x



Now the parameters for the seismic load case will become visible. These parameters will now be
explained (going from top to bottom).

= Parameters
= Direction X
= Direction Y
Direction ¥
= Direction Z
Direction £
Acceleration factor 1
Owverturning [m] 0,000
= Accidental eccentricity
Method Disabled -
= Modal superposition
Type of superposition SRSS ~
= Multiple eigenshapes
Unify eigenshapes
Mass in analysis Participating mass only -
= Signed results
Predominant mode
Master load case Maone ~
Mass combi Chl -

» Direction X, Y, Z: You must tick on a direction to apply a spectrum in this global direction.
We advise to use 1 direction per load case, and to combine the different load cases in a
seismic load combination.

o

After ticking on ‘X’, you will see the different spectrums which are already composed in
the project. You can tick on the three points on the line “Response spectrum X” to go
to the list with spectrums, and then choose “New” to create a new spectrum.

JpELII G P

= Parameters

El Direction X
Direction X v
repersespeanmi [
Factor X 1

El Direction Y

(A

It is also possible that there is no spectrum in the project yet. Then after ticking on ‘X,
the software will automatically open the list with spectrums and click on “New” for you.
The next window will pop up. Choose “Input type = Eurocode” and tick on “Code
Parameters”.

Seismic spectrum | =
s =L 01500
010
als
a1
s |
[
= - = = E & E
Frequency[Hz] Period(s] Acceleration[m/s"2 *
F F52
1 |o00 1000,00 0,02 [LEmE
2 |035 3,98 0,03 Drawing type Frequency hd
3 (025 397 0,03
4 |ozs 39 0,03 | S [Eurocade dl
5 |0,25 395 0,03
6 |05 304 003 T >0 e
7 (025 393 0,03 Step 0,25 Hz
8 (025 392 0,03
o |noe Code parameters
a (025 391 003 | Code parameters |
10 |0,26 3,80 0,03 &
4l ’ 0K Cancel
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o In‘Code parameters’ the spectrum will be defined (for more details, go to p.77).

= The coefficient of acceleration ag is 0,35 (see input).
Note that ag is automatically calculated after changing coeff accel. ag.

= The behavior factor q is 2,0 (see input).
= The subsoil type is type B (see input).
= We use spectrum type 2 (default).

= The spectrum is used in X (and Y) direction, so the Horizontal direction.

( 1" Code #ara meters [_J& |

coeff accel. ag 0,350 -

| ag - design acceleration [m/s*2] 3,434
q - behaviour factor 2,000
beta 0,200
5, Th, Tc, Td manually? Mo -
Subsoil type B -
Spectrum type type 2 T |E
Direction Horizontal -
Direction factor 1
5 - soil factor 1,350
Th 0,050
Te 0,250
Td 1,200
Blos. BIA ot o ol i

,Tl Cancel |

o After changing the parameters, click on ‘OK’ until you get back to the load case.

» Factor X, Y, Z: This is used to modify the accelerations in the spectrum without changing the
spectrum parameters. We advise to set this to 1.

» Acceleration factor: This factor is multiplied with the factor X, Y, Z (all of them). This factor
should be set to 1 since the acceleration factor is already used in the parameters of the
spectrum..

» Overturning: This parameter is used when the supports of the structure are above ground
level. By default, this value equals O.

» Accidental eccentricity: Most of the seismic codes require that structures are checked for
torsion due to mass eccentricity including an additional eccentricity, which is the “accidental
eccentricity”. Please note, that “accidental eccentricity” may be used only together with the
reduced model analysis. We will explain the reduced model analysis and accidental
eccentricity later on.

» Type of superposition: Here the type of modal superposition can be chosen. In this example,
the SRSS method is used. The use of the CQC method will be illustrated later on.

o SRSS: Square Root of the Sum of Squares. Because of the square root in the
formulas of the modal combination methods, the results are always positive.

R= \/ R% +R2, +R% +R% +R2 +.

o Max: Modified SRSS (method not included or described in Eurocode 8)

RtOt :\/ (imax) +ZR(J)

o CQC: Complete Quadratic Combination

\/ZZR Pij

i=1 j=1
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Note:

The options under Multiple Eigen Shapes can be used to avoid the errors in the SRSS-method for closely
spaced modes. As specified in the theory however, it is advised to use the CQC-method in such cases.

» Unify eigenshapes: This option can be used in the seismic analysis in the case of the method

SRSS. Classical the following formula is used for SRSS:

_ 2 2 2 2 2
R= \/R(l) +R% +R3 + R +R% +...

If the option unify eigenshapes is checked, then the following condition is verified:

w.
1—— < precision% (where i<j and w; < wj)
Wj

If the check is fulfilled and mode (i) and (j) are multiple, then the superposition will be modified:

R=\R%+(R

2 2 2
W +R(3)) +R(4)+R(5)+....

(2)

» Mass in analysis: The user has to verify if 90% of the total mass is included in de modal
masses. This will be checked later on in the calculation protocol. If the number of total
participating mass is under 90%, the number of eigen frequencies has to be increased.

To avoid this check, it is possible to choose missing mass in modes or residual mode.

» Signed results > Predominant mode: The user can select the mode shape which will be

used to define the sign. If automatic is chosen as mode shape, the mode shape with the

biggest mass participation is used (sum of direction X, Y and Z). This option can be used for

example for shear walls.

This result only makes sense if this single eigenmode is clearly the most dominant for that
spectrum, and all other modes have almost no significance for that spectrum. But since this
option manipulates the results, we advise you not to use it, unless you have a very good

knowledge of SCIA Engineer and of seismic calculations.

Note:

The options under Multiple Eigen Shapes can be used to avoid the errors in the SRSS-method for closely

spaced modes. As specified in the theory however, it is advised to use the CQC-method in such cases
(as advised in Eurocode 8, article 4.3.3.3.2).
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To conclude, the complete set of parameters in the load case will be shown in the image below.

i Load cases — |i|
A BB S @ A AT
LC1 - Self-Weight [Name Lc2
Description Seismic X
Action type Variable -
LoadGroup LG2 | e
Load type Dynamic -
Specification Seismicity -
= Parameters
= Direction X I
Direction X W
Response spectrum X Fs2 A e
Factor X 1
= Direction Y
Direction ¥
= Direction Z
Direction £
Acceleration factor 1
Cwerturning [m] 0,000
= Accidental eccentricity
Method Disabled -
= Modal superposition
Type of superposition SR35 -
= Multiple eigenshapes
Unify eigenshapes
Mass in analysis Participating mass only -
= Signed results
Predominant mode
Master load case Mone -
Mass combi chl -
Actions
Delete all loads ES 5
Copy all loads to ancther loadcase EF
| Mew || Insert ” Edit ” Delete | Close

Step 6: Finite element mesh

As specified in the previous chapters, the finite element mesh needs to be refined to obtain precise
results. This can be done through Calculation, Mesh > Mesh Setup.

For this example however, the default mesh is not refined which will make it easier to verify the results
by a manual calculation. But for a default dynamic calculation, we advise to change the number of 1D
elements in the finite mesh to 5 ~ 10 finite elements

MName

= General mesh settings

Minimal distance between two points [m] 0,001

Average number of tiles of 1d element | 10

Average size of 2d element/curved element [m] 1,000
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Step 7: Number of frequencies

The last step before the seismic results can be checked, is setting a sufficient amount of eigenmodes
to be calculated. For this example, 2 eigenmodes are chosen.
In Calculation, Mesh > Solver Setup the number of frequencies is thus set to 2.

[ B Solver setup &J‘
Mame
=l General

Neglect shear force deformation ( Ay, Az == A) v
Type of solver Direct »
MNumber of sections on average member 10
Warning when maximal translation is bigger than [mm] 10000
Warning when maximal rotation is bigger than [mrad] 100,0
Print time in Calculation Protocol 4

Cocfficient for reinforcement 1

Lanczos =
2

Type of eigen value solver

MNumber of eigenmodes

Produce wall eigenmode results (needed for ECtools)

| ok || Cancel |

To check if the number of eigenmodes is sufficient, the calculation protocol for the Eigen frequency
calculation must be checked. To check the calculation protocol, the Modal Analysis has to be done first
(under Calculation, Mesh > Calculation).

Properties R x
Calculatien pretocol (1) [~ %@ %
Name Calculation protocel

Type Eigen frequency =

Modal participation factors

Mode |Omega Period Freq. Wi f Wi f Wi f Wxi R/ |Wyi R/ |Wrzi R/
[rad/s] [s] [Hz] Whixtot Wytot Wrtot Whxtot_R |Wytot_R |Spectral

1 3.3027 15024 05256 07267 0.0000 0.0000 0.0000 02723 0.0000
2 216256 0.2505 34418 02154 0.0000 0.0000 0.0000 05273 0.0000
I 059421 I 0.0000 0.0000 0.0000 0.7996 0.0000

As specified in the first example of this course, the Modal Participation Factors show the amount of
mass that is vibrating in a specific eigenmode as a percentage of the total mass.

For the first Eigenmode, 73% of the total mass is vibrating. For the second Eigenmode, 22% is
vibrating. In total, these two Eigenmodes account for about 94% of the total mass.

According to Eurocode 8 [7] the sum of the effective modal masses for the modes taken into account
must amount to at least 90% of the total mass of the structure.

This criterion is fulfilled which indicates the two Eigen modes are sufficient for this example.

But it is important to see that the number of eigenmodes taken into account is only sufficient in the X-
direction to evaluate a dynamic load working in the X-direction. If the total would be under 90%, the
number of eigenmodes in the solver setup would have to be augmented and the calculation protocol
for the Eigen Frequency would have to be checked again.

91



Advanced Professional Training - Dynamics

Step 8: General results

The model has been prepared and checked to perform the Linear Calculation. This can be done
under Calculation, Mesh > Calculation.

Using Displacement of Nodes, the Deformed Structure can be shown to view the eigenmodes:

Eigenmode 1: Eigenmode 2: Results 2 x
o
----- FF Displacement of nodes
"""  Deformed Structure
422 3D displacement
ﬂ 3D stress
F-£ Supports
== Beams
El-04 Dynamics
Loz Eigen frequencies
[ TF Acceleration of nodes
r - Seismic detailed
-] Bill of material
-4 Calculation protocol
M (y
There is a separate part Dynamics where the eigen frequencies can be checked:
Results s
----- V¥ Displacement of nodes
""" 9 Deformed Structure
% 3D displacement
ﬂ 3D stress
E-& Supports Eigen frequencies
[#-== Beams
E-0% Dynamics N [f omega | omega® |T
L2 Eigen frequencies [Hz] |[1/s] [1/s] [s]
Pk Acceleration of nodes
..... D Seismic detailed Mass combination : CM1
-] Bill of material L\\) 1 |o53 [3.30 10,91 1,90
B Calculation protocol
2 [3.44 2162 |[467.,64 |0,29
The deformations caused by the seismic load case can also be checked under Seismic detailed.
Results o x Properties I x
Seismic detailed (1) [-]%8 V7
----- V¥ Displacement of nodes
""" ) Deformed Structure S
‘g 3D displacement MName eismic detailed
g 3D stress Selection All -
[ Supports Type of loads Load cases ~
[H-== Beams Load cases LC2 - Seismic X -
E-0% Dynamics Filter No -
Ly Eigen frequencies Modal results Displacements i
7 Acceleration of nodes Sum -
A Seismic detailed Values
-] Bill of material Al eigenmodes
B Calculation protocol Bareme Eigenmode 1
Eigenmode 2
Node X Y z Ux Uy Uz Fix Fiy Fiz
[m] [m] [m] [mm] [mm] [mm] [mrad] [mrad] [mrad]
N2 0,000 0,000 4,000 13,6 0,0 0,0 0,0 6,0 0,0
N3 0,000 0,000 8,000 43,6 0,0 0,0 0,0 9,0 0,0
N4 0,000 0,000 12,000 81,4 0,0 0,0 0,0 10,3 0,0
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The details of the seismic calculation can be found in the Calculation Protocol (Linear Calculation):

Dynamic loadcase: 2:LC2

Mode Freq. Damp Sax Say Saz Glj) Fx Fy Mx My
[Hz] ratio Damp | coe | [m/s?] [m/s?] [mys?] [kN] [kN] [kNm] [kNm]
1 0.53256 0.0500 1.0000 0.6870 0.0000 0.0000 2.0754 0.7489 0.0000 0.0000 -7.4878
2 3.4418 0.0500 1.0000 4.5856 0.0000 0.0000 0.1916 1.6112 0.0000 0.0000 -1.6585
Level= 0.00 1.78 0.00 0.00 8.82

The Damping ratio shows the manually inputted damping ratio for the respective Eigenmodes.
It is important to keep in mind that the Seismic Spectra of Eurocode 8 have been calculated with a
damping ratio of 5% as specified in the theory. When a damping ratio is manually inputted, the spectra

need to be adapted. This is done through the Damping Coefficient.

YV V V V

Sax, Say & Saz: These show the spectral accelerations.

G(j): This shows the mode coefficient for mode j.

Fx & Fy: These are the Base Shears for each mode.

Mx & My: These are the Overturning Moments for each mode.

The last line in the table shows the global response. This response was obtained by means of the

SRSS-method for combining the modal responses.

The formulas for these parameters have been shown in the theory and a manual check can be found in
annex C.
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Example 4-3: Spectral_Analysis_3.esa

The previous example is repeated and will now be calculated using the CQC-method. For all
frequencies, a damping ratio of 2% is used. In Step 6, CQC is chosen in the Type of evaluation box:

E] Load cases
| B3 e BB 0 & - A - Y
LC1 - Self-Weight MName Lc2
LC2 - Seismic Description Seismic
Action type Variable -
LoadGroup LG2 P
Load type Dynamic -
Specification Seismicity -
= Parameters
= Direction X
Direction X i
Response spectrum X ECE-SubscilclassB-q=2 e
Factor X 1
= Direction Y
Direction ¥ [
= Direction Z
Direction Z [
Acceleration facter 1
Overturning [m] 0,000
= Accidental eccentricity
Method Disabled -

= Modal superposition

Type of superposition CcQc -

Damping spectrum Damping P
= Multiple eigenshapes
Unify eigenshapes [
Mass in analysis Participating mass only -

= Signed resulis

Predominant mode

Master load case Mone -
Mass combi CM1 -
Actions
Delete all loads EES
Copy all loads to another loadcase EESS

| Mew ” Insert " Edit " Delete |

Using the button _I behind CQC, a damping spectrum can be inputted. Since for this example a
constant damping ratio will be used for all eigenmodes, the ratio of 2% is inputted starting from
frequency 0 Hz to 100 Hz

e e wa

el & EE A - Y
0.020_ 0.0200
0.015 |
]
MName Damping
= Freq.
req.Hal] 0.010]
1[Hz] 0,00/0,02
2 [Hz] 100,00 /0,02
0,003 ]
0.000]
= = =) = = =
L2} = = L= ) S

MNew Insert Edit Delete
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This damping spectrum will be used for the calculation of the Modal Cross Correlation coefficients of
the CQC-method and will also be used to calculate the Damping Coefficient for each mode as
specified in the previous example.

When the spectrum has been inputted, the Linear Calculation can be re-run.

The following results are obtained through the Calculation protocol of the Linear Calculation:

Mode Freq. Damp Sax Say Sar G(j) Fx Fy Mx My
[Hz] ratio Damp | coe | [m/s°] [m/s?] [mjs7] [kN] [kN] [kNm] [kNm]
1 0.5256 0.0200 1.1952 0.8211 0.0000 0.0000 243854 0.8951 0.0000 0.0000 -2.9456
2 3.4418 0.0200 1.1952 5.9589 0.0000 0.0000 0.2291 1.9258 0.0000 0.0000 -5.5680
Level= 0.00 2.12 0.00 0.00 10.54

The results show that for each mode, the Damping Ratio is equal to 2%.

As specified in the theory, the Seismic Spectra of Eurocode 8 have been defined using a Damping
Ratio of 5%. Since now another value is used for the damping, the spectrum needs to be corrected
using a Damping Coefficient n.

Following Eurocode 8 [6], this coefficient is calculated as follows:
10
(5+¢)

Where & = Damping Ratio expressed in percent

>0,55 (4.13)

For a default damping ratio of 5%, n equals unity.

The lower limit of 0,55 for the Damping Coefficient indicates that Damping Ratio’s higher than +
28.06% have no further influence on the seismic spectrum.

For the exact application of n in the formulas of the seismic design spectra, reference is made to
Eurocode 8 [7].

In this example, the damping ratio of 2% causes the following Damping Coefficient:

= =1,1953
T\ (5+2)

This indicates that the spectral accelerations will be augmented by 20% due to the fact that less
damping is present in the structure. The spectral accelerations of the previous example can thus be
multiplied by n:

m m
= Sax) =0, 68703—2 *1,1953 = 0, 82125—2

m m
= Sax(2) = 4,9856 5+ 1,1953 = 5,9589

With these new spectral accelerations, the calculation of the Base Shear, Overturning Moment,... can
be repeated.
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Manual Calculation
In this paragraph, the application of the CQC-method is illustrated for the global response of the Base
Shear.

—  Mode 1: o = 3,3027 rad/s  F@) =0,8951 kN
—  Mode 2: o) = 21,6256 rad/s Fp)=1,9258 kN

Using a spreadsheet, the Modal Cross Correlation coefficients p;i;j are calculated with a damping ratio

&ij of 2%.
Mode 1 2
1 1 0,0003065
2 0,0003065 1

0,8951 kN = 1 * 0,8951 kN + 0,8951 kN * 0,0003065 * 1,9258 kN
+1,9258 kN % 0,0003065 * 0,8951 kN + 1,9258 kN 1 * 1,9258 kN

N N

Reoe = R;* pij*R;
=1 =1

2,12 kN
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4.3 Seismic Combinations

There are different possibilities to create load combinations which include also seismic load cases.
Since SCIA Engineer 14, there is an optimal possibility available due to some changes in seismic
combinations. This is also linked to the following message which is displayed when opening an older
project with dynamic functionalities activated in it:

Scia Engineer 15.0.1019

The EC-EM Seismic combination generation has been modified, The
different concomitant seismic actions are now automatically combined
according to the rules given in EN 1998-1 Article 4.3.3.5.2.

- The generation of coefficients will be done only for seismic load cases
from seismic load groups which have their relation set to Together',

- Any load case of the type "Seismic Accidental Eccentricity’ will receive
the same combination coefficient as its master Seismic load case.

The above generation of coefficients does not apply in case 'Active
coefficients' are used.

Example 4-4: Spectral_Analysis_4 Combs.esa

First of all, 3 load cases are created.
The general format of effects of actions should be:

Ey = E<Gkvj P AEd;'//z,iQk,i> j2Lix>1
The combination of actions in brackets can be expressed as:

sz,j +TP Ay "+"Zl//2,iQk,i

i>1 i>1

Where E,,.

Eeg +0,3Eg,, +0,3Eg,
0,3E., + EEdy +0,3E,
0,3Egg, +0,3E¢,, + Egy,

So, these load cases include respectively the seismic spectra in the directions X, Y and Z.
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For example:

e AR =

Direction X
= Direction Y
Vi

| A3 2 BEI= = & =H A - Y
LCL-P [Name | Lca
Lc2- se?m ® Description seim z
Iw Action type Variable
- ca LoadGroup LG2
Load type Dynamic
Specification Seismicity
= Parameters
= Direction X

= Direction Z
Direction £
Response spectrum £
Factor £

&l
F52
1

Acceleration factor

Overturning [m]
= Accidental eccentricity
Method
= Modal superposition

Type of superposition
= Multiple eigenshapes
Unify eigenshapes

Mass in analysis

1
0,000

Disabled

SRSS

=

Participating mass only

= Signed results
Predominant mode
Master load case

Mass combi

Actions
Delete all loads

Copy all loads to another loadcase

Please note that a different Eurocode must be generated for the vertical direction. In SCIA Engineer, a
load case must be made for component of the earthquake in the X-direction, another for the Y-
direction, and another for the Z-direction.

Please make sure that the ‘factor’ just underneath the spectrum is not set to ‘zero’, since the
accelerations in the seismic spectrum will be multiplied with this value.

Seismic spectrum -

a1z

coeff accel. ag 0,015

ag - design accele., 0,150
q - behaviour factor 1,500

beta 0,200
S, Tb, Tc, Td man... No
Subsoil type o}

Spectrum type type 2
Direction Vertical

Frequency[Hz] Direction factor 0,45
Fs2

1 (0,00 5 - soil factor 1,000 I

2 (0,25 Tb 0,050 lm
3 10,50 Tc 0,150

4 (075 Td 1,000 Eurocode -
5 [1,00 Blot. MA ot

|30,00 Hz

6 |125

7 (150 0,25 Hz I
& |175 ’

9 |200 Code parameters |
10 [2,25
k] Cancel |
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Next, we have to assign a type of load group to the seismic load case.

First of all, the relation between load cases in the same group has to be defined. The three seismic
spectra have to appear always in the same combination. So, the option ‘together’ will be chosen here.
Next, the type of load has to be selected: for this, the special type ‘seismic’ has been implemented.

-

Aiemiio = &l=zE
Name =
Relation Together v
Load Seismic
bl "

After the creation of seismic load cases, the combinations can be made. For this purpose, a new type
of combinations was implemented: namely the Seismic combination according to the EC-EN.

To use this special type of combination, the seismic load cases must have a load group with properties
‘seismic’ and ‘together’ assigned to it. Also no active coefficients can be used.

=

28 & B3 Bel <2 ¢ | & | Input combinations
Nome Sesmic 15

Description

Type EM-5eismic
Structure Building
|Active coefficients L
= Contents of combination

LC1 - P[]

LC2 - seim x [-]

LC3 - seim y [-]

LC4 - seim z [-]

LC5- QS catE[-]

Actions

Explode to envelopes

Explode to linear

Show Decomposed EN combinations

| New ” Insert || Edit || Delete |

This combination will automatically look at the seismic load cases with both a positive and a negative
coefficient, and will automatically make one of the seismic load cases the primary load case and the
others secondary load cases.

If we would not yet take into account that the coefficients can be both positive and negative, then an
example would be:

Eco +0, 3EEdy +0,3E,,
0,3E.,, + EEdy +0,3E,
0,3E., +0, 3EEdy + Egg,
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Note:

In the case of the EC-EN, we have to make two sets of combinations, one for the deformations and
one for the internal forces. This means that we would have in total 6 EN-Seismic load cases. For
internal forces, the load cases have to be introduced as described above. For deformation results, we
must create 3 new load cases, which have a behavior factor g equal to 1.0.

If we consider our example with a q factor of 1.5, we would have to copy the existing seismic load
cases, and give the new load cases new spectra with a behavior factor q set to 1,0.

i VRIILUNY  LIC|

La-p Mame LG8
LC2 - seimx Description seim z def
LC3 - seimy . X
LC4 - seim z Action type Variable -
LC5-Q/catE LoadGroup LG2 L
LCH - seim x def Load type Dynamic -
LT - seim y def P L
LCR - seim z def Specification Seismicity hs

= Parameters

E Direction X

Direction X [
= Direction Y
Direction ¥ [

Then all you have to do, is make a new seismic combination with the new load cases.

e

A @ BBl ) 2| & Input combinations

Seismic_ULS [Narme | Seismic_Def

Description
Type EN-Seismic
Structure Building
Active coefficients [

= Contents of combination
LC1-P[-]
LCS-Q/catE[-]
LCH - seim x def [-]
LCT - seim y def [-]
LC8 - seim z def [-]

Actions

Explode to envelopes
Explode to linear

Show Decomposed EN combinations

| New || Ingert || Edit || Delete |
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4.4 Mass in Analysis

4.5

As mentioned before, the sum of the effective modal masses for the modes taken into account must
amount to at least 90%. The user can try to achieve this with the following possibilities:

- Take more natural frequencies into account.

- Assign mass more to nodes/connection instead of beams (to avoid local eigenmodes).

The mass which has not been taken into account (for example, if the effective modal mass is 90%,
then there is 10% not taken into account), can be treated in 3 possible different ways in SCIA Engineer:

hass in analysis

Faricipation mass anly -
hissing mass in modes -
Residual mode 0

The used method is set in each seismic load case and is again displayed in the linear calculation
protocol. Let’s take as example that the effective modal mass in a direction is 90%. Then how can the
other 10% be treated?

- Participation mass only: In this case, the 10% would be ignored. We would only take into
account 90% of the mass of the structure to calculate the effects of an earthquake.

- Missing mass in modes: In this case, the missing mass would be divided over the calculated
modes. Which means the 10% would be distributed over the eigenmodes which make up for the
90% which we did find. This is done according to their weight. So for the calculation of internal
forces and deformations, the masses in the calculated modes would be increased by 100%/90%
=1,111...

- Residual mode: In this case, a ‘fictual’ mode corresponding to the combination of all missing
modes can be calculated. But since these missing modes are over different natural frequencies,
the last found frequency will also be the natural frequency of this mode. In the calculation, the
forces in this mode will be calculated in the same way as in the other modes.

A detailed explanation of these modes by using examples can be found in Annex D.

Modal superposition

The response spectrum method uses a modal superposition of the relevant eigenmodes of the structure. The
methods which are used for modal superposition are the ones described at the beginning of the chapter:
SRSS or CQC.

These methods have the advantage of very easily providing design values of all results (displacements,
internal forces...) but only part of the information is available:

min and max values of any result can be determined
the actual sign of a result cannot be defined

the concomitance of separate results cannot be defined

The loss of concomitance and sign of results is an issue typically when computing resulting forces in shear

walls

. it is not possible to compute a resultant from internal forces after modal superposition, as typically all

raw results are positive.
Computing resultant forces in one of those shear walls would typically give near-zero moments and
extremely overestimated axial forces.
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In SCIA Engineer 2013 and higher, an automatic method can be used since using signed results
(described below) is only a workaround to obtain usable resulting forces.

The rigorous method for computation of resultants in the context of the response spectrum method can be
summarized as follows:

e compute the local internal forces for each eigenmode
e compute the resultant force for each eigenmode separately

o apply the modal superposition to the obtained modal resultant values

When proceeding so, no result signature is necessary to obtain correct values of resulting forces. Moreover
there are cases where the method described in the previous paragraph gives overestimated results of most
result components and can therefore only be seen as an approximation. The method described here is
clearly more accurate.

Since version 2013, this option is enabled by default for new projects in SCIA Engineer. For old
projects, you have to open the Solver > Setup and activate it:

e R, ==

Mame
= Solver
Fun one nonlinear combination
Meglect shear force deformation | Ay, Az == A)
Type of solver

Type of eigen value solver
Mumber of sections on average member
Waming when maximal translation is bigger than [mm]
Waming when maximal rotation is bigger than [mrad]
Frint time in Calculation Protocol

Coefficient for reinforcement

= Dynamics

Mumber of frequencies
Usze reduced model

Produce wall eigenmode results (needed for ECtools)

Enable advanced modal superposition for seismic load cases

0K Cancel

To obtain usable values of resulting forces, a possibility is the so-called “signed results” method.
It consists of applying some signature scheme to raw results of the modal superposition. A classical
approach uses the sign of the most significant eigenmode.

It is however very important to know that this method will only give good result if there is 1 and only 1
eigenmode of great importance in that respective direction (compared to the other eigenmodes).
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Modal
superposition

180

=7.7
—18.0
(3]
T
188 —
I ——
]
o
-3 —E9
mRI = —I05

7.2
=174
—a4

Predominant
mode

Resultiﬁg signed envelope

T
N
&1

—£.4

Applying this to shear walls, it is possible to “sign” the internal forces, making them suitable for computation

of resulting forces.

You can sign results in SCIA Engineer by selecting a signature mode manually or a default mode determined
by the program. If the Automatic is chosen, the mode shape with the biggest mass participation is used (sum
of direction X, Y and 2):

e, ==
j‘- cases

A s BRI =& & A - ¥

L1 - Self Weight

5X

New Insert

L2 - Floer + Reof Weight
LC3 - Imposed Load on Floors

Edit

Delete

m

Fi

Crwvertuming [m] 0,000
El Accidental eccentricity
Accidental eccentricity Disabled
= Type of superposition
Type of superposition SRSS
= Unify eigenshapes
Unify eigenshapes ]
Mass in analysis Participating mass onfy
= Predominant mode
Predominant mode
Automatic
Master load case Automatic
Mass combi !
Actions |i
Delete all loads '

Copy all loads to another loadcase

55
3

Close
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In the previous chapters, the influence of damping on the dynamic response of a structure was shown.
Especially in the vicinity of resonance the effect of damping was significant.

In this chapter, damping will be looked upon in more detail. First the theory will be explained after
which the input of non-uniform damping in SCIA Engineer is regarded.

By means of the examples of the previous chapter, the influence of damping on the seismic response
is illustrated. The chapter is finished with a 3D structure, which takes into account material damping of
the different elements.

5.1 Theory

Damping can have different causes. The component that is always present is structural damping.
Structural damping is caused by hysteresis in the material: the transfer of small amounts of energy into
warmth for each vibration cycle possibly increased by friction between internal parts.

Other causes can be the foundation soil of the building and aerodynamic damping due to the diversion
of energy by the air [22]. In many cases, damping is increased by adding artificial dampers to the
structure.

In the same way as for the previous chapters, first the theory is examined. A complete overview can be
found in reference [1].

Consider the following damped free-vibrating system:

AAA-

k

— 1 c
A body of mass m can move in one direction. A spring of constant stiffness k, which is fixed at one
end, is attached at the other end to the body. The mass is also subjected to damping with a damping
capacity c.
The equation of motion, using matrix notations can be written as:

M-xt) + C-x(t) + K-x(t) = 0 (5.1)
A possible solution to this equation is one of the type:

x = A.e¥ (5.2)

Substituting (5.2) in (5.1) gives:
M-s®>-A-e* + C-s-Ae® + K-Ae" =0

(5.3)
This equation can be rewritten as:
s> + 2ns + o =0 (5.4)
. C
With: n = — (5.5)
2M
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o, = |— (5.6)

The possible solutions for equation (5.4) are:

2

s = -n = Jn’-a (5.7)

Itis clear that the response of the system depends on the numerical value of the radical. Therefore the
following three possibilities need to be examined:

n = o,
n < o, (5.8)
n > w

These can be rewritten as:

C = 2-JK-M
C < 2+VK-M (5.9)
C > 2-+K-M
The conditon C = 2-vK-M = C, is called critical damping. In this case, the displaced body

is restored to equilibrium in the shortest possible time, without oscillation.

C
The ratio & = C_ is called the damping ratio or the relative damping.

c

Therefore, when assuming N = ¢ - @, , equation (5.5) can be written as:

C = 2¢w,-M (5.10)
The three possibilities of equation (5.8) can then be rewritten as:
£ =1
& < 1 (5.11)
& > 1
When looking at the conditions & = 1and & > 1,itcan be shown that there is no harmonic

solution. Only the condition & < 1 gives a harmonic solution.

Introducing the damped circular frequency @y, = @, 11— fz , the solution to equation (5.1)
can be written as:
x = e "{A.cos(wpt)+B-sin(wpt)} (5.12)

In chapter 2 this vibration equation was illustrated by the following figure:

105



Advanced Professional Training - Dynamics

N
~

ﬂ\ {»“
[LZ)-\J?:X;EEE-__ t

- v =fwt

v Exponential decay Xe

X
i
| Circular frequency /(1 — t2)w = w,

A convenient way to determine the damping in a system was shown to be the logarithmic decrement
A, which is the natural logarithm of the ratio of any two successive amplitudes in the same direction.

A=inZeo 2T

(5.13)
X 1-&

Note:

As shown above, the circular frequency is reduced by the damping action to obtain the damped circular
frequency. However, in many systems this reduction is likely to be small because very small values of &
are common; for example, in most engineering structures &is rarely greater than 0,02. Even if £=10,2;
@p=0,98 an

Annex B gives some references for numerical values of the damping ratio.

5.2 Damping in SCIA Engineer

In SCIA Engineer, damping can be specified on 1D elements, 2D elements and supports. The damping
of each of these elements (or substructures) will be used to calculate a modal damping ratio for the
whole structure for each Eigenmode. In the literature this is described as Composite Damping.
Composite damping is used in partly bolted, partly welded steel constructions, mixed steel-concrete
structures, constructions on subsaoil, ...

For structural systems that consist of substructures with different damping properties, the composite

damping matrix C can be obtained by an appropriate superposition of damping matrices Ci for the
individual substructures:

N
cC = >¢ (5.14)
i=1
With: C, = The damping matrix for the it" substructure in the global coordinate
system.

N = The number of substructures being assembled.

Proportional Damping (Rayleigh Damping)
A way of describing the damping is assuming that the damping matrix is formed by a linear
combination of the mass and stiffness matrices.

With: ai and S = Proportional damping coefficients for the it part of the structure.
Mi = Mass matrix for the ith part of the structure in the global coordinate
system.
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Ki = Stiffness matrix for the it" part of the structure in the global coordinate
system.

Formulas for these proportional damping coefficients can be found in reference [19].
Examples can be found in reference [20].

Stiffness-Weighted Damping

For structures or structural systems that consist of major substructures or components with different
damping characteristics, composite modal damping values can be calculated using the elastic energy
of the structure [8], [21]:

N
Zgi ’ Ei
gj = Ile (5.16)

With: fj = Damping ratio of the considered eigenmode.

E = Elastic energy of the structure, associated with the modal displacement of the
considered eigenmode.
N = The number of all substructures.

fi = Damping ratio for the it" substructure.
Ei = Elastic energy for the it substructure, associated with the modal
displacement of the considered eigenmode.

Equation (5.16) can be rewritten in the following way [19]:

q)jT'{Z[é:K]i:|'(Dj
95,- - i=1 5 (5.17)
o

With: [éK]i: Stiffness matrix for the it" substructure in the global coordinate system,

scaled by the modal damping ratio of the it substructure.

Note:
This formula may be used as long as the resulting damping values are less than 20% of critical. If
values in excess of 20% are computed, further justification is required.

As specified, in SCIA Engineer on each element a damping ratio can be inputted. For this ratio, also
the damping of the material can be used from which the element is manufactured.

When no damping ratio is inputted on an element, a default value will be used since all elements need
a damping ratio before the above formulas can be applied. The input of this default will be shown in the

examples.
Analogous to the input of other objects in SCIA Engineer, Damping on elements will be grouped in a

Damping Group. In turn, this Group can be assigned to a Combination of Mass Groups.

Support Damping
Additional to the damping of 1D and 2D elements, SCIA ENGINEER allows the input of a damper on a

flexible nodal support. The modal damping ratio §j is calculated by the following formula:

D, -[ch]cbsyj

4-w,

With: @, =The circular frequency of mode j

(5.18)

&, = Alpha

(Ds'j = The modal displacement in support node s for mode j
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Cs = The damping constant for the support

Alpha = A user defined parameter (> 0)
The total modal damping ratio can then be calculated as the summation of equations (5.17) and (5.18).
As specified, on all 1D and 2D elements a damping ratio has to be defined. This is not the case with
supports, not every support needs to have a damping value.

The following diagram shows how non-proportional damping is inputted in SCIA Engineer:

Activate the functionalities - Dynamics
- Non-Proportional Damping

'

Create a Damping Group

'

Input Dampers

'

Assign the Damping Group to a Mass Combination

'

Proceed with the steps of the previous chapters

The use of dampers and the calculation of the composite damping ratio will be illustrated in the
following examples.

Example 5-1: Damping_1.esa

In this example, the principle of stiffness-weighted damping is illustrated.

A concrete frame is modeled in which the beam is assumed to be rigid. In this case, only the columns
take part in the horizontal stiffness of the frame.

The left column has a Rectangular 500 x 500 section, the right column a Rectangular 350 x 350
section. The column bases are modeled as rigid. To model the rigid beam, a Rectangular 500000 x
500000 section is used. To make sure this beam acts as rigid, in the nodes between the columns and
the beam, supports are inputted which have a fixed Translation Z and Rotation Ry. The height of the
columns and the length of the beam are taken as 5m. All elements are manufactured in C30/37
according to EC-EN.
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Rigid Beam

N VS S
— ™~
O C C
) o
7777777 777777
/V 5000 /k

The beam is loaded by a line mass of 500 kg/m. The left column has a damping ratio of 12%, the right
column a damping ratio of 3%.
One static load case is created: the self-weight of the beam. However, in order not to take the self-
weight into account for the dynamic calculation, the volumetric mass of C30/37 can be set to 1e-10
kg/m?3 in the Material Library. This low value is chosen to avoid any influence by the rigid beam.
The steps of the Free Vibration calculation are followed and extended with the input of damping.

Step 1: Functionality

The first step in the Dynamic calculation is to activate the functionalities Dynamics and Non-
Proportional Damping on the Functionality tab in the Project Data.

-

Project data

S5

Basic data | Functionality| Actions Protection

BT -
| | Dynamics

Scia
Enginees nItial SLrEss
Subsoil
MNonlinearity
Stability
Climatic leads

Prestressing

Pipelines

Structural model

BIM properties

Parameters

Mobile loads

LTA - load cases

External application checks
Property modifiers

Bridge design

Document

m

= Dynamics
Seismic
Harmonic band analysis

Non proportional damping "

Fire resistance

Hollow core slab

oK | | Cancel
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Step 2: Mass group and masses

A Mass Group is created after which the line mass of 500 kg/m can be inputted on the rigid beam.

500,0
500,0

Step 3: Damping
Before creating a Combination of Mass Groups, the dampers are inputted.
=43 Dynhamics

----- @ Masses
----- I tass groups

----- {Bl Damper setup
----- it Dampers
----- @ Damping groups

First of all, a Damping Group is created.

g b

MiaeBE o S E A i
DGL Mame DGl

Description

Type of default damping Global default ~

| Mew ” Insert || Edit " Delete |

As specified in the theory, on each element a damping ratio needs to be inputted. When no damper is
specified, a default value will be taken. In the properties of the Damping Group, this default can be set
as either:
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- Global default: The logarithmic decrement specified in the Damper Setup will be used
- Material default: The logarithmic decrement of the material will be used

In this example, the Global default is chosen.
After the creation of a Damping Group, Dampers can be inputted. In this example, 1D Damping shall

be inputted on the columns. The damping can be inputted in the following ways, which have been
explained in the theory:
)

# 1D damping

Name D103

Relative damping

Logarithmic decrement

Relative damping
Rayleigh damping

Value

3

EIzIz 112

i OK H Cancel '_

On the left column, a Relative damping of 0,12 is inputted, on the right column a Relative damping of
0,03.

127% 3%

As a final step, the general parameters can be checked through Damper Setup:

p =)

B ' Damper setup

=l Global default

Base value - logaritmic decrement 0,05
Alpha factor for supports 05
Maxiral modal damping 0,2

The Base value specifies the default value when a Damping Group of type Global default is chosen
and no damper is inputted on an element.

The Alpha factor is used in the damping calculation for supports as specified in the theory.

When the composite modal damping ratio is calculated, the value is checked with the Maximal modal
damping value inputted here. If the calculated value is higher than the maximal value, the maximal
value is used. In this example, the maximal value is set to 0,2 in accordance with the remark for

formula (5.17)
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Step 4: Mass matrix

A Combination of Mass Groups can now be created and the Damping Group can be specified.

o

A LBkl Sla - Y
[Name En
Description
= Contents of combination
MG1 [-] 1,00
Damping group DGL =

Step 5: Mesh setup

To obtain precise results for the dynamic calculation, the Finite Element Mesh is refined.
This can be done through Calculation, Mesh > Mesh Setup.

T

= General mesh settings

Minimal distance between two points [m 0,001
Average number of tiles of 1d element 10

Average size of 2d element/curved element [m] 1,000

Definition of mesh element size for panels Automatic
Average size of panel element [m] 1,000
Elastic mesh &
= 1D elements
Minimal length of beam element [m] 0,100
Maximal length of beam element [m] 100,000
Average size of cables, tendons, elements on su... 1,000
Generation of nodes in connections of beam ele., ¥

Generation of nodes under concentrated loads ... [

Generation of eccentric elements on members ... [
Division on haunches and arbitrary members 5

Division for 2D-10 upgrade 50
Mesh refinement following the beam type

Hanging nodes for prestressing

EipEat!

The Average number of tiles of 1D element is set to 10.

Step 6: Solver setup

The last step before launching the calculation is setting the amount of eigenmodes to be calculated.
For this example, only one eigenmode is required so in Calculation, Mesh > Solver Setup the
number of frequencies is set to 1.

To compare the results with a manual calculation, the shear force deformation is neglected.

Name

=_General
MNeglect shear force deformation [ Ay, Az »> A v
Type of solver Direct

Number of sections on average member 10
‘Warning when maximal translation is bigger tha... 1000,0
Warning when maximal rotation is bigger than [... 100,0
Print time in Calculation Protocol v
Coefficient for reinforcernent 1
= Dynamics

Type of eigen value solver Lanczos

I Mumber of eigenmodes 1

Use IRS (Improved Reduced System) method

Produce wall eigenmode results (needed for ECt... [

Eigtapc)
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Step 7: Calculation

All steps have been executed so the Free Vibration calculation can be started through Calculation,

Mesh > Calculation.

The following results are obtained through the Calculation Protocol for the Eigen Frequency

calculation:

Sum of masses

[kgl X Y |z
Combination of mass groups 1 |2500.00 (0.00 (2250.00
Meodal participation factors
Mode |Omega Period Freq. Wi / Wi / Wizi / Wxi R/ |Wyi R/ |Wzi R/ |Damp ratio
[rad/s] [s] [Hz] Witot Wytot Wrtot Wxtot R |Wytot R |Spectral
1 89.0865 0.0705 | 14.1786 1.0000 0.0000 0.0000 0.0000 0.0000 0.0000 0.1026
1.0000 0.0000 0.0000 0.0000 0.0000 0.0000

The calculated modal damping ratio is shown to be 0,1026 or 10,26%.
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Manual Calculation

In order to check the results of SCIA Engineer, a manual calculation is performed.

First, the calculated eigen frequency is checked using formula (2.3)

In this example, the two columns can be treated as fixed-fixed beams. Using default engineering tables
[12], each column contributes the following stiffness to the frame:

k:12LI;:I

(5.19)

With: Column 1:
E = 32000 N/mm?2
| = 5208300000 mm*
L =5000 mm
Column 2:
E = 32000 N/mm?2
| = 1250500000 mm*

L =5000 mm
12-32000 N/, 5208300000 mm?*
Sk = e i = 15999,8976 N/
(5000 mm) mm
12:32000 N/ 1250500000 mm
=k, = Mmm —3841,536 N
? (5000 mm)? Viom

Both columns act in parallel since each column will displace the same amount due to the fact the beam
is rigid. The beam itself does not bend so it does not contribute to the stiffness.

= ko =k, +k, =159998976 N/ +3841536N/ 108414336\

The vibrating mass is calculated as:

5009/ -5m = 2500kg

19841433 6 N
o = K= ' - 89,087 rad//
m 2500kg S
—f = “ _-141787 Hz
27

These results correspond exactly to the results obtained by SCIA Engineer.

Next, the stiffness-weighted damping ratio is calculated. The first column has a damping ratio of 12%,
the second column a damping ratio of 3%.

Using the elastic energy principle of formula (5.16) the modal damping ratio can be calculated as
follows:

. N . N
cbkrgd 012-15999,8976 N/ +0,03-3841,536 N/ _
Kiot 19841,4336 N/
=0,1026 = 10,26%

This result corresponds exactly to the result obtained by SCIA Engineer.
The modal damping ratio can now be used to calculate the Damping Coefficient in a seismic
calculation. This will be illustrated in the following examples.
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Example 5-2: Damping_2.esa

In this example, non-proportional damping is accounted for in a seismic calculation using the SRSS
modal combination method. To this end, the example Spectral_Analysis_2.esa from the previous

chapter is extended with dampers.
More specifically, a relative damping of 12%, 3% and 8% is inputted on the three columns starting from

the base of the structure.

Step 1: Functionality

The first step to take into account the damping is to activate the functionality Non-Proportional
Damping on the Functionality tab in the Project Data.

Step 2: Damping group
The second step is the creation of a Damping Group.

r =)

# ° Damping group

i o8 & B Bl < = A== T .

CENN | Name DG1
Description
Type of default damping Global default =

Since a damper will be inputted on all elements, the choice of the default damping type is not relevant.

Step 3: Dampers

After the creation of a Damping Group, Dampers can be inputted. A relative damping of 12%, 3% and
8% is inputted on the three columns starting from the base of the structure:

8%

3%

12%
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Step 4: Mass matrix

As a final step, the Damping Group is assigned to the Mass Combination:

# ' Combinations of mass groups I

=)

A Za & B ) & Al

-

[Name

| en

Description

M1 [-]

Damping group

-I Contents of combination

1,00
DGL

| Mew || Insett || Edit | Delete

| Close |

The non-proportional damping has now been inputted so the Linear Calculation can be re-done to

see the Seismic results.

The following results are obtained through the Calculation protocol of the Linear Calculation:

Mode Freq. Damp Sax Say Saz G(j) Fx Fy Mx My
[Hz] ratio Damp | coe | [m/s?] [m/s?] [m/s3] [kN] [kN] [kNm] [kNm]
1 0.5253 0.0956 0.8176 0.1651 0.0000 0.0000 0.5003 0.1800 0.0000 0.0000 -1.7994
2 3.424% 0.0711 0.5085 0.3579 0.0000 0.0000 0.0155 0.1288 0.0000 0.0000 -0.3716
Level= 0.00 0.22 0.00 0.00 184

For both eigenmodes the Composite Modal Damping Ratio is calculated using equation (5.17).
As specified in the previous chapter, this Damping Ratio will be used to calculate the Damping

Coefficient, which influences the spectral accelerations. Using equation (4.13):

= L—08176
e\ (5+9.9)

= L—09087
L T2

As expected, since the modal damping ratios are higher than the default 5% used in the acceleration
spectrum, they will have a positive effect thus lowering the response of the structure.
More specifically, for the first eigenmode only 81,7% of the spectral acceleration will be taken into

account and for the second eigenmode 90,8%.

The spectral accelerations of the original example without damping can thus be multiplied by n:

=S, =0,2019 f%z .0,8176 = 0,1651%2

=S, =0,4380 r%z .0,9087 = 0.3980 n% i

These adapted spectral accelerations will thus influence the mode coefficients, the base shear, the
overturning moment, the nodal displacements and accelerations,...
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Example 5-3: Damping_3.esa

In this example, non-proportional damping is accounted for in a seismic calculation using the CQC
modal combination method. To this end, the example Spectral_Analysis_3.esa from the previous
chapter is extended with dampers.

More specifically, a relative damping of 2%, 5% and 2% is inputted on the three columns starting from
the base of the structure.

As seen in the theory and the original example, the CQC method required the definition of a Damping
Spectrum. This damping spectrum was used for the calculation of the Modal Cross Correlation
Coefficients and to calculate the Damping Coefficient for each mode.

When however Non-Proportional Damping is used, the calculated Composite Modal Damping Ratios
are used jnstead of the data of the Damping Spectrum. This is illustrated in this example.

Step 1: Functionality

The first step to take into account the damping is to activate the functionality Non-Proportional
Damping on the Functionality tab in the Project Data.

Step 2: Damping group

The second step is the creation of a Damping Group.

e ouneng oo S|

B eBE & EE A -

CE | Nome | b6t
Description
Type of default damping Global default ~

Since a damper will be inputted on all elements, the choice of the default damping type is not relevant.

Step 3: Dampers

After the creation of a Damping Group, Dampers can be inputted. A relative damping of 2%, 5% and
2% is inputted on the three columns starting from the base of the structure:

2%

5%

2%
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Step 4: Mass matrix

As a final step, the Damping Group is assigned to the Mass Combination:
# ' Combinations of massgmup- &J
KL 4 0 | & A E
Name EE
Description
= Contents of combination
MGL [-] 1,00
Damping group DG1 2
| MNew | Inset | Edit | Delete | Close |

The non-proportional damping has now been inputted so the Linear Calculation can be re-done to
see the Seismic results.
The following results are obtained through the Calculation protocol of the Linear Calculation:

Mode Freq. Damp Sax Say Saz Gfj) Fx Fy Mx My
[Hz] ratio Damp | coe | [m/s?] [m/s?] [m/s*] [kn] [kN] [kNm] [kNm]
1 0.5253 0.0265 1.1432 0.2308 0.0000 0.0000 0.6995 0.2517 0.0000 0.0000 -2.5160
2 3.4249 0.0330 1.0980 0.4809 0.0000 0.0000 0.0187 0.1556 0.0000 0.0000 -0.4451
Level= 0.00 0.30 0.00 0.00 2.56

In the original example, a Damping Spectrum with a constant damping ratio of 2% was used. Due to
the inputted dampers, the calculated Composite Modal Damping Ratios of 2,64% and 3,30% are now

used.
Using equation (4.13) the Damping Coefficients can be calculated:
n = 10 =1,1432
(5+2,65)
n, = 10 =1,0976
* \(5+330)

As was the case in the original example, the damping ratios are lower than the default 5% used in the
acceleration spectrum, they will have a negative effect thus augmenting the response of the structure.
Since the calculated damping ratios are higher than the original 2%, the response will be less when
compared to the original example.

Second, the calculated Composite Modal Damping Ratios will be used for the calculation of the Modal
Cross Correlation Coefficients of the CQC-method.

This will be illustrated in a manual calculation.
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Manual Calculation
In this paragraph, the application of the CQC-method using the calculated Composite Modal Damping
Ratios is illustrated for the global response of the Base Shear.

Mode 1: o) = 3,3007 rad/s F@) =0,2701 kN

Mode 2: @) = 21,5192 rad/s Fe) =0,1629 kN

Using a spreadsheet, the Modal Cross Correlation Coefficients pi; are calculated with a damping ratio
& of 2,64% for the first eigenmode and 3,30% for the second eigenmode.

Mode 1 2
1 1 0,00055202
2 0,00055202 1

N N
Rt = \/_1 ZR(i) “Pii R(J')

i j=1

0,2701kN -1-0,2701kN + 0,2701kN -0,00055202-0,1629kN
+0,1629kN -0,00055202-0,2701kN + 0,1629kN -1-0,1875kN
=0,315kN

The difference between these Correlation Coefficients and the original is very small which was to be
expected since the calculated damping ratios are close to the original 2%.
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Example 5-4: Damping_4.esa

In this example, a seismic analysis is carried out on a storage depot. The layout of the structure is
given in the pictures below. The depot is constructed with steel members manufactured of S235
according to EC-EN. On the upper roof, a steel shell is used with thickness 20 mm.

On each floor level, concrete slabs are used with thickness 200 mm. The slabs are manufactured in
C25/30 according to EC-EN.

Rooi 6301’"‘

1500

Raof Beam

4000
Calumn
Calumn

Floor Bearn

A0Q00
Column
Column

Flogr Bearn Flaor Beam

4000
Column
Column
Column

— 6000 —1— £000 ——
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The diagonals are hinged in both directions. The column bases are also hinged though the anchors
are spaced such that the rotation around the Z-axis is taken as fixed.
The steel members of the depot have following cross-sections:

- Columns: IPE 300

- Floor Beams: HEA 200

- Roof Beams: IPE 160

- Diagonals: L(ARC) 40x40x4

The vertical loads acting on the structure are:
- Load Case 1: The self-weight of the depot
- Load Case 2: A category E (Storage) imposed load of 5 kN/m2 on all floor slabs.

The structure will be subjected to an earthquake loading in both X, Y and Z direction, using a Design
Response Spectrum according to Eurocode 8 for Ground Type A with a behavior factor of 1,5. This
means that the spectrum for the internal forces will be divided by this value. The acceleration
coefficient is 0,50.

For the dynamic calculation, the structural damping of the depot is taken into account. More
specifically, a logarithmic decrement of 0,025 is used for steel and 0,056 for concrete [22].

Step 1: Functionality

The first step in the Seismic calculation is to activate the functionalities Dynamics and Seismic on the
Functionality tab in the Project Data. In order to take the structural damping into account, the
functionality Non-Proportional Damping is also activated.
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Scia

Enginess

~
Project data

J EEN—

Subsoil

Monlinearity

Stability

Climatic loads
Prestressing

Pipelines

Structural model

BIM properties
Parameters

Mebile loads
Automnated GA drawings
LTA - load cases

CADS composite checks
External application checks

Slabs with void formers

Basic data |Functiona|ity'|l Actions  Protection

= Dynamics

Seismic

Harmonic band analysis
General dynamics

Mon proportional damping
Steel

Fire resistance

Connection modeller
Frame rigid connections
Frame pinned connections
Grid pinned connections
Bolted diagonal connections
Expert system

Connection monodrawings
Scaffolding

LTE 2nd Order
ArcelorMittal

Step 2: Masses & Mass groups

The second step is to create Mass Groups and then the creation of Masses.
Since the self-weight is automatically taken into account in a Combination of Mass Groups, only one
Mass Group is created here, a group to take the mass of the imposed load into account.

Create masses from load caze

Using the action
loads.

automatically generates masses from the already inputted

A eBEl o= Sl FE A - Y

Description

Bound to load case Yes
LC2 - Imposed Load (Storage)

Keep masses up-to-date with loads 2

Load case

Actions

Create masses from load case

New Insert Edit Delete

Step 3: Damping groups

Before creating a
Combination of Mass Groups,
the damping is specified.

Mame | D61

Description

Type of default damping Material default

First of all, a Damping Group is
created.

MNew Inzert Edit Delete
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Since, in this example, the structural damping of the steel and concrete is taken into account, the Type
of default damping is set to Material default. This way, when no damper is inputted on an element, the
default damping value of the material will be used.

The damping values can be specified in the Material Library:

& TMaterials [——)
AlrenBk oo S e A - Y
l C25/30 Name C25/30 B
5235 E Code independent
Material type Concrete
[ Thermal expansion [m/mk] 0,00
Unit mass [kg/m*"3] 2500,0
E modulus [MPa] 31000,00
Poisson coeff. 0.2
Independent G madulus
G modulus [MPa] 12916,67
Leg. decrement (non-uniferm damping only) 0,056
Colour [
Specific heat [J/gK] 6,0000e-01
Thermal conductivity [W/mK] 4,5000e+01

Qrderin code 4

=] ial b i for

Material behaviour
= EN1992-1-1

Characteristic compressive cylinder strength fck{28) [MPa] 25,00
Calculated depended values

Mean compressive strength fcm(28) [MPa] 33,00
fem(28) - fck(28) [MPa] 8,00
Mean tensile strength fctm (28) [MPa] 2,60
fetk 0,05(28) [MPa] 180
fetk 0,95(28) [MPa] 3,30
Design compressive strength - persistent (fcd = fck / gamma c_p) [MPa] 16,67
Design compressive strength - accidental (fed = fck / gamma c_a) [MPa] 20,83
Strain at reaching maximurm strength eps c2 [1e-4] 20,0

Ultimate strain eps cu2 [1e-4] 350

Strain at reaching maximum strength eps ¢3 [1e-4] 175
Uktimate strain eps cu3 [1e-4] 350
Stone diameter (dg) [mm] 32
Cement class N (normal hardening - CEM 32,5 R, CEM 42,5 N)
Cement type - for BS and French NA only CEMI
= Measured values
Measured values of mean compressive strength (influence of ageing)
= Stress-strain diagram
Type of diagram Bi-linear stress-strain diagram

£ ctrain o

For the concrete, a logarithmic decrement of 0,056 is inputted, for the steel a value of 0,025.

Step 4: Mass matrix

The Mass Group and Damping Group can now be combined in a Combination of Mass Groups.

As specified in formula (2.9) all gravity loads appearing in the following combination of actions need to be
taken into account for an eigenmode calculation:

ZGK + Z‘/’E,i Qi

For this example, with a Category E imposed load, ¢ is taken as 1,0 and 2, as 0,8. This gives a value
of 0,8 for e,

Since the Self-Weight is automatically taken into account, the Combination of Mass Groups CM1 can
be formulated as 0,80 MG1

L B’

Aim BN & A T
[Name | cm

Description

E Contents of combina...
MGL [-] 0,80

|| Damping group DGl - |I

As a final step, the Damping Group is assigned to the Combination of Mass Groups.
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Step 5: Seismic spectrum

Before creating the Seismic load cases, the Seismic Spectrum needs to be defined through
Libraries>Loads > Seismic Spectrums.

# SCIA Engineer 16.1.30
‘Ml File Edit View
DEEE ¢

33 - [Damping_4_v15.0: 1]
Libraries | Tools Modify Tree Plugins Setup Window Help

Materials =Dy (i =21

| 1-4 o | 1

Cross-sections

Main

Setup
Catalogue blocks

Project

~:H Line grid and sto
..... B BIM toolbox
- Structure

el Load

=12 Load cases, Com
.]® Load Cases

B B g ' @

Mamed item

Structure, Analysis L
Steel »
Concrete, reinforcement L
Compuosite L

Subsoil, foundation

ﬁ l&?;:;?;::;: Loads M | | Predefined loads
..... H Concrete con ﬁ Fire heat dw.  Seismic spectrums l:
E Result claszes Drawing tools M| m#®  Dynamic load functions E
-4 D}rnamicg "f Attributes definition ﬂ Load pattern
P ] I R TS L

Instead of inputting a spectrum manually, the spectrum according to EC8 is chosen. In this example,
the spectrum for Ground Type A with a Behavior Factor g = 1,5 is used for all directions:

Seismic spectrum | B |
mrt
15
167
185
14 i Code parameters. A
12
0102 o
ag - design acceleration [m/s*2] 1,000
q - behaviour factor 1,500
beta 0,200
5, Th, Tc, Td manually? No
Subsoil type A
Spectrum type type 2
Direction Horizontal
Frequency[Hz] Direction factor 1
EC3-h
1 |000 5 - soil factor 1,000
2 1025 Th 0,050 IPeriod 'l
3 |050 Tc 0,250
4 1075 1,200 IEurocode vl
5 |100 BIA nnt o rtec
[30,00 Hz
6 |125
7 |50 0,25 Hz
8 175
9 200 Code parameters
10 |25
<l Cancel |

Step 6: Seismic load case

The Seismic load cases can now be defined through Load cases, Combinations > Load Cases.
For the Seismic load case in the X-direction, the following parameters are used:
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,
T T

Aca BB im0 == = =

LC1 - Self-Weight |Name | LC3
LC2 - Imposed Load (Storage) Description Seismic X
LC3 - Seismic X . .
L4 - Seismic ¥ Action type Variable ~
LC5 - Seismic Z LoadGroup LG3 e
LC6 - Seismic X def Load type Dynamic =
LCT - Seismic ¥ def Specificati Seiemici .
LCE - Seismic Z def pecification ty
=l Parameters
= Direction X
Direction X v
Response spectrum X ECE-h " e
Factor X 1
= Direction Y
Direction ¥
= Direction Z
Direction £
Acceleration factor 05
Overturning [m] 0,000
= Accidental eccentricity
Method Disabled -
= Modal superposition
Type of superposition cqQc =
Damping spectrum cQd L

= Multiple eigenshapes
Unify eigenshapes
Mass in analysis Participating mass only ~
= Signed results

Predominant mode

Master load case MNone -
Mass combi Chil -
Stage for composite analysis model Final stage, short term

The Coefficient of Acceleration is setto 0,5. As Type of evaluation the CQC-method is used.
In exactly the same way, the Seismic load cases in the Y and Z-direction are defined:

Note:

- For the load case Seismic Z a new spectrum has to be defined with type vertical.

- 3 other EN-Seismic load cases have to be defined, the first 3 are for internal forces and 3 new
(with g-behavior factor set to 1) for deformation. Each group of load cases has to get a load
group with type “seismic” & “together” and they must be placed in separate combinations.

According to Eurocode 8 [7] the action effects due to the combination of the horizontal components of
the seismic action may be computed using the following combinations:

Eeo " +"0,3Eq, "+"0,3E,
0,3E g "+ " Egy, "+ "0,3Eq,,
0,3E g "+"0,3E ey, "+ " Eqy,

Where:
"+" = Implies “to be combined with”.
Eci = Represents the action effects due to the application of the seismic action along the
chosen horizontal axis x of the structure.
EEdy = Represents the action effects due to the application of the same seismic action along
the orthogonal horizontal axis y of the structure.
E;, = Represents the action effects due to the application of the same seismic action along
the orthogonal vertical axis z of the structure.
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First of all, this implies that all Load cases must always be considered together in a combination. In
SCIA Engineer this can be done by putting both Seismic Load cases in a Load Group with relation

Together.
w7
I: L
kLI 4 ColN el JN g =
LG2 Marme [LG3
LG3 Felation Together |
‘ Load Seismic j
Note:

The EC1 - load type will not be used in this example. In the new EC-EN it is possible to specify the
load type as Seismic.

Next, the combination for the Seismic calculation can be inputted. According to Eurocode 8 [7] this
combination is the following:

ZGK +P+ AEd+Z‘/’2,i Qi (5.22)

Where Aed signifies the accidental action, in this case the combined seismic action.
In SCIA Engineer, the ‘EN-seismic’ type can be used for this purpose.
To fulfill the conditions of the Eurocode, 6 load combinations of this type are created:

# " Combinations /

LI 4 ¥} &5 | Input combinations -

CO1_ULS - forces MName C0O2_5LS

Description deformation
Type EM-Seismic
Structure Building

|Acti\re coefficients |
= Contents of combination

LClL - Self-Weight [-] 1,00
LC2 - Imposed Load (Storage) [-] 1,00
LC - Seismic X def [-] 1,00
LCT - Seismic Y def [-] 1,00
LCE - Seismic Z def [-] 1,00
Actions
Explode to envelopes EE
Explode to linear RS
Show Decomposed EN combinations 2ax
| Mew | Inset | Edt | Delets | | Closs |

Step 7: Mesh setup

To obtain precise results, the Finite Element Mesh is refined through Calculation, Mesh > Mesh
Setup. The Average number of tiles of 1D element is set to 10; the Average size of 2D element is
set to 0,25m.
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e I

MName

= General mesh settings

Minimal distance between two points [m]

Average number of tiles of 1d element

Definition of mesh element size for panels
Average size of panel element [m]
Elastic mesh
= 1D elements
Minimal length of beam element [m]

Maxirnal length of beam element [m]

Generation of nodes in connections of beam ele...

Generation of nodes under concentrated loads ...

Generation of eccentric elements on members wi

HAverage size of cables, tendons, elements on sub...

0,001
10

Average size of 2d element/curved element [m] 0,250

Automatic
1,000

—

0,100
100,000
1,000
7

&

=

Step 8: Solver setup

The last step before launching the calculation is setting the amount of eigenmodes to be calculated.

For this example, five eigenmodes are chosen.

In Calculation, Mesh > Solver Setup the number of frequencies is thus set to 5.

MNumber of thicknesses of rib plate

Parallelism tolerance for automatic calculation [d...

= Span length correction
Simply supported beam [-]
Inner span [-]
End span [-]
Cantilever [-]

Coefficient for reinforcement

Use IRS (Improved Reduced System) method

Produce wall eigenmode results (needed for ECto...

Span length ratic L/beff,max (1 side) for automati...

20
10,00
8,00

1,00
0,70
0,85

MNumber of eigenmodes 5

Step 9: Calculation & Results

All steps have been executed so the Linear Calculation can be started through Calculation, Mesh >

Calculation.

The Calculation Protocol for the Eigen Frequency calculation shows the following:
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Mode |Omega Period Freq. Wi f Wi / Wi f Wxi R/ |Wyi R/ |Wzi R/ |Damp ratio

[rad/s] [s] [Hz] Wixtot Wytot Wrtot Wixtot_R |Wytot_R |Spectral

1 4.6018 1.3654 0.7324 0.59688 0.0000 0.0000 0.0000 0.0103 0.0000 0.0050

2 11.4191 0.5502 1.8174 0.0000 0.6685 0.0000 0.0130 0.0000 0.2863 0.0042

3 13.6354 0.4608 2.1701 0.0270 0.0000 0.0002 0.0000 0.3696 0.0000 0.0050

4 13.8212 0.4346 2.1997 0.0000 0.2705 0.0000 0.0003 0.0000 0.5285 0.0072

5 14.9356 0.4207 2.3771 0.0000 0.0000 0.0000 0.0000 0.0000 0.0004 0.0060
0.9957 0.5391 0.0002 0.0133 0.3798 0.8151

It can be seen that for both horizontal directions more than 90% of the total mass is taken into account
in these five modes so it is concluded that sufficient Eigenmodes have been calculated.
Through Deformation of nodes under 2D Members, the Deformed Mesh can be used to visualize
the first four Eigenmodes:

1]
1%

Eigenmode 3: f = 2,17T—J|z

Eigenmode 4: f

-
7]
1

2

T

S

= 2,20 Hz

The Calculation Protocol for the Linear calculation shows the results of the seismic calculation:
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Dynamic loadcase: 3:1C3

Mode Freq. Damp Sax Say Saz G(j) Fx Fy Mx My
[Hz] ratio Damp | coe | [m/s?] [my/s?] [my/s?] [kN] [kN] [kNm] [kMm]
1 0.7324 0.0050 1.3486 0.1863 0.0000 0.0000 4.5314 49.4355 0.0000 -0.0000 |-311.0481
2 1.8174 0.0042 1.3580 0.5147 0.0000 0.0000 0.0000 0.0000 -0.0000 0.0000 -0.0000
3 2.1701 0.0050 1.3485 0.6101 0.0000 0.0000 -0.2820 4.5072 0.0000 -0.0000 43.7293
4 2.1997 0.0072 1.3221 0.6062 0.0000 0.0000 -0.0000 0.0000 -0.0000 0.0000 0.0000
5 2.3771 0.0060 1.3368 0.6623 0.0000 0.0000 0.0000 0.0000 0.0000 -0.0000 -0.0000
Level= 0.00 45.64 0.00 0.00 314.10
Dynamic loadcase: 4:1C4
Mode Freq. Damp Sax Say Saz G(j) Fx Fy Mx My
[Hz] ratio Damp | coe | [m/s*] [my/s?] [my/s?] [kn] [kN] [kNm] [kNm]
1 0.7324 0.0050 1.2436 0.0000 0.1863 0.0000 0.0000 0.0000 0.0000 -0.0000 -0.0000
2 18174 0.0042 1.3580 0.0000 0.5147 0.0000 -1.6892 -0.0000 94.2627 |-630.0326 0.0000
3 2.1701 0.0050 1.3485 0.0000 0.6101 0.0000 -0.0000 0.0000 0.0000 -0.0000 0.0000
4 2.1997 0.0072 1.3221 0.0000 0.6062 0.0000 0.8640 -0.0000 44,9331 |-256.2757 | -0.0000
5 2.3771 0.0060 1.3368 0.0000 0.6623 0.0000 0.0102 0.0000 0.0078 -0.0355 -0.0000
Level= 0.00 0.00 104.57 680.99 0.00

For each Eigenmode the Composite Damping Ratio has been calculated using the structural
damping of the steel and concrete.

The combinations can now be used to verify the structural elements.
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6.Reduced Analysis Model

6.1 Theory

The actual tendency in FE structural analysis is using full 3D modelization of the considered structure.
SCIA Engineer obeys that rule as structures are usually modeled in 3D using beam and shell elements,
including buildings.

Once a detailed 3D model is ready for statical analysis of a structure, it is natural to use it also for
dynamic analysis and, more specifically, for seismic design. A typical issue of full 3D model is, that
seismic design regards mostly the global behavior of the structure whence the full mesh of the
structure provides a lot of information about local behaviors. When performing the modal analysis, the
full mesh finds all local and global vibration modes, but the local modes are irrelevant for the overall
seismic response of the structure. It appears hence logical to use a different, reduced mesh for the
dynamic analysis, which ignores these local modes.

There are well known matrix condensation techniques (Guyan Reduction, also known as static
condensation) which allow the user to obtain a reduced system in a very efficient way, but those
methods are not well suited for dynamic analysis. An Improved Reduced System (IRS) method has
been developed which takes into account not only the stiffness matrix of the system, but also the mass
matrix during the condensation process. That method proved to give excellent results for dynamic
analysis, with both modal analysis and direct time integration methods.

The algorithm implemented in SCIA Engineer uses the IRS method and consists of 3 steps:

1. The IRS method is used for condensing the mesh of the analysis model.

2. The modal analysis is performed using the reduced mesh, which has typically 1’000 times less
degrees of freedom than the original full mesh. This makes the calculation of eigenvalues massively
faster on large structures and also avoids unwanted local modes. The latter is particularly interesting
for seismic analysis.

3. The results of the reduced system are expanded to the original full mesh, allowing for output of
detailed results in the entire structure.

Full 3D Storey-based input Condensed model & Expand back to full mesh for
dynamic analysis result input

S

42'840DoF & 24 DoF
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The IRS method allows:

Elimination of irrelevant, local bending vibration modes in the slabs: local modes in all
structural elements are implicitly removed, due to the elimination of unwanted degrees of freedom.
Of course, adding more reduction nodes would allow for more detailed analysis of local modes, but it
is particularly interesting for seismic analysis to keep in the reduced model only the nodes that are
strictly necessary to reproduce the typical seismic behavior of a building. Ultimately, it is up to the
user to choose the reduction points in such a way that the wanted eigenmodes are obtained.

Reduction of computation time: the computation time is reduced, due to the drastic reduction of
the number of degrees of freedom; actually, the reduction is even more important than with
diaphragms, as supporting members are also condensed.

Easy handling of mass eccentricities for each deck: the IRS analysis uses a full mass matrix,
which allows for exact implementation of mass eccentricity in each node of the reduced system.

Remark: The elimination of unwanted frame effects from the structural behavior (considering deck
slabs as diaphragms) is not addressed by the IRS analysis in itself, as it does not modify the
mechanical behavior of the structure. However, as unwanted local bending modes are implicitly
removed from the reduced system, so-called flexible diaphragms may be easily simulated by
significantly reducing the bending stiffness of deck slabs. Not only does that allow obtaining classical
diaphragm behavior by means of a very low bending stiffness, but also intermediate behavior where
the bending stiffness is less drastically reduced and frame effects are therefore reduced, but not
completely removed.

The condensed model is obtained from Reduction nodes. R-nodes are placed in each storey, at the specified
level, in the middle of the structure (all R-nodes are located on the same vertical axis).

During the analysis, the reduced model is automatically generated from the full mesh of the structure. Each
node of the full mesh is mapped to the closest R-node. In a typical building configuration, this means that
each R-node will receive the stiffness, loads and masses from the corresponding deck slab, from the top half
of the supporting members below the slab and from the bottom half of the supporting members above the

slab.
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Unlike the classical modal analysis, which typically uses a lumped mass matrix (only diagonal terms
are non-zero), the reduced system uses a full mass matrix , with non-zero values out of the diagonal.
This means that mass eccentricities can be taken into account easily by the reduced system. The very
small size of the reduced system allows using the full mass matrix.

Therefore the reduction points — or so-called R-nodes — that will constitute the reduced model do not
need to be located in a particular position, such as the mass center of each storey. As the structure
may have to be calculated several times with various distributions of the masses, the mass center of
each storey is likely to be slightly different depending on the selected mass combination. Thanks to the
use of a full mass matrix, the same R-nodes may be used in all cases.

During the analysis, the reduced model is computed automatically from the full mesh. Each node of the
full mesh is mapped to the closest R-node of the reduced model.

6.2 IRS Method in SCIA Engineer

To make an IRS calculation, you first have to perform all the steps as described in detail for seismic
calculation in previous chapters. As a reminder, those steps are:

Activate the functionalities - Dynamics
- Seismic

Create a Mass Group

Input Masses Generate Masses from Static Load cases

~, =

Create a Mass Combination

\ 4
Define a Seismic Spectrum

A 4
Create a Seismic Load case

Refine the Finite-Element Mesh if required

'

Specify the number of Eigenmodes to be calculated
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Before doing the linear analysis, the additional steps you have to execute in order to make an IRS
calculation are:

1. You have to enable the reduced model analysis in the project. This can be done via Setup menu >
Solver:

Setup Window Help

Options
Geometry/Graphics
Detete T, =
Colours/Lines Name
Fonts # Solver
Beam types (structural) | | Coefficient for reinforcement !
Dimension lines =/ Dynamics
- Number of frequencies A4
@ sooe Use reduced model - ‘
Cross-sections
1B Mesh
* E I
. Concrete solver
w Gallery

2. Define the building storeys. The Reduction nodes will be calculated from the storey data. In SCIA
Engineer, each storey is reduced into one R node.

R-nodes

To introduce the building storeys, go to Main menu > Line grid and storeys > Storeys:
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o o=

The storey manager where you can input the levels opens:

g
FL3
I
T
L2
him————
B a
¥ Ed
Hp—
MName Z-Bottom [m] | h_fl [m] | Rep | Z-Top [m] | Description
1 |FL1 0,000 4,000 1 4,000
2 |FL2 4,000 3,000 1 7,000
3 |FL3 7.000 4,000 1 11,000
4 |FLe 11.000 [ o ] 1 11,000
Insert I Delete | Inserting point x| 0,000 m ¥ 0,000 m oK | Cancel |

With the default settings, the deck slab of each storey is located at the bottom of the storey, and so is

the corresponding R-node. It is recommended to keep it that way. This can be seen from the storey
Properties:

Storey () -V Y
&

Descrption

Allocation type All inside

Include members on top I no
Include members on bottom M yes
Curmrent used activity F yes

Lewvel of reduction point 0.000
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3. Once the linear calculation has been executed, results are available. There are fundamentally two
types of results available after an IRS analysis:

e The results of the reduced model are automatically expanded to the original mesh and are
accessible through standard output. This will not be detailed here as it is the same as what
has been explained in the previous chapters.

e Some dedicated results, coming directly from the reduced model, are available in the new
result service Results menu > Storeys > Summary Storey Results. This typically gives
information about the masses, displacements and accelerations at each storey in the reduced
model.

e Other results can be displayed via Results menu > Storeys > Detailed Storey Results: this
menu can be used to display results from the full mesh analysis. It may be used for results
from any linear analysis, with or without dynamic analysis, with or without IRS analysis. It
provides results in all supporting members, with easy selection of members per storey. Walls
and columns may be represented on the same drawing. Typical provided results are: internal
forces, resultants per wall or per storey...

7 Displacement of nodes
ﬁ.' Deformed Structure
#- & Supports
[#] == Beams
- ¥ Dynamics
F-<= 20 Members
El== Storeys

!- ! Detailed results

E 201D uparade
[ Bill of material
EQ Calculation protocol
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Example 6-1: IRS_1l.esa

Open the project IRS.esa
We are going to apply the principles seen above to this small building.

Step 1: Set up the seismic model

e Activate Dynamic and Seismic functionalities from the Project data menu.

Basic data | Functionality | Loads Protection

Séig” ‘"' Dhynamics = | |E Dynamics
Engineer Initial stress ] Seismic
Subsoil O Hamaonic band analysis ]

e Create mass groups. For this example we are going to consider 3 mass groups related to 3 static
predefined load cases : self weight, Dead Load (DL) and Live Load (LL).

e Create a combination of mass groups

# Combinations of mass group X
A3 BB =& A
CML [Name: [cm

Description
= Contents of combina...
MG1H 1,00
MG2 H 1,00
MG3H 0.30

MNewr Insert Edit

o Define a seismic spectrum. Let’s consider a seismic spectrum with the following parameters:

(e e PR Y = )
T
L]
s
ot
o coeff accel. ag
o ag - design acceleration [m/s... 0,600
o4 q - behaviour factor 1,500
o beta 0.200
o EAL S, Tb, Te, Td manualy? No
o Subsoil type A
h Spectrum type ype 2
Direction Horizontal
Frequency[Hz] Direction factor 1
1 (0.00 5 - soil factor 1,000
2 o ™ 0.050
R Tc 0.250
"4 075 Td 1.200
5 |10
6 |15
7 |150
8 |17
9 |200 T )
T 225 X Code parameters |
11 |2.50
g EI E 114 | Cancel |

i
|
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e Create the seismic load cases in X and Y direction in the Load cases menu:

Ai s BEIR o= &G EEH A
MName SX

Description
Action type Variable
LoadGroup LG2
Load type Dyniamic
Specification Seismicity
= Parameters
= Direction X
Direction X
Response spectrum X F51
Factor X 1
= Direction Y
Direction Y o
Actions
Delete all loads
Copy all loads to ancther loadcase

[ iset | Edit | Delete |

A e BEI & SH A
SW Mame 5Y

DL Description
LL Action type Variable
. 2
Load type Dynamic
Specification Seismicity
El Parameters
= Direction X
Direction X ]
= Direction Y
Direction Y
Response spectrum Y F51
Factor Y 1
Actions
Delete all loads
Copy all loads to another loadcase

New | Insert | Edit | Delete .

e Refine the mesh. For this example, we set the mesh as follow:

Mame =
E General mesh =ettings
Mirimal distance between two points [m] 0.001
Average number of tiles of 1d element 1
Average size of 2d element/curved element [m] 0.500
Definttion of mesh element size for panels Manual ~
Average size of panel element [m] 1,000

e Chose the number of frequencies which have to be calculated (Setup > Solver). We chose 10
values.
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Step 2: Activate the option “Use IRS (Improved Reduced Model)”

.
B Solver setup | P9

MName
= General

Meglect shear force deformation ( Ay, Az »= A) F

Bending theory of plate/shell analysis Mindlin -
Type of solver Direct -
Murmnber of sections on average member 10

Warning when maximal translatien is bigger than... 1,0e+03
Warning when maximal rotation is bigger than [...  1,0e+02
Print time in Calculation Protocol v

= Effective width of plate ribs
Mumber of thicknesses of rib plate 20
Parallelism tolerance for autematic calculation [d... 10,00
Span length ratio L/beff,max (1 side) for automati... §00

= Span length correction

Simply supported beam [-] 1,00
Inner span [-] 0,70
End span [-] 0,85
Cantilever [-] 2,00
Coefficient for reinforcement 1
= Dynamics

Type of eigen value solver Lanczos -

Produce wall eigenmode results (needed for ECto...

= = E oK

Step 3: Define storeys

Define the Storeys form the Main menu > Line grid and storeys

Line grid and storeys B x a

H 2D Line grid

ZBottomn] | h_flm] ZTop[m] | Description
4500 4500
4,500
4500

[0 ]

Insert Delete Inserting point xl 0,000

The levels are shown graphically. If you select a storey level, you can adapt its properties from the
Properties window:
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+13,50@.,\\

/\

BVAY.

FL3

+9,ooo,\\

FL2

)
AN/
WAWA

NERVARY

Mﬁw’:k“\.

LT R L >< el /
N N . . . N . . . , o h'

AN

[

Properties 4
Storey (1) AT
Name FL2

Description

Z-Bottom [m] 4,500

h_fl [m] 4,500

Fittered allocation of Entities

Allocation type Allinside -
Inzlude members an top [ ne

Include members on bottom yes

Cument used activity yes

Level of reduction poirt 0.000

You can check if the supporting members of the building are properly allocated to storeys using the ‘Filtered
Allocation of Entities’ property.

Optionally, R-nodes may be placed at any level in each storey. The storey property “level of reduction point”
allows selecting the exact height of the reduction point for each storey separately. 0 corresponds to the
bottom of the storey, 1 to the top of the storey.
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Step 4: Perform the linear calculation and check the results

Summary Storey Results:

There are 3 types of results: Storey data, displacements and accelerations.

e Storey Data:

Storey data displays for each storey the total mass and the coordinates of the mass center. It is only
available with mass combinations

+4508.___ |

j Properties
-;___ Summary storey result (1) - \rﬁ \]
+13,50Q\‘( > Name Summary st.oreyt' result
Type of loads Mass combinations
— L] Mass combinations CM1/1-266
FL3 \“""N-. - / Selection Al storeys
/ 2% "'""-...._\‘ Draw values
/ [~ Draw units
+9000__ | < ) Resut type Storey Data
=
“N\‘. /
FL2 > =S
/ B

Raf oot

G

VAR

Preview
B =0 150 % - | e | T defaurt -

Summary storey result

Storey Data:

Eigen s olution, Exreme: Mo, Systermn: Principal

Seledtion: Al

Mass combinations (CM11 -2 66

Modal shapes are dimensionless, units are printed forconsistency purposes.

Mame M pie YG 26
i [ml [ml [ml
FL1 1649 4157 |7704  [1.250
FL2 1480 |5663 (6350 4500
FL3 1480 |5662 (6350 9000
FL4 1078 |5769 6240 [13.343

e Displacements & accelerations:

Displacements & Accelerations are available for eigenmodes and seismic load cases. The values of
displacement & acceleration components are given at the mass center of each storey.

Results for mass combinations are raw, normalized results from modal analysis, without effect of response
spectrum.
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Results for seismic load cases are values after modal superposition.

+13, 50“-_\_‘

y

FL3

+9,008__|

\ A

V

R

Preview

BEBS =0 150 %

d Properties 3 =
Summary storey result (1) BAY: Y
&
Name Summary storey result
Type of loads Load cases -
8% S
Selection All storeys -
Extreme No -
Draw values
Draw urits
J Resutt type Displacements -
Values L -

Additional values
Limit values

N «

- | Ipf Igf | T defaurt -

Summary storey result

Storey Displace ments:
Linear caloulation, Extreme: Mo, System: Principal

Seledion: All

Loadcases: SX
Mame LUk Ly Uz Phix Phiy Phiz
[mml [l [miml [mradl [mrad] [mradl
FL1 1,1e01 24e02 58e05 1,3e-03 24ed3 24e03
FL2 A.7ed 1.7e1 Bied2 88e03 |48e03 889e03
FL3 1.7e+10 52e 7 0e02 1,3e-02 G,3e03 25e02
FL4 3.0e+00 9.2e-01 90e02 15e-02  |70e03 [4ZFe02

Using the option ‘Additional values’ in the properties windows you can display more components:

+13150Q__“_“
FL3
+9,DO&_‘\‘

FL2

+4508___ |

L

j Properties B x
Summary storey resuft (1) v \rﬁ
&
Name Summary storey resuft
Type of loads Load cases -
Load cases 5X -
Selection Al storeys -
Extreme No -
Draw values
Draw units
J Result type Accelerations -
Values Ao =
B
Ay
fa
Alpha X ]
Apha Y 0o
Apha Z [}
Limit values
=
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Detailed Storey Results:

Typical provided results are: internal forces, resultants per wall or per storey...

Mainly 4 types of results are available in this service:

e Internal forces in supporting members
The result can be displayed on different section levels:

- Top (section at the top of each storey)

- Middle (section at mid-height of the each storey)
- Bottom (section at the bottom of each storey)

- User defined

'
%,

-14,07 kN

|
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Properties

W
&

Detailed storey resutt (1) BRY:]
MName Detailed storey resutt
Type of loads Load cases
|Load cases | SK
Selection Single storey
Storey FL1
Section level Top
Fitter No
System Principal
Extreme Global
Draw values
Draw units
Result type Intemal farces
Values on beams N

Additional values
Limit values
Values on slabs e
Additional values
Limit values
Diagram Precise
Draw diagram Section plane
Display total value O
Display average value O




Detailed storey result
Lin ear calculation, Extreme: Global, System: Principal
Seledion: FL1
Loadcases: S
Columns:
Mame Storey ¥ ¥ z M Wy vz ¥ Iy [l rd
(] [m] [m] 20020 0 5 A AR a1
B40 FLA 6000 [12000 |0000 |&632 |047 [111 004 297 | 062
Ba7 FL1 12000 |opoo  |00D0 |710  |028 |060 004 204 | 089
B22 FL1 G000 |6000  |0000 [4407 {028 (112 003 200 |077
Walls:
Mame | Storey o ] z e my oy e my G w ]
[m] [m] [m] [kMm] [ENm] [EMim] [ENmm] [ENm!m] [kNm!m] [EMim] [EMim]
B15 1 3,500 Q.000 Q9,300 -412 .52 -B56,81 -130,99 Q.03 0,04 -0.,02 g,21 9,26
S5 1 9.000 0.000 Q.a00 414 .42 E53.18 -131, 351 -0.03 -0.93 -0.01 0.13 -0.13
10 FL1 1.500 (12,000 |0.000 |-151.68 |-291.51 [74.1%§ -0.02 0.01 0,05 -0.36 0.45
&7 1 Q9,000 12,000 Q.a00 135,23 287,289 -20.21 2.32 5.34 -217 14 .68 -23.77
10 FLi 0.000 |1z.000 |o.000 [13s.86 |284.00 |-73.39 -3.00 -9,58 1,85 14,59 |[-57.50
g7 FL1 Q9,000 11,000 Q9.000 29,74 145,30 10,44 -0,05 -0,15 -0.44 -3.89 Q.31
S10 R Q9,500 12,000 Q9,300 3I8.7TE 58,18 18,97 -0.03 0,38 Q.a7 1,23 18,73
e Resulting forces (by member)
L i b b h i f Properties oo
ocation = by member: compute the resulting forces are Detaied storey esul (1) SETXY,
computed for each wall member separately —
MName Detailed storey result
Type of loads Load cases -
Resulting forces in 1D members (columns) are identical to Load cases K -
internal forces in 1D members. Selection single storey v
Storey FL1 -
Resulting forces in 2D members (walls) compute the resultant Section level Bottom .
at the center of each wall, according to a dedicated local Fiter :? L ’
coordinate system, regardless of the System output setting. System GTn:Ta =
The coordinate system that is used is the same as the LCS of E‘"er“el ° .
a vertical rib placed in the middle of the wall. It is also the D'_“'“ "a:es
same coordinate system that is used for integration strips. re s ,
Result type Resutting Forces -
|Location | By member -
Values N o
t Additional values
+ Limit values

e The local X-axis is vertical, upwards

e The local Z-axis is identical to the Z-LCS of the wall

e Y=2Z"X

In this way, resulting forces in walls can be easily displayed

together, consistently with internal forces in columns on a single

drawing.
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e Resulting forces (by Storey) Properties 7 x
Detailed storey result (1) - \Jﬁ V
&
Location = by storey: the resulting forces are computed for each Nome Detaled storey resut
storey, considering all the supporting members at once; 1D Type of loads Load cases .
(columns) and 2D members (walls) are taken into account Load cases 5X -
toget her Selection Single storey -
Storey FL1 -
Section level Bottam -
Filter Mo -
System GCS -
Extreme Global -
Draw values
Draw units
Result type Resulting Forces A
|LDcation | By storey -
Values Fx -
Additional values
Limit values
e Total vertical forces in all storeys
| =] Properties qox
Detailed storey resutt (1) - ‘\Jﬁ \f
/| 2 ~
g ﬁ Name Detailed storey result
E - Type of loads Load cazes -
o0 Load cases SwW -
/ Selection Al storeys -
o ——————— Section level Middle -
ﬁ Fitter Mo -
b System GCS -
E. i J |E:dreme | Mo -
4 Diraw values
P Draw units
ﬂ Result type Resulting Forces "
291‘ Location By storey -
ﬂ B Values Fz -
; / Additional values
fé e T = |/ Limit values
g
Detailed storey resuilt
Linear calculation, Extreme: Mo, System: GCS
Seledion: Al
Loadcases:SW
Resulting Forces
Mame X ¥ i Fx Fy Fz [l Iy Mz
[ml [ml [l 1l LK [k [Hdml [EMm] [kl
FLA1 4507 |7548 22580 044 |-104 |-283815 328145 -3163,36 573
FLZ 4507 |[7548 6.750 026 087 [-190418 | 218760 -2109.18 .08
FL3 4507 |7549 11,280 108 -1.01 -870,03 109335 -1054.50 0482
FL4 0000 10000 0,000 000 0,00 0,00 0,00 0,00 0,00
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6.3 Accidental eccentricity (Accidental Torsion)

The accidental eccentricity accounts for inaccuracies in the distribution of masses in the structure. Design
codes usually take it into account as an additional eccentricity that is defined as a fraction of the size of the
structure.

In the Eurocode 8, the accidental eccentricity for a given floor is defined as 5% of the width of the floor
perpendicularly to the direction of the acting seismic action.

In SCIA Engineer, using the IRS condensed model allows introducing accidental eccentricity easily, since the
condensed model uses only one R-node per storey. The accidental eccentricity may be taken into account
either as real mass eccentricity or as additional torsion actions (simplified method according to the design
codes).

However, SCIA Engineer uses the simplified method using additional torsion moment.

Accidental eccentricity is added through static loading (acc. EN 1998-1 4.3.3.3.3)

o =
- i E
~ J . “EE

Example 6-2: IRS_2 Accidental torsion.esa

In SCIA Engineer, the accidental torsion can be accounted for in a seismic project using the IRS method.
Open the Load cases menu and select one type of Accidental eccentricity:

# | Load cases
A Bk oS aHEl A N
SW Name SX -
| DL Description I
LL Action type Variable
:ﬁ LoadGroup LG2 -
SX_AE - Accidental eccentricity for 5X Load type Dynamic ”
Specification Seismicity =
= Parameters
E Direction X
Direction X
Response spectum ¥ F51 > .
Factor X 1
= Direction Y
Direction Y O e
E Direction Z
Direction Z O
Acceleration factor 1
a Bl Al
E Accidental ecce...
Linear distribution of accelerations -
Eccentricity Disabled
= Modal superposit ... Di-" T N Ta——
stribution of accelerations from eigenshape
Type of superposition  |Accelerations from modal superposition
Unify eigenshapes o
= Mode filtering
Mode fittering Disabled >
Mass in analysis Participating mass onhy -
El Sirwad e d 2
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The following methods are available for calculation of
e Linear distribution of accelerations (EN

e Accelerations from modal superposition

AE moments:
1998-1 4.3.3.3.3 and formula (4.11) )

Distribution of accel. from eigenshape (EN 1998-1 4.3.3.3.3 and formula (4.10) )

Once the accidental eccentricity is selected, a new AE load case and also a hew load group are

automatically created:

BEcil > EIEE A

- Y

Master load case

SW MName SX_AE
DL Description Accidental eccentricity for SX

Action type ariable
LoadGroup SX_AE

SX_AE - Accidental eccentricity for 5X Load type Static

SY_AE - Accidental eccentricity for SY Specification Seismic accidental eccentricity
Duration Short

SX

L1 MName | 5X_AE

LG2 Relation Exclusive

SX_AE Load Seismic Accidental Eccentricity
SY_AE
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7. Vortex Shedding: Karman Vibration

In this chapter, the transverse vibration of cylindrical structures due to wind is examined.
First the theory is explained in which reference is made to the Harmonic load since Vortex shedding is

a special case of harmonic loading.
The theory is then illustrated by an example of a steel chimney for which the results are again verified

by a manual calculation.

7.1 Theory

One of the most important mechanisms for wind-induced oscillations is the formation of vortices
(concentrations of rotating fluid particles) in the wake flow behind certain types of structures such as
chimneys, towers, suspended pipelines,...

At a certain (critical) wind velocity, the flow lines do not follow the contours of the body, but break away
at some points, thus the vortices are formed [27].

These vortices are shed alternately from opposite sides of the structure and give rise to a fluctuating
load perpendicular to the wind direction. The following figure illustrates the vortex shedding for flow
past a circular cylinder. The created pattern is often referred to as the Karman vortex trail [2]:

When a vortex is formed on one side of the structure, the wind velocity increases on the other side.
This results in a pressure difference on the opposite sides and the structure is subjected to a lateral
force away from the side where the vortex is formed. As the vortices are shed at the critical wind
velocity alternately first from one side then the other, a harmonically varying lateral load with the same
frequency as the frequency of the vortex shedding is formed [23].

The frequency of the vortex shedding fv is given by:

T 6.1)
d
With:
S = Non-dimensional constant referred to as the Strouhal Number
For a cylinder this is taken as 0,2.
d = Width of the body loaded by the wind [m]
For a cylinder this equals the outer-diameter.
v = The mean velocity of the wind flow [m/s]

The manner in which vortices are formed is a function of the Reynolds number Re, which is given by
[24]:
Re = 0,687 -v-d-10° (6.2)

In general large Reynolds numbers mean turbulent flow. The Reynolds number characterizes three
major regions:

Subcritical 300 < Re <10°
Superecritical 10° < Re < 3,5-10°
Transcritical 35-10° < Re

For chimneys with circular cross section the flow is either in the supercritical or transcritical range for
wind velocities of practical interest.
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If the vortex shedding frequency coincides with the natural frequency of the structure (resonance) quite
large across-wind amplitudes of vibration will result unless sufficient damping is present. This principle

was already discussed in Chapter 3.
In this case, formula (6.1) can be rewritten to calculate the critical wind velocity at which resonance

occurs:
Voie =9-0 - f (6.3)
With: f = Natural frequency of the structure

The across-wind forces per unit length caused by the vortex shedding can be approximated by the
following formula: [2]

1
P (t) = Ep'd 'Vrfrit -C, (t) (6.4)

With: p = Air density taken as 1,25 kg/m3
C, (t = A lift coefficient that fluctuates in a harmonic or random manner
and depends of the Reynolds number. The following figure shows
this relation when Ct is proportional to the mode shape [24].
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If the vortex shedding is taken as harmonic, equation (6.4) can be written as:
. 1 .
P (t)=P,sin(a,t) = Ep-d V2, -C,sin(24f,) (6.5)
According to reference [2], assuming a constant wind profile, the equivalent modal force due to the
fluctuating lift force of equation (6.5) is given by:
. 1 . H
P(t)=Psin(eyt) = 2 p-d VG sin(2, )- [ C.(2{(2)3dz (6.6)

With:
#(2) = Modal shape at height z
H = Total height of the structure

As seen in Chapter 3, the dynamic amplitude Y at resonance can be written as:

Ys

Y=— 6.7
28 (6.7)
The static deformation Ys is given by:
P P
Y. =0 — 0 6.8
° K Mo’ ©9

M is the equivalent modal mass of a prismatic member given by [2]:
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M = [m(2)p(2)¥ dz (69)

With:
m(z) = The mass per unit height

When combining formulas (6.7) and (6.8) the maximum response of a SDOF system subjected to a
harmonic excitation may be written as:

_ R 1
Me® 2&
It follows that when the vortex shedding occurs with the same frequency as the natural frequency of the
structure, the maximal amplitude is given by:

P8V [} C @ |
2

(6.10)

Y = (6.11)

o [m(z{p(2)¥ dz

When it is assumed that the mass per unit height is constant and that the lift coefficient is proportional
to the mode shape, formula (6.11) can be simplified to the following:

— p'd3 'Ct
16-72-S%-m-&
This equation may be used as a first estimate of likely response of the structure.

(6.12)
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7.2 Karman Vibration in SCIA Engineer

In SCIA Engineer, the Vortex Shedding was implemented according the Czech loading standard [24].
The effect is only taken into account if the critical wind velocity calculated by formula (6.3) is between a
minimal and maximal value. These two extremes can be defined by the user. According to [24] these
values are taken as 5 m/s and 20 m/s.

In addition to formula (6.11), in SCIA Engineer it is possible to specify the length of the structure where
the Von Karman effect can occur. For each geometric node of the structure, it is possible to relate a
length of the cylinder to the node. This implies that, in order to obtain precise results, the structure
should be modeled with sufficient geometric nodes.

By default the effect can occur over the entire height of the structure however, when there are specific
obstacles on the surface of a chimney for example, these obstacles will hamper the formation of the
vortices and thus reduce the Von Karman effect. In practice, this is exactly the solution to suppress
vortex-induced vibration: the fitting of special ribs on the surface of the cylinder.

The following diagram shows the required steps to perform a Vortex Shedding calculation:

Activate the Dynamics functionality

|

Create a Mass Group

/\

Input Masses Generate Masses from Static Load cases

. -

Create a Mass Combination

'

Create a Karman Vibration Load case

A 4
Input Karman Loads (lengths)

A 4
Refine the Finite-Element Mesh if required

h 4
Specify the number of Eigenmodes to be calculated

'

Perform a Linear Calculation

This diagram will be illustrated in the following example.
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Example 7-1: Vortex_Shedding.esa

In this example, a steel chimney is modeled with a fixed base.

The chimney has an outer-diameter of 1,2m and a thickness of 6mm. The total height is 30m and the
structure is manufactured in S235 according to EC-EN.

To take into account the weight of insulation, electrical cables and other non-structural elements, a
distributed mass of 55 kg/m is inputted.

No specific structural measures are taken to prevent the vortex shedding thus the entire length of the
chimney must be taken into account for the Von Karman vibration.

To this end, the chimney is modeled as a cantilever built up as 30 members to create sufficient
geometric nodes. Each node (except the base and top) will be assigned a chimney length of 1m.

For the logarithmic decrement of the chimney, a value of 0,025 is used.

2
One static load case is created: the self-weight of the structure. %\{

[
30000

Step 1: Functionality

The first step in the Karman Vibration calculation is to activate the |
functionality Dynamics on the Functionality tab in the Project Data. %E

Step 2: Mass groups

The second step is to create a Mass Group.

s RER-—= A=y = N -
M1 - Additional Weight Mame MGL
Bound to load case Yes -
I Load case LC1 - Self-weight | e
I Keep masses up-to-date with loads v
Actions
Create masses from load case e
| MNew | msert Edit | Delete | | Close |

Actually, this mass group doesn’t contain anything, since the self-weight is automatically taken into
account. But to do dynamic calculation, at least one Mass Group needs to be defined.

In this mass group, we are going to place some additional masses. This will be added to the mass
coming from the self weight (which is always and automatically taken into account).
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Step 3: Masses

After the Mass Group has been created; the distributed mass of 55 kg/m can be inputted on all

members.
o
i
554
55
S
b
55750
%0
%0
%0
55,0
555.
5
EE
35,
554
55
55‘0
=5,
55550
55-7'5;3
%0
%0
%
354
5555,
5‘5?
i
EL
=
S
iy
o
%o
o
e
. B
-

Step 4: Mass matrix [+ combimatons o massyours I Sl
Next, the Mass Group is put within a ELE 4 D& A i
Combination of Mass Groups, which can [Name | e
be used for defining the harmonic load. Description

= Contents of combination
MG1 - Additional Weight [-] 1,00
L =
| Mew || Insert " Edit | Dielete | Close |

Step 5: Karman vibration load case
After creating a Mass Combination, a Karman vibration load case can be defined through Load cases,
Combinations > Load Cases.

The Action Type of the Load Case is set to Variable.

The Load Type can then be changed to Dynamic.
Within the Specification field, the type of dynamic load can be set, in this case Karman vibration.

- Thelogarithmic decrement was given to be 0,025.
- The Diameter of the tube was 1,2m.

- The Wind direction is defined in the Global Coordinate System. A direction of 0,00 deg
specifies the global X-axis. This implies that the Karman vibration will occur in a direction along
the Y-axis (perpendicular to the wind direction).

- As specified in paragraph 6.2 the minimal and maximal wind velocities are set to 5 m/s and 20
m/s respectively. Vortex shedding will only occur if the critical wind velocity is between these two
limits.
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- The option ‘Select eigenshape’ can be used to manually specify for which eigenmode the
Vortex shedding needs to be calculated. When this option is left to ‘Automatic’, SCIA Engineer
determines the representative mode automatically (which is the one with the biggest modal

participation factor in the relevant direction)

Since the wind direction is set along the global X-axis, the representative mode will be a mode

shape along the global Y-axis.

(o .

| Az g BEBiI= | SIEc-~

LC1 - Self-weight MName

LC2 - Von Karman Description

Action type

LoadGroup
Load type

= Parameters
Legarithmic decrement
Diameter of the tube [m]
Wind direction [deg]
Minimal wind velocity [m,/s]
Maxirnal wind velocity [m/s]
Select eigenshape

Master load case

Mass combi

Lc2

Von Karman
Variable
LG2

Dynamic

Specification Karman vibration

0,025
1,200

0,00

5,000
20,000
Automatic
MNone
Chil

Actions

Delete all loads

Copy all loads to ancther loadcase

]

-0

I rew | et | Ese | Dote |

Step 6: Karman load

The parameters of the load case have been defined, what is left is to specify
the length of the structure where the Von Karman effect can occur.

As indicated in paragraph 6.2; SCIA Engineer allows relating a length of the

chimney to each geometric node.

This load can be inputted through Load > Point Force > Karman Load
As no specific measures were taken to prevent vortex shedding and since the
chimney was inputted as 30 members, each node is assigned a length of 1m.

Additional nodes are made at 0,25m from the base and top. These nodes also

get Karman loads assigned to them of 0,50m.

Close

Warman 1oad in node KLS0 - 0,500 [m]
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Step 7: Mesh setup

To obtain precise results for the dynamic calculation, the Finite Element Mesh is refined. The Average
number of tiles of 1D element is set to 5 through Calculation, Mesh > Mesh Setup.

-
i ™y
I

Mame

= General mesh settings

Minimal distance between two points [m 0,001

HAwerage number of tiles of 1d element 5

Average size of 2d element/curved element [m] 1,000

Definition of mesh element size for panels Automatic
Average size of panel element [m] 1,000
Elastic mesh [
= 1D elements
Minimal length of beam element [m] 0,100
Maximal length of beam element [m] 100,000
Average size of cables, tendons, elements on subseil, nonlinear soil spring [m] 1,000
Generation of nodes in connections of beam elements )
Generation of nodes under concentrated loads on beam elements
Generation of eccentric elements on members with variable height
Divisicn on haunches and arbitrary members
Divisien fer 2D-1D upgrade
Mesh refinement following the beam type

Hanging nodes for prestressing

= = E

Step 8: Solver setup

Step 8: The last step before launching the calculation is setting the amount of eigenmodes to be
calculated. The default value in Calculation, Mesh > Solver Setup is 4. This is sufficient for this
example.

,

Name
= General
Meglect shear force deformation ( Ay, Az »=» A) F
Type of solver Direct -
Mumber of sections on average member 10
Warning when maximal translation is bigger than [rmm] 1000,0
Warning when maximal rotation is bigger than [mrad] 100,0
Print time in Calculation Protocol b
Coefficient for reinforcement 1
= Dynamics
Type of eigen value solver Lanczos -
umber of eigenmodes
Use IRS (Improved Reduced System) method [
Produce wall eigenmode results (needed for ECtools) 4
ERCIC) =
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Step 9: Linear calculation and results

All steps have been executed so the Linear Calculation can be started through Calculation, Mesh >
Calculation.

The Calculation Protocol for the Eigen Frequency calculation shows the following:

Modal participation factors

Mode |Omega Period Freq. Wi [ Wryi [ Wri f Wxi R/ |(Wyi RS |[Wzi R/S
[radfs] [5] [Hz] Witot Wytot Waztot Wxtot R |Wytot_R | Spectral

1 7.4354 0.8450 11834 0.6159 0.0000 0000 0.0000 0.3751 0.0000
2 7.4354 0.8450 11834 00000 0.6159 00000 0.3751 0.0000 0.0000

3 46.0814 0.1363 7.3341 0.1908 0.0000 0000 0.0000 0.1995 0.0000
4 460814 0.1363 7.3341 0000 0.1908 0000 0.1995 0.0 0.0000
0.8067 0.8067Y 0.0000 0.5746 0.5746 0.0000

The details of the Karman Vibration calculation can be found in the Calculation Protocol for the
Linear calculation:

MWaximum  horizontal
Critical velocity
Reynolds number
Ct ratio
rlaximum

057
load on cylinder
Reduced load on cylinder

710

translation

HE5346 64

21.50
896,82

Karmans wvibration is analyzed for eigen shape 2

0.02397

As expected, the Vortex shedding was analyzed for the second eigenmode, the mode with largest

mass participation in the Y-direction.

The Maximum and Reduced loads are intermediate results used to calculate the across-wind forces
according to [24].

The maximum horizontal translation for the second eigenmode can be found through Deformation of
Nodes (note that the value has no relevance, the direction however is very important):

Displacement of nodes

Eigensclution Extreme : Global
Selection: All
Masscombinations: CM1/2 - 1,18
Modal shapesre dimensionlessynits are printedfor consistencypurposes.

MNode Case U Uy Uz Fin Fiy Fiz
[mm] | [mm] |[mm] | [mrad] | [mrad] | [mrad]
N1 CM1/2- 1,18 (1K) 0.0 0.0 0.0 0.0 0.0
N31 CM1/2- 1,18 00l 240 0,0 -1,1 0,0 0,0

In the same way, the total deflection of the top of the chimney caused by the Karman Vibration can be

shown:

Displacement of nodes

Linearcalculation,Extreme - Global
Selection: All
Load cases: LC2

Mode | Case Ux Uy Uz
[mm] | [mm] | [mm]
N1 Lc2 0.0 0.0 0,0
M31 LC2 00| -210.8 0,0
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Because of this large translation at the top, at the base of the chimney considerable stresses will occur.
As specified in Chapter 3, a combination of type Envelope provides the possibility for considering both
sides of the vibration amplitude since a vibration is always in both directions.

An envelope combination is created for the chimney to evaluate the stresses at the base:

o

# | Combinaticns "
kL O o &
[Nome

Input combinations -

oL

Description
Type
= Contents of combination
LC1 - Self-weight [-]
LC2 - Von Karman [-]

Envelope - ultimate

1,00
1,00

Actions

Explode to linear £

| Mew | Inset | FEdt | Delete | | Close |

=
b T

The Member Stresses for the lower member of the chimney give the following normal stresses for the
combination:

Stress

Linear calculation, Extreme : Global

Selection : All

Combinations : CO1

Values : Normal -, Normal +, Shear, von Mises, Fatigue, Kappa, Sigma Y

Member dx Case | Normal - | Normal + | Shear | von Mises | Fatigue | Kappa | Sigma Y
[m] [MPa] [MPa] [MPa] [MPa] [MPa] [-] [MPa]
Bl 0,000 |CO1/1 -105,8 0,0 105,8 0,0
Bl 0,000 |CO1/2 101,2 0,0 101,2 0,0
B1 0,000 |CO1/2 -2,3 -2,3 2,8 54 0,0
B1 0,000 | CO1 -105,8 101,2 207,0| -0,9
B30 1,000 | CO1 0,0 0,0 00| -1,00
B30 0,875 |CO1 0,0 0,0 0,0 0,47

A stress range of 207 MPa will lead to significant fatigue problems after even a low amount of cycles.
This is one of the most reported types of failures due to Vortex shedding.
A solution to this problem is the fitting of a helix type rib to prevent the correlation of the vortices (and
thus lower the chimney-length which should be considered for the Von Karman effect). The
disadvantage of such arib is that it increases the drag force [2].
Since the Vortex shedding is a state of resonance, the amplitude is damping dependent as explained
in Chapter 3. Another solution is thus to increase the damping by installing a tuned mass damper

system [23].
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Manual Calculation

In order to check the results obtained with SCIA Engineer, a manual calculation is performed.

First of all, the fundamental natural frequency of the chimney is approximated by the following formula
given in Eurocode 1 [4]:

. gléd W (6.13)
heff Wt
With:

€1 = 1000 for steel chimneys

d = Diameter of the chimney at the top [m]

hett = Total height of the chimney for a prismatic cantilever structure [m]
Ws = Weight of the structural elements which add to the stiffness of the
chimney, in this case only the self-weight of the chimney.

W = Total weight of the chimney, thus including the additional weight.

The self-weight of the chimney is given in the Bill of Material:

Ccss ‘ Material | Unit mass Length Mass
[kg/m] [m] [kg]
Chimney - Tube (12006} |S 235 | 176,6 | 30,000 | 52992

1000-12 | 1766
= f= 5 =116 Hz
30 176,6+55

This result is a good approximation of the result of 1,18 Hz calculated by SCIA Engineer.

Next the result of the Von Karman vibration is verified.
The critical wind velocity at which resonance occurs is calculated using formula (6.3):

Vy =5-d- f =5.1,2-11834 = 7,10 m/s

The critical wind velocity is between the upper and lower limit of 5 m/s and 20 m/s thus vortex
shedding is likely to occur.
Using formula (6.2) the Reynolds number Re is calculated:

Re = 0,687 -v-d-10° = 0,687 -7,10-1,2-10° =585356,98

Using the Reynolds number, the lift coefficient C; can be calculated:

o |
10 +
|
|
|
[0.568] :
i
|
i
02 fo — — — — ;
I 1
00 —fp—Hi— 1 '
105 108 0

| 585356,9 |

These intermediate results correspond to the results calculated by SCIA Engineer.
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As an approximation of the response at the top of the chimney, equation (6.12) can be used:
— p-d ’ 'Ct
16-72-S%-m-&

With:  p =1,25 kg/m3
S=0,2
m = 176,6 kg/m + 55 kg/m
& = 0,003979 for a logarithmic decrement of 0,025

V- 1,25-1,2°-0,5686
16-7%-0,2°-(176,6 +55)-0,003979

=0,21099mM =210,99mm

This result corresponds to the result calculated by SCIA Engineer.

Eurocode 1 [4] gives an approximate formula to calculate the amount of cycles a chimney is subjected
to due to vortex shedding. This can be used in a fatigue analysis.

Adaptations to the formulas for formations of cylindrical elements like chimneys and cables are found in
the same reference.
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8. Direct Time Integration

8.1 Theory

The title may be misleading because normally in the literature, this name is used for a dynamic
computation without modal superposition. In SCIA Engineer, the eigenmodes are determined first and
are used to uncouple the equilibrium equations into a set of m uncoupled second order differential
equations which are solved one by one by direct time integration. The uncoupling is based on the
properties given by equations

O M-, = 0,When i# ]

®F-M - D,

1, Wheni=|j

O K@, = of

1 1
In equation (3.1) a solution for y is assumed to be of the form:

y=¢Q (7.1)
Where ¢ is the matrix of eigenvectors (n*n) and Q is a vector which is time dependent.

Substitution in equation (3.1) gives:
MepeQ+CopeQ+KepeQ=F (7.2)
When the equation is pre-multiplied with ¢™ and the above equations are taken into account, one obtains:

Q+¢ eCogeQ+02eQ=¢"oF (7.3)

This set of equations is still coupled because of the damping term. If however C-orthogonality is assumed
(this means that ¢'.C.¢ reduces to only diagonal terms), then the equations are uncoupled and can be
solved separately. The global results are obtained by superposition of the individual results (7.1) is also the
exact solution if the assumption of C-orthogonality holds. If however, only a few eigenvectors (m<n) are
used in ¢ instead of all the eigenvectors, then the system of equations and the superposition of the solutions
gives a solution y which is an approximation of the exact solution.

In SCIA Engineer, C-orthogonality is assumed and it is also assumed that all modal damping factors are
constant. This means that:

¢ eCep=20m 005, (7.4)

The value of & is one of the input data and is called damping factor.

The number of eigenvectors that is taken into account is also specified by the user. This value is equal to
the number of eigenvectors computed in the eigenvalue computation.

The method used to solve each uncoupled second order differential equation is the Newmark-method. This
method is unconditionally stable but the accuracy depends on the time step. This time step has to be given
by the user. However, to help him in his choice, a value determined by the program will be used if the user
does not specify a value. This proposed value is computed as: 0.01 T

Where T smallest period of all the modes which have to be taken into account

This proposed value guarantees accuracy better than 1% over each period of integration of this highest
mode. In most cases, a larger time step can be used because the contribution of this last mode is small.

This brings us to the question about the number of modes that should be used. When the time dependent
terms on the left hand side of equation (7.3) are neglected, the solution for g; (a term of Q) is:

qullcojz0¢jT0F (7.9)
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This indicates that the lowest eigenmodes (wj small) will contribute more than the highest modes (wj large),
if dynamic terms are neglected. This can give a first idea on how many modes to use.

A second criterion is the periodicity of F. Any mode which coincides with the loading frequency should be
taken into account.

Modal weight is a third criterion that can be used. If you add all modal weights in a particular direction
together and divides this result by 9.81*sum of nodal masses in the same direction, you obtain a value
smaller than 1. If this value is close to 1, it means that the higher modes will not contribute anymore. If, on
the contrary, the value is smaller than 0.9, one can doubt about the value of a subsequent modal
superposition.

8.2 Direct Time Integration in SCIA Engineer

In SCIA Engineer, it's possible to input a dynamic function. This can be used for different purposes, for
example: harmonic loads, explosions, ... In this case, the user has to input a dynamic function which
presents the frequency in function of the time.

The following diagram shows the different steps which have to be performed for the time history
calculation:

Activate the functionalities -Dynamics
-General dynamics

Create a Mass Group

T

Input Masses Generate Masses from Static Load cases

>, —

Create a Mass Combination

'

Define a Dynamic load function

i

Create a ‘general dynamics’ load case

i

Refine the Finite-Element Mesh if required

'

Specify the number of Eigenmodes to be calculated

'

Perform a Linear Calculation
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Example 8-1: Time_history _1l.esa

In this example an explosion is simulated on a concrete plate.

The plate has a dimension of 6x6m and the thickness is 300 mm. The plate will be calculated
according to the EC-EN and is made of concrete grade C30/37. The four corners are supported by
hinged supports.
Three load cases are introduced:

- Self weight

- Permanent surface load: -4kN/m”2

- Variable point load: Blast of -11 kN

Step 1: Functionality

Go to ‘Project>functionality’ and check the options:
Dynamics and General dynamics

Step 2: Mass groups and masses

Open the menu ‘Dynamics’ and a mass group will be created here. For this, the permanent surface
load of -4kN/m”2 is used. For this, you can click on the ‘create masses from load case’ button.

B | Mass groups | Fl
AineBE oo S SEH A -
MIiG1 Marne MiE1

Description
Bound to load case Yes -
Load case B&2 - Permanent L
Keep masses up-to-date with ... ¥/
Actions
I Create masses from load case 22>
[ew [ oot | & ] e ]

b, A

A surface mass of 407.7 kg/m”2 is created.
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Step 3: Mass matrix

Next, a combination of mass groups can be created.

p

B ' Combinations of mass groups

Ais s BB | &lA

ame o
Description
= Contents of combination
MG1 [-] 1,00

| Mew " Insert ” Edit ” Delete |

Close

Step 4: Dynamic load function

After the creation of masses, the explosion can be simulated by means of a dynamic load function.

Go to ‘Libraries > loads > Dynamic load functions’.

Here you can input the input of load coefficients in function in time.
Two types of functions can be input, namely a base and/or modal function. If both are introduced, the
user can choose if these functions have to be multiplied or summarized.
4 types of functions can be chosen: constant, linear, parabolic or sinusoidal.

In our example a modal function is created with linear lines:

Dynamic Load Function @
Mame Composition type
DLF1 ™ Multiply * sum
COMPOSE]
L POO Function 1
: type | dehatls] | 1 f2 f shift F[Hz]
. 1 [iin - 0,050 0,000 0,000 0,000 0,000 0,000
- Iq 2 |lin - 0,078 1,000 0,000 0,000 0,000 0,000
: Ié 3 |lin - 0,024 0,000 -0,620 0,000 0,000 0,000
e -0.6200 4 |lin - 0,048 -0,620 0,000 0,000 0,000 0,000
_ _ = i - 0,000 0,000 0,000 0,000 0,000 0,000
FUNCTION 1 " ‘ ‘ ‘ ‘ ‘ ‘
g 1.00
= :q ’H\H\H\H\m\rﬂ\ﬂ\ﬁ\ Fundionz
S é type delta t [s] fl f2 3 shift F [Hz]
20 -0.6200 const - 0,000 0,000 0,000 0,000 0,000 0,000
FUNCTION 2 t[s]
0
o Wy [=] Wy [=)
o o — — (o]
"~ "~ - 4 L 3
(=] (=] (=] (=] (=]
oK | Cancel

This function has to be attributed to a point load. We will do this in step 6.
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Step 5: A ‘general dynamics’

load case

A load case is introduced to simulate this explosion.

The action type is Variable and the type of load Dynamic.

-

1 | Load cases @
A eBEir 2 S e A .
BG1 - Dead Load [Name BG3
BG2 - Permanent Description Explosion
BG3 - Explosion X .
Action type Variable =
LoadGroup LG3 -
Load type Dynamic -
Specification General dynamics =
= Parameters
Total time [s] 1,51
Auto integration step v
Output step [s] 0,30
Logarithmic decrement 016
Master load case MNone -
Mass combi CM1 -
Actions
Delete all loads S
Copy all loads to another loadcase 2>
| New || Insert || Edit || Delete | | Close |
For the load group, the user can choose a special case, namely Accidental.
i ' Load groups ﬁ
= a Y i
KL 4 -] & =H
Name LG3
Relation Exclusive
Load Accidental

| New " Insert ” Edit " Delete

Next, the specification has to be selected and the type General dynamics has to be chosen for a time

history calculation

For this, we need some extra parameters:

Where:
- Total time:
- Integration ste

- Output step:

The total time of the dynamic analysis
p: When ‘Auto’ is checked, then 1/100 of the smallest period is taken.
When ‘Auto’ isn’t checked, then the user is allowed to select an integration step

value.

Step for generating the load cases. The value need to be bigger or

integration step.
- Log Decrement: Damping defined as logarithmic decrement

equal at the
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Step 6: Input of loads which follow the load function

In this step, you will create of a nodal force. Only nodal forces can be linked to a dynamic function.
The value of the nodal force, will be multiplied with the coefficients in the function to achieve the final

force in function of time.

r ~
1 ' Point force in node Ié]
Mame Puntlast
Rz F Direction z =
Rx Ry Type Force -
(;>\ > Angle [deg]
Y Value - F[kM] -11,00
Function DLFL T

KBL

Mode
Fx @ Load case BG3 - Explosion " e
@ = Geometry
F GCS -

System
. ?Fzy '
<N 6

A point force of -11kN is input in the middle of the plate. The user has the option to attribute the
dynamic function DLF1 to this load.

i oK |'| Cancel I_

A

Step 7: Mesh setup

Before the calculation, the mesh is refined to get precise results.

.
B Mesh setup ﬁ

Mame

= General mesh settings

Minimal distance between two points [m] 0,001
Average number of tiles of 1d element 1
Average size of 2d element/curved element [m] 0,200 -

Mmfimibinm nf mmmrb Almms ek e £ e R e

Step 8: Linear calculation
Now, the linear calculation can be performed.
When the calculation is finished, new load cases are created which present the influence of the blast

on the structure on each output step (the output time must always be smaller than ‘Total time’, so in
this example, we used 1,51s as total time to get an output at 1,50s):

164



-

B Load cases

A BB & ESH A MY
BG1 - Dead Load [Mame BG3
BG2 - Permanent Description Explosion
I BG3 - Explosion . .
BG3.1 - 0,30/1,51 Action type Variable -
BG3.2-0,60/1,51 LoadGroup LG3 -
BG3.3-0590/151 Lead type Dynamic -
BG3.4-1,20/1,51 o .
BG3.5-1,50/151 Specification General dynamics -
E Parameters
Total time [s] 151
Auto integration step v
Output step [s] 0,30
Legarithmic decrement 016
Master load case Maone -
Mass combi CML -
Actions
Delete all loads EESS
Copy all loads to another loadcase ez
| New " Insert ” Edit " Delete | Close

To find the most extreme result, these load cases can be input in a Result class.

Step 9: Results

The eigen frequencies are shown in the results menu:

Eigen frequencies

N |f omega | omega® |T
Hzl |[1/s1  |[L/5%] [s]

Mass combination : CM1

1 [r95 |aos7 249708 |03

2 |1798 [11285 |1275708 |008

3 1788 [112.85 (1275710 |0,06

Other results, like for example deformations, can be regarded for the different output steps:

- After 0.3 seconds:

- After 0.6 seconds:

Uz [mm] -
0.26
0.24
0.22
0.20
0.18
0.16
0.14
0.12
0.10
0.08
0.06
0.04
0.02
0.00

Uz [mm]
0.00
-0.01
-0z
-0.03
-0.04
-0.05
-0.05
-0.07
-0.08
-0.0%
-010
-0

165



Advanced Professional Training - Dynamics

- After 0.9 seconds:

- After 1.2 seconds:

- After 1.5 seconds:

166

Uz [mm]
0.00
-0.00
-0.00
-0.00
-0.00
-0.00
-0.00
-0.00
-0.00
-0.00
-0.00
-0.01
-0.01
-0.1
-0.1

Uz [mm]
0.00
-0.00
0.0
-0.01
-0.02
-0.02
-0.02
-0.03
-0.03
-0.04
-0.04
-0.04
-0.05
-0.05
-0.06




Or we can ask the result for the class which has been generated for the load cases.

’
B | Result classes

A s £ B

|

RC1
BG3 - Explosion

J (S5
< & A ¥
[Name | BG3
Description Explosion
B List
BG31
BG3.2
BG3.3
BG34
BG3.5

| MNew || Inzert " Edit || Dielete |

Close

Lo

d Propertias a3 =
Displacement of nodes (1) tl Wh v; 7
& =
MName Displacemnent of nodes
Selection Current ~
Type of loads Class ~
Class BG3 - Explosion P
Values Uz -

Extreme

If you choose refresh, then you can see Uz for each 0,3 seconds in the selected node.

Displacement of nodes

Linearcalculation Extreme : Node
Class: BG3

Uz [mm]
s )
0,200
0150
0,100
0,050

@, 0o

Mimmum

BG32

BG33

BG3s,

[

BG3S

Mode -
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If we would set the output step to 0,01s in the dynamics load case, then you would get 150 load cases.

And as a result, the “deformation in nodes” graph would give more detailed representation:

s e BEiI= 0 &Sl EHE A

BG1 - Dead Load
BG2 - Permanent

-0,01/1,51
-0,02/1,51
-0,03/1,51
-0,04/1,51
-0,05/1,51
- 0,06/1,51
-0,07/1,51
-0,08/1,51
- 0,09/1,51
-0,10/1,51
-0,11/1,51
-0,12/1,5
-0,13/1,51
-0,14/1,51
-0,15/1,5
-0,16/1,51
-0,17/151
-0,18/1,51
-0,19/1,51
-0,20/1,51
-0,21/1,5

DR277 NIA B

o |Name

Description
Action type
LoadGroup
Load type
Specification
=/ Parameters
Total time [z]
Auto integration step
Output step [s]
Logarithmic decrement
Master load case

Mass combi

Explosion
Variable
LG3
Dynamic

General dynamics

151
W~
0,01
016
Mone
ChM1

Actions

Delete all loads

Copy all loads to another loadcase

Displacement of nodes

Linear calculation, Extreme : Node

Delete

Class : BG3
Uz [mm]
0,400
0,300 0,331
0,255
0,200 0228
0,199
0,15f
0,100 0139F § 1ok o
0% 00
0.0 | ok

0,000,

o, aft

! : A o0sd
0,100 o oedt 00fd .
0,11 :
) o1 013
0200 0178
4 0210
Lt 0,245

-0.300 A 0,270 . T

= = I Z % = = =

Z O o o o o T P

m 4] o] o]

m m m m o & &
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Example 8-2: Time_history_2_ - RunningLoad.esa

In this example a running load over a bar is simulated.

™~

/PR TR VR TR VS TV RN PR PR PR

The beam has a length of 20m and a section HEA200. The beam will be calculated according to the
EC-EN and is made of steel S235. The edges are supported by hinged supports.
Two load cases are introduced:

- Self weight

- Variable dynamic load: Point loads of -100 kN on every 2m over the beam

Step 1: Functionality

Go to ‘Project>functionality’ and check the options: Dynamics and General dynamics

Step 2: Mass groups

Open the menu ‘Dynamics’ and a mass group will be created here. For this, no mass is inputted. Only
the self weight is taken into account.

Step 3: Mass matrix

Next, a combination of mass groups can be created.

# ° Combinations of mass groups @
LI 4 & A -
= EX
Description
= Contents of combination
MG [-] 1,00

L L

| MNew | Imset | Edit | Delets | Close |
i

Step 4: Dynamic load functions

After the creation of masses, the running load can be simulated by means of dynamic load functions.

Go to ‘Libraries > loads > Dynamic load functions’.
Here, the input of frequencies in function in time is asked.

Two types of functions can be input, namely a base and/or modal function. If both are introduced, the
user can choose if these functions have to be multiplied or summarized.
4 types of functions can be chosen: constant, linear, parabolic or sinusoidal.
In this example 9 modal functions are created with linear lines:
- DLF1is 1,00 from 0,2s to 0,4s

- DLF2is 1,00 from 0,4s to 0,6s
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# ° Dynamic Load Functions @
8 & Sl=HE A -
DLF1
DLF2 COMPQOSED
10 Lo
DLF4 o
DLFS 0'4
DLF6 0.2
DLF? 0.0
DLF8
DLF2 V[ I
0 FUNCTION 1 1.00
0.8
0.6
04
0.2
0.0
| |
MName DLF3
Compositi... sum ~
| foxcTIoN 2 t[s]
e B B s B
[ New | Inset | Edt |-Delete | Close |

L .

Each function will be attributed to a different point load (see step 6).
DLF1 to the first point load from the left. DLF2 to the second point load from the left. And so on...

These 9 load functions will be used to simulate the effect of a point load moving from left to right over a

time period is simulated. On each point (every 2m) the point load stays for a time of 0.20sec. So it
takes 2 seconds for the point load to cross the whole beam.

Step 5: General dynamics load case

A load case is introduced to simulate this running load.
The action type is Variable and the type of load Dynamic

For the load group, the user can choose a special case, namely Accidental.

| Load groups =5
kLI 4 =& -
E | Nome LG2
[l Relation Exclusive
ll Load Accidental -
|

Next, the specification has to be selected and the type General dynamics has to be chosen for a time
history calculation. After chosing general dynamics, some extra parameters have to be defined.

- Total time [s]: The total time of the dynamic analysis.

- Integration step: When ‘Auto’ is checked, then 1/100 of the smallest period is taken.
When ‘Auto’ isn’t checked, then the user is allowed to select an integration step value.

- Output step [s]: The step is used to determine on which points in time results must be
generated. These will be saved in new generated load cases.

- Log Decrement: Damping defined as logarithmic decrement
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Step 6:

)

Specification
= Parameters
Total time [s] 2,50

Auto integration step [

HLBEI S SEH A

LCI - self weight Mame LC3

LC3 - dynamic Description dynamic
Action type Variable -
LoadGroup LG2 -
Load type Dynaric ¢

General dynamics ~

Qutput step [s] [0.025

Logarithmic decrement 0,05
Master load case Maone

Mass combi CM1

Actions

Delete all loads

Copy all loads to another loadcase

Input of loads

In this step, nodal forces will be inputted. Dynamic load functions can only be linked to nodal forces.
Since they are ‘nodal’ forces, the user must proved internal nodes to place these internal forces on.
Every 2m an internal node has to be created on the beam. On each of these nodes a point force of -
100 kN is set. The first point force from the left is linked to DLF1, the second to DLF2,...

This models the movement a single point load over the beam left to right over the beam in a total time
of 2 sec.

Properties 1 x
Point force in node (1) u A=Y
\" *
| FL
Direction z -
Force -
Angle [deg]
Value - F [kM] -100,00
Function DLF1 I
N2
Load case LC3 - dynamic S o
= Geometry
Systemn GCS -
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Step 7: Linear calculation

Now, the calculation can be performed.

When the calculation is finished, new load cases are created which present each output step:

e
Aiaegki=a - & - A
LCI - self weight | |Name |Lc3a
e d”amic Description 0,03/2,50
3.1 - 0,03/2,50 :
LC3.2 - 005‘;2“50 Action type Variable
LC3.3 - 0,08/2,50 LeadGroup LG2
LC3.4 -0.10/2,50 Lead type Dynarnic
LC3.5-0,13/250 e -
LC3.6 - 0,1572,50 Specification General dynamics
LC3.7 -0,18/2,50 = Parameters
LC3.8-0,20/2,50 Total time [s] 2,50
Il:glfﬂ_ —UEJBL‘;?ZS,EU Auto integration step W
LC3.11 - u:zafz,su Output step [s] 0,03
LC3.12-0,30/250 Logarithmic decrement 0,05
tgﬁ g:ggﬁ:gg Master load case MNone
LC3.15 - 0,38/2,50 Mass combi Chil
LC3.16 - 0,40/2,50
LC317 - 0,43/250
LC3.18 - 0,45/2,50
LC3.19 - 0,48/2,50 =
LC3.20 - 0,50/2,50 Actions
LC3.21 - 0,53/2,50 Delete all loads
}EEEEEE’EE = | Copy all loads to another loadcase EEE

| New | inset | Edt | Delete |

To find the most extreme result, these load cases are automatically input in a result class:
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| & Al

pm= .

A e BB

|Nam-e

Description

= List

LC31
LC3.2
LC3.3
LC3.4
LC3.5
LC36
LC3.7
LC3.8
LC38
LC3.10
LC311
LC312
LC313
LC3.14
LC3.15
LC3.16
LC3.17

»

m

| New | iset | Edt | Delete |




Step 9: Results

The eigen frequencies are shown in the results menu:

TRRRERREInnrnnnl
Eigen frequencies

N |f omega | omega® T
[Hz] |[1/s] |[[1/s%] [s]
Mass combination : CM1
5,03 |31,61 998,90 0,20
19,74 124,02 |15382,05 0,05
42,99 |270,09 [72946,75 0,02
64,59 (405,79 |[164668,52 |0,02

B W] =

Other results, like for example deformations, can be regarded for the different output steps:

- After 0.5 seconds:

™~
NE Ny N2 M3 N NS ME N7 NS g 5. NET
—EJ_EJmm
- After 1 seconds:
M~
Mi Ny NZ M3 e Rl G n7 NE Mg a) NPT
&F&MMlUluﬂluuﬂluﬂluHluﬂlﬂﬂlﬂﬂluﬂlﬁUluUlUMlﬂLuﬂLuu$H,_
- After 1.5 seconds:
M~
ME Ny NZ M3 e 5 MNE NT NE MG MO NPT
—5@Umm

- After 2 seconds:

™~
ME Ny N2 M At =] MNE N7 ME R IO MIT
-14 5 mm
- After 2.4 seconds:
M~
ME sy ME M3 e M5 e N7 B NG MNID MNIT
—|5U4mrn

- The result class shows the envelope of all possible results over time:
™~

Mx NN & SNNMRRY | MUNMLIL.Y v iz i 1 A - R ) 17/ NPT

—104 Frnm
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It is also possible to see the result in a certain point for all load cases in one picture. By this it is
possible to see the result over the time.

Consider for instance the vertical displacement of the middle node N6.

Properties rx
Displacement of nodes (1) [-] %8 2 &
x
MName Displacement of nodes
Selection Current -
Type of loads Class -
Class LC3 T
Values Uz -
Extreme Mode -

The deformation of the middle node in function of the time is shown in the result preview.

(FRNRRRARE
Displacement of nodes

Linear calculation, Extreme : Node
Class :LC3

Uz [mmm)]
200

0.0
= It 12 ; 2 2 - .
-20.0 ' 12, -13 1357 146 35§ 147

Minimum
60,0 Maximum
80,0 72

-100,0 96

-120,0

o
g

LC311
L.C3.21
L0331
LC34
1.C3.51
LC3a61
LC3T
LC3 &l
L.C391

This result clearly represents the vibration of the middle point over time.
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_Annex A: Earthquake Magnitude

To assess the magnitude of earthquakes, a scale to describe the energy released during an
earthquake was developed by Richter in the 1930s. This is named the Richter scale and it is the most
common scale used today to describe earthquakes [26].

The magnitude of an earthquake on the Richter scale is determined by a so-called Wood-Anderson
seismograph maximum amplitude, where M = log(a), and a is the maximum amplitude [um] at a 100
km distance from the epicenter.

The seismic action on buildings cannot be described by the Richter scale magnitude and this may not
be used in the design. However, Housner in 1970 developed empirical relationships between the
maghnitude, the duration and the peak ground acceleration to be used in design:

Magnitude on the Peak ground Duration (s)
Richter scale acceleration (% g)
5.0 9 2
3.3 ] )
6.0 22 12
6.5 29 18
7.0 37 24
7.3 435 30
8.0 30 34
8.5 S0 37
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In this annex, some numerical values for structural damping are given.
A. EC 8 - Part 6 (ENV 1998-6:2003 Annex B) suggest the following values for the damping ratio:

Structural material Damping ratio &
Steel elements 1% - 4%
Concrete elements 2% - 7%
Ceramic cladding 1.5% - 5%
Brickwork lining 3% - 10%

B. Other values for damping are suggested by EC1 - Part 2-4 (ENV 1991-2-4:1995 Annex C):
The fundamental logarithmic decrement d is given by:
d = d

Where:
dS . Fundamental structural damping,

+ d, + d,

S

da . Fundamental aero dynamical damping

dd . Fundamental damping due to special devices

The structural damping is given by:

d, = axn + b
d Z 5min
N, : Fundamental flexural frequency,

a ,b , 0., : Parameters given in the following table for different structural types.

Structural type a, b1 S
Reinforced concrete buildings 0.045 0.030 0.080
Steel buildings 0.045 0 0.050
Mixed structures: concrete + steel 0.080 0 0.080
Reinforced concrete towers 0.050 0 0.025
Lattice steel towers 0 0.030 0
Reinforced concrete chimneys 0.075 0 0.030
Prestressed steel cable 0 0.010 0
Unlined welded steel stacks 0 0.015 0
Steel stack with one liner or thermal insulation 0 0.025 0
Steel stack with two or more liners 0 0.030 0
Steel with brick liner 0 0.070 0
Coupled stacks without liner 0 0.015 0
Guyed steel stack without liner 0 0.040 0
Steel bridges Welded 0 0.020 0
High resistance bolts 0 0.030 0
Ordinary bolts 0 0.050 0
Concrete Prestressed without 0 0.040 0
bridges cracks
With cracks 0 0.100 0
Bridge cables Parallel cables 0 0.006 0
Spiral cables 0 0.020 0

E.g.: for a steel building with first frequency of 3Hz, the logarithmic decrement is:
0.045x3 +0 =0.135 (>0.05)
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C. Other values for the logarithmic decrement are suggested by [22]:

Structural material Logarithmic decrement
Steel (welded) 0,025
Reinforced or Prestressed Concrete 0,056
Brickwork 0,25
Wood 0,13

In this reference, preliminary formulas can also be found for aerodynamic damping and damping
caused by the foundation.
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Annex C: Manual calculations spectral analysis

Example 4-2x: Spectral_Analysis_manual_calculation.esa

In this paragraph, the seismic results of SCIA Engineer are calculated manually to give a clear
understanding of the applied formulas. All formulas can be found in the paragraph “Calculation
Protocol” of this chapter.

The reference project is not completely the same as the one described in example 4-2. The differences
will be shown first before starting the manual calculation.
Seismic load case

The properties which have been used in the seismic load case can be seen here:
A different acceleration factor has been used. This reduces the accelerations given by the spectrum.

e A ==

e gBEE=v =S EE A

LC1 - Self-Weight Mame Lc2

LE2 - Seismic Description Seismic
Action type Variable -
LeadGroup LG2 L
Load type Dynarnic -
Specification Seismicity -

E Parameters

= Direction X

Direction X v
[T EC & - Sd(T)/alfa - Subsoil class B - q = 2 .
Factor X 1
= Direction Y
Direction ¥
= Direction Z
Direction £
Acceleration facter 0,35
Overturning [m)] 0,000
= Accidental eccentricity
Method Disabled -
= Modal superposition
Type of superposition SR5S -
= Multiple eigenshapes
Unify eigenshapes
Mass in analysis Participating mass only -

= Signed results

Predominant mode

Master load case Mone -
Mass combi Chl -
Actions
Delete all loads FEg I
Copy all loads to another loadcase ES

| New || Insert || Edit || Delete |

Spectrum

A manual seismic spectrum is used.
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AiaeBEl o &l weE A g
EC8 - 5d(T)/zlfa - Subsoil classB-gq=2
m's*2
14_
1
MName EC8 - 5d(T)/alfa .. 1.25
Type drawing Period - 1.2
= Freq.Hzsm/s*2 o
1 [Hz,s,m/s2] 0,00 /0,00 /0,200 I
2 [Hz,sm/is"2] 0,33/3,03 /0,466 08
3 [Hzsm/is2] 0,50 /2,00 /0,560 1
4 [Hz,5,m/s*2] 1,00 /1,00 /0,890 06
5 [Hz,s,m/s*2] 1,50 /0,67 /1,165 h
6 [Hz,s,m/s*2] 1,67 /0,60 /1,250 04
7 [Hz,s,m/s"2] 6,67 /0,15 /1,250
& [Hz,sm/s2] 100,00 /0,01 /1,0, 0.2
el Il
s
0.0l
o [ o wr = vl = vl
= = — — o od o o5

Finite element mesh and solver setup

The finite element mesh has not been refined.

Mame

= General mesh settings

I Minirnal distance between two points [m] 0,001
[T —
Average size of 2d element/curved element [m] 1,000

Definition of mesh element size for panels Automatic

Average size of panel element [m] 1,000

The solver also has not been changed to neglect shear deformations.

o |
l = General
I MNeglect shear force deformation [ Ay, Az »> A)
Type of solver Direct
Number of sections on average member 10
Warning when maximal translation is bigger tha... 10000

Warning when maximal rotation is bigger than [... 100,0

Print time in Calculation Protocol i
Coefficient for reinforcement 1
= Dynamics
Type of eigen value solver Lanczos
Mumber of eigenmodes 2

Use IRS (Improved Reduced Systern) method

Produce wall eigenmode results (needed for ECt..
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Manual calculation of example 4-2x

Verification of modal participation factors
First, the Modal Participation Factors of the Eigen Frequency Calculation Protocol are verified.

As shown in the Deformation of Nodes, the normalized modal shapes for both modes were the

following:
Displacement of nodes Displacement of nodes
Eigen solution, Extreme : Node Eigen solution, Extreme : Node
Selection : All Selection : All
Mass combinations : CM1/1 - 0,53 Mass combinations : CM1/2 - 3,42
Modal shapes are dimensionless, units ar Modal shapes are dimensionless, units a
Node Case Ux Uz Node Case Ux Uz
[mm] | [mm] [mm] | [mm]
N1  |CM1/1-0,53 00| 00 N1 |CM1/2-3,42 0,0 00
N2 |CM1/1-0,53 61 0.0 N2 |cMm1/2-3,42 | 258 0,0
N3 |CM1/1-0,53 | 20,8 0,0 N3 |cM1/2-3,42 | 305 0,0
N4 CM1/1-0,53 39,1 0,0 Na CM1/2 - 3,42 20,2 0,0

0,039111 ~0,020233
(o) = 0,020803 (0,1~ 0,030451
?15770.006128 P27 0025755

0 0

Participation factor: 7, ;, ={4}" -{m}
= 7y = 0,039111 - 500 + 0,020803 - 500 + 0,006128 - 500 = 33,021
= ¥y,2 = —0,020233 - 500 + 0,030451 - 500 + 0,025755 - 500 =17,984

Effective mass: Mk'ef’(j) = 7/k2,(j)
>M, 0= (33,021)2 =1090,39
=M, .0 = (17,984)2 =323,42

ici i i _ Mk,ef,(j)
Participation mass ratio: Lk,(j) =——"7
k,tot
=L = 109039 =0,7269
’ 500+ 500+ 500
L 323,42 0.2156

@ ~ 500+ 500+500

These results correspond to the results obtained by SCIA Engineer. They can be found in SCIA
Engineer in the Calculation protocol (Eigen frequency).

Modal participation factors

Mode (Omega Period Freq. Wi f Wi / Wizi f Wxi R/ |(Wyi R/ (Wzi R/
[rad/s] [s] [Hz] Whitot Wytot Wrztot Wxtot R (Wytot R |Spectral
1 3.3007 1.5036 0.5253 0.7269 0.0000 0.0000 0.0000 0.2721 0.0000
2 21.5192 0.2320 3.4245 0.2157 0.0000 0.0000 0.0000 0.5283 0.0000
0.9426 0.0000 0.0000 0.0000 0.8010 0.0000
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Details of the seismic calculation

Next, the details of the seismic calculation found in the Calculation Protocol for the Linear
Calculation are verified.

Dynamic loadcase: 2:1C2

Mode Freq. Damp Sax Say Saz G(j) Fx Fy Mx My
[Hz] ratio Damp | coe | [m/s*] [m/s%] [m/s?] [kM] [kN] [kNm] [kNm]
1 0.5253 0.0500 1.0000 0.2019 0.0000 0.0000 0.6119 0.2201 0.0000 0.0000 -2,2008
2 3.4245 0.0500 1.0000 0.4380 0.0000 0.0000 0.0170 0.1417 0.0000 0.0000 -0.4050
Level= 0.00 0.26 0.00 0.00 2.24

The spectral acceleration Sax for both modes is calculated using the defined seismic spectrum.
The spectrum for Ground Type B with a Behavior Factor q = 2 gives the following values for Sd(T)/a

Frequency[Hz] Period[s] Acceleration[m/="2] |
1 |0,00 0,00 0,20
2 0,33 3,03 047
3 |0,50 2,00 0,56
4 1,00 1,00 0,89
5 1,50 0,67 117
6 |1,67 0,60 125
7 |6,67 0,15 125
8 100,00 0,01 1,00
= nnn i nn nnn

The first mode has a period T1 of 1,9036 s = Sd(T1)/a = 0,5918 m/s?
The second mode has a period T, of 0,2920 s = Sd(T2)/a. = 1,25 m/s?
In this example, the coefficient of acceleration o was 0,35

— m . — m
=8, =05918M/,:035 0,207/,

= m . = m
= Sax,(Z) =125 Az 0,35 0,437542

These results correspond to the results obtained by SCIA Engineer. The small deviation is due to the
fact that SCIA Engineer uses more decimals. In the further analysis, the spectral accelerations of SCIA
Engineer are used.

Mode coefficient: G Sakii) Tki)

k() =
j o
G, - 0,2019-33,?21 _ 06119
' (3,3007)
04380-17,984 _ 1\

M T (21,5102

These results correspond to the results obtained by SCIA Engineer.

182



The necessary intermediate results are calculated so the response of each mode can now be obtained.
First, for each mode, the lateral force in each node can be calculated. These lateral forces can then be
used to calculate the base shear and overturning moment.

Mode 1:
Lateral force in node i: Fi,k,(j) =My iy 'Sa,k,(j) Yy '¢|,k,(j)

Fy o = 500kg -0,2019% ,-33,021-0,039111=130,38N
F, . o) = 500kg -0,2019%2 :33,021-0,020803 = 69,35 N

F, o = 500kg -0,2019% ,-33,021-0,006128 = 20,43N
Fio =ON

Base Shear Force: F, ;) = Z F o
i

=F,4=130,38N +69,35N +20,43N = 220,129 N = 0,2201 kN

Overturning momentin node i: M, , ;y =F,, ;)" Z,
M,,q =—130,38N-12m = -1564,50 Nm
M;, o =—69,35N-8m=-554,77 Nm

M 2y, = —20,43N -4m =-81,71Nm
M, =0Nm

Overturning Moment: M, ;) = Zl\/li’k'(j)
i

=M, ;= —~1564,50 Nm — 554,77 Nm —81,71Nm = ~2200,89 Nm = -2,2009 kNm

Note:

In this mode, all lateral forces in the nodes are oriented the same way. The lateral loads in the nodes are in
this case oriented in the negative X-direction so the Base Shear Force is oriented in the positive X-direction.
The lateral loads in the nodes thus produce a negative Overturning Moment around the Y-axis. An example of
this principle can be found in reference [26].

However, as stated in the previous chapters, the signs have no absolute importance since vibration amplitudes
always occur on both sides of the equilibrium position.

Mode 2:
Lateral force in node i: Fi,k,(j) =M (i) -Sa’k](j) Yy '¢l,k,(j)

F. «.z =500kg-0,4380 r%z -17,984--0,020233=-79,69N
F;. 2 =500kg-0,4380 r%z -17,984-0,030451=119,93N
F, .. =500kg-0,4380 r%z -17,984-0,025755=101,44N
Fx2=0N

Base Shear Force: F ;= Fi\ ()

=>F, 2=-79,69N +119,93N +101,44 N =141,68 N = 0,1417 kN
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Overturning moment in node i: Mi’k’(j) =Fi %
My, = 79,69N-12m = 956,25 Nm
M;, ) =—119,93N-8m =—-959,45 Nm
M,y =—101,44 N -4m = -405,74 Nm
M., 2 =0Nm

Overturning Moment: M, ;) = ZMi’k’(j)
i

=M, o= 956,25 Nm — 959,45 Nm — 405,74 Nm = —408,94 Nm = -0,4089 kNm

To obtain the global response, the modal responses need to be combined. In this example the SRSS-
method was used:

Fo=(Fuo f +(Fo f =(0,2201kN Y +(0,1417kNY =0,2618 kN

M, = \/('V' o f + (M, F = J(=2,2009kN }? + (- 0,4089kN }? =2,238 kNm

These results correspond exactly to the results obtained by SCIA Engineer. We will show them again:
Dynamic loadcase: 2: 102

Maode Freq. Damp San say Saz Gli) |I: Fy Mx My |
[Hz] ratio Damp | coe | [m/s*] [m/s*] [mf's*] [kN] [kM] [kNm] [kMm]
i 0.5253 | 0.0500 1.6000 0.2015 | 0.0000 | 0.0000 | 0.6119 0.2201 || 0.0000 | o0.0000 J -2.2008
2 3.4240 0.0500 1.0000 0.4380 0.0000 0.0000 0.0170 0.1417 0.0000 0.0000 0.4030
Level= 0.00 | 02 | o0uo0 ooo | 2|

As specified in the theory, these same principles can now be used to calculate the displacements and
accelerations for each mode. These modal responses can then be combined again to obtain the global
displacements and accelerations of the structure.

Mode 1.
Displacement in node i: U;, iy =Gy (i) "))

Uy = 0,6119-0,039111 = 0,02393 M =23,93 mm
U, = 0,6119-0,020803 = 0,01273 M =12,73 mm
U, o =0,6119-0,006128 =0,00375 M =3,75 mm

U« ) =0mm

Acceleration in node i Uy, = @) -Gy () * i)
a,, o =(33007)°-0,6119-0,039111=0,26073" (2 =260,73 mm/s?
2, o = (33007)°-0,6119-0,020803=0,13868" (2 =138,68 mm/s?
3, =(3,3007)-0,6119-0,006128 = 0,04085%2 = 40,85 mm/s2
Ay =0 mm/s2

Mode 2.
Displacement in node i: U;, iy =Gy (i) " @)

Uy, ) = 0,0170-(~0,020233) = —0,00034 m =-0,34 mm
Uy oy = 0,0170-0,030451 = 0,00052 m =0,52 mm
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U, ) =0,0170-0,025755 = 0,00044 m =0,44 mm

Uy x (2 =0mm

Acceleration in node i U ;) = a)(zj) ‘Geii) Piii)
a,, » =(215192)-0,0170-(-0,020233) = -0,15928M (> =-150,28 mm/s?
Ay = (21 5192) -0,0170-0,030451=0,23972M e 239,72 mm/s?
8, =(215192)°-0,0170-0,025755 = 0,20275%2 =202,75 mm/s?

Ay o) = 0 mm/s?

To obtain the global response, the modal responses need to be combined. In this example the SRSS-
method was used:

Displacements:

= U+ U f =(2393F +(-0,34) =23,93mm
u, =\/(3x(1))2 Uy f =/12,73F + (052 =12,74 mm

\/(u2X 1))z (uzX(z))Z \/3,75)2+ (0,44) =3,78 mm

ul,x =0mm

Accelerations:

8, = (@ f + @iy f =/(260,73) +(~159,28) = 305,53 mmis?
8, =\ (s f + (o f = (138,68) +(239,72) =276,94 mmis

a,, = \/(az,xy(l))z (a0 f = J(40,85) +(202,75)F =206,82 mmis?
a, , =0 mm/s2

In SCIA Engineer, a specific result menu Seismic Detailed was designed to view these modal
displacements and accelerations.
In the Properties Window, the options for viewing the modal results can be set:

Results 1 x Properties 1 x
Seismic detailed (1) BT IY

----- ¥ Displacement of nodes
""" 7 Deformed Structure

£ 3D displacement Name Seismic detailed

&2 3D stress Selection Al -
E-£ Supports Type of loads Load cases -
Eﬂ"; Beams Load cases LC2 - Seismic -
= Dynamics Filter Mo "

""" %85 Eigen frequencies -
...... ﬁ Acceleration of nodes Modal results Accelerations -
----- hdD Seismic detailed Evaluation for Sum -
[ Bill of material Values Deformed mesh -
'ﬁ‘;;l Calculation protecol Extreme Mo -

— Inthe field Load Cases, a Seismic Load case can be selected.
— The field Modal results allow choosing between the Displacements or Accelerations.

— Evaluation for is used to specify which results need to be shown: the results for a specific
Eigenmode, the results for All Eigenmodes or the global, Summarized results.
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The results for each mode and the summarized results are shown on the next pages for both the
displacement and the accelerations.

Displacements
Mode 1

IRRRARRARARRIAAE
Seismic detailed

Linear calculation, Extreme : No
Selection : All

Load cases : LC2

Modal results : Displacements
Evaluation for : Eigenmode 1

Node X Y rd Ux Uy Uz Fix Fiy Fiz
[m] [m] [m] [mm] [mm] [mm] [mrad] [mrad] [mrad]
N1 0,000 0,000 0,000 0,0 0,0 0,0 0,0 0,0 0,0
N2 0,000 0,000 4,000 3,7 0,0 0,0 0,0 1,7 0,0
N3 0,000 0,000 8,000 12,7 0,0 0,0 0,0 2,6 0,0
N4 0,000 0,000 12,000 23,5 0,0 0,0 0,0 2,9 0,0
Mode 2

INRRARRIRARRARR]
Seismic detailed

Linear calculation, Extreme : No
Selection : All

Load cases : LC2

Madal results : Displacements
Evaluation for : Eigenmode 2

Node X Y z Ux Uy Uz Fix Fiy Fiz
[m] [m] [m] [mm] [mm] [mm] [mrad] [mrad] [mrad]
N1 0,000 0,000 0,000 0,0 0,0 0,0 0,0 0,0 0,0
N2 0,000 0,000 4,000 0,4 0,0 0,0 0,0 0,1 0,0
N3 0,000 0,000 3,000 0,5 0,0 0,0 0,0 -0,1 0,0
N4 0,000 0,000 12,000 0,3 0,0 0,0 0,0 0,3 0,0

Summarized

TRRETRERnnennnnl
Seismic detailed

Linear calculation, Extreme : No
Selection : All

Load cases : LC2

Maodal results : Displacements
Evaluation for : Sum

Node X Y z Ux Uy Uz Fix Fiy Fiz
[m] [m] [m] [mm] [mm] [mm] [mrad] [mrad] [mrad]
N1 0,000 0,000 0,000 0,0 0,0 0,0 0,0 0,0 0,0
N2 0,000 0,000 4,000 3,8 0,0 0,0 0,0 1,7 0,0
M3 0,000 0,000 8,000 12,7 0,0 0,0 0,0 2,6 0,0
N4 0,000 0,000 12,000 23,5 0,0 0,0 0,0 2,5 0,0
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Accelerations

Mode 1

Seismic detailed

Linear calculation, Extreme : No

Selection : Al

Load cases : LC2

Modal results : Accelerations
Evaluation for : Eigenmode 1

Case Node X Y z Ax Ay Az Alphax Alphay Alphaz
[m] [m] [m] [mmys?] [mmys?] [mim/s*] [mrad/s®] | [mrad/s?] | [mrad/s*]
Lc2 N1 0,000 0,000 0,000 0,0 0,0 0,0 0,0 0,0 0,0
Lc2 N2 0,000 0,000 4,000 40,5 0,0 0,0 0,0 18,8 0,0
Lc2 N3 0,000 0,000 8,000 138,7 0,0 0,0 0,0 28,6 0,0
Lc2 N4 0,000 0,000 12,000 260,7 0,0 0,0 0,0 3.4 0,0
Mode 2
(ARRARRRRRRRIRN]
Seismic detailed
Linear calculation, Extreme : No
Selection : All
Load cases : LC2
Modal results : Accelerations
Evaluation for : Eigenmode 2
Case Node X Y z Ax Ay Az Alphax Alphay Alphaz
[m] [m] [m] [mm/s?] [mm/s3 [mm/s?] [mrad/sq | [mrad/s?] | [mrad/s’]
LC2 N1 0,000 0,000 0,000 0,0 0,0 0,0 0,0 0,0 0,0
LC2 N2 0,000 0,000 4,000 202,59 0,0 0,0 0,0 57,0 0,0
Lc2 N3 0,000 0,000 8,000 235,39 0,0 0,0 0,0 -51,2 0,0
LC2 N4 0,000 0,000 12,000 -159,4 0,0 0,0 0,0 -123,5 0,0
Summarized
AR AR NIRRERR]
Seismic detailed
Linear calculation, Extreme : No
Selection : All
Load cases : LC2
Modal results : Accelerations
Evaluation for : Sum
Case Node X Y z Ax Ay Az Alphax Alphay Alphaz
[m] [m] [m] [mm/s] [mm/s] [mm/s?] [mrad/s?] | [mrad/s?] | [mrad/s?]
Lc2 N1 0,000 0,000 0,000 0,0 0,0 0,0 0,0 0,0 0,0
Lc2 M2 0,000 0,000 4,000 207,0 0,0 0,0 0,0 60,0 0,0
Lc2 M3 0,000 0,000 8,000 2771 0,0 0,0 0,0 58,6 0,0
Lc2 M4 0,000 0,000 12,000 305,60 0,0 0,0 0,0 127,4 0,0

When comparing the results of the manual calculation and those obtained by SCIA Engineer, it is clear
that both calculations correspond.

As specified in the theory, when using the CQC-method, a damping spectrum needs to be defined. To
illustrate this, the above example is calculated again, but now using the CQC-method for the modal
combination.
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Annex D: Missingmassinmodes

As mentioned before, the sum of the effective modal masses for the modes taken into account must
amount to at least 90%. The user can try to achieve this with the following possibilities:

- Take more natural frequencies into account.
- Assign mass more to nodes/connection instead of beams (to avoid local eigenmodes).

The mass which has not been taken into account (for example, if the effective modal mass is 90%,
then there is 10% not taken into account), can be treated in 3 possible different ways in SCIA Engineer:

Mass in analysis

Participation mass only -
Missing mass in modes -
Fesidual mode (o

The used method is set in each seismic load case and is again displayed in the linear calculation
protocol. Let’s take as example that the effective modal mass in a direction is 90%. Then how can the

other 10% be treated?

- Participation mass only: In this case, the 10% would be ignored. We would only take into
account 90% of the mass of the structure to calculate the effects of an earthquake.

- Missing mass in modes: In this case, the missing mass would be divided over the calculated
modes. Which means the 10% would be distributed over the eigenmodes which make up for the
90% which we did find. This is done according to their weight. So for the calculation of internal
forces and deformations, the masses in the calculated modes would be increased by 100%/90%
=1,111...

- Residual mode: In this case, a ‘fictual’ mode corresponding to the combination of all missing
modes can be calculated. But since these missing modes are over different natural frequencies,
the last found frequency will also be the natural frequency of this mode. In the calculation, the
forces in this mode will be calculated in the same way as in the other modes.

In the following examples the differences are explained in detail.

In these projects the following general principle is used:

First of all, a seismic spectrum is introduced. For this spectrum the modal displacements are calculated
for each mode, in this case there are 2 modes. Afterwards, the displacements are transformed in real
load cases. For these 2 load cases the results of the internal forces and reactions can be asked.
According to the specific analysis method, the results are summed. On that way, one can compare
these results with the output of the internal forces of the seismic load case. This will be done with the
following three types of ‘mass in analysis’.

Remark: The used method is displayed in the linear calculation protocol.
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Example D-1: Participating_mass_only.esa

If the option ‘Participation mass only’ is checked, the standard calculation is used. In this case, only the
participation mass from the selected number of modes is taken into account and the user has to
consider the 90% rule of the Eurocode. In other words, using this method it's important that the total
amount of the masses in X, Y and Z are sufficient.

In the example, a structure made of beams with rectangular cross-sections is subjected to dynamic
forces. The members are manufactured in C25/30 according to EC-EN. The height of each column is
5m.

Next, a seismic load case is introduced. The seismic spectrum acts in 3 directions. An acceleration of 2
m/s”2 is given in function of the frequency.

The evaluation method SRSS is used together with the option ‘Participation mass only’.

The Eigen frequency analysis gives the following output:

(RN AR RRRNR]]
Eigen frequencies

N |f omega | omega® [T
[Hz] ([1/s] |[[1/s1] [s]
Mass combination : CM1
1 |2,05 |12,50 |166,40 0,49
2 (2,35 15,03 [225,B1 0,42

Deformation for mass combination CM1/1-2,05 :

Mass combinations - CM1/1 - 2,05
Yalues are mulitpied by 10000 for better numeric representation.
Node of mesh Case Ux Uy Uz Fix Fiy Fiz

[1] 1] [1] [1] 1] 1]
1 Ch1i1- 2,05 0,00 0,00 0,00 0,00 0,00 0,00
2 CwW1i1- 2,05 -12 67 151,53 0,42 -3.37 -20,19 -0.68
3 Ch1i1- 2,05 0,00 0,00 0,00 0,00 0,00 0,00
4 Ch1/1- 2,05 -7, 78 151,53 -0.38 -3.40 -1.54 -0.77
5 Cw1i1- 2,05 0,00 0,00 0,00 0,00 0,00 0,00
5 CMW1/1- 2,05 -TLTT 156,36 0,01 -43.20 -2,72 -1.1%5
7 Cw1i1- 2,05 -12 65 156,37 128,92 -42.72 -13.54 -1.,54

Deformation for mass combination CM1/2-2,39:
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Mass combinations : CM1/2 - 2,39

YValues are mulitpied by 10000 for better numeric representation.

Node of mesh Case Ux Uy Uz Fix Fiy Fiz
[1] [1] [1] [1 [1 [1]

1 Ch1/2 -2 39 0,00 0,00 0,00 0.00 0,00 0,00

2 Ch1i2- 2 39 133,69 -196,89 -0,10 2,39 -6,12 42,74

3 ChM1i2- 2 39 0,00 0,00 0,00 0,00 0,00 0,00

4 Ch1/2- 2 39 4,291 -196,89 0,22 2,386 -0,76 45,54

5 ChM1i2- 2 39 0,00 0,00 0,00 0,00 0,00 0,00

5 Ch1/2- 2 39 4,31 93,186 -0,01 -24.03 0,71 35.49

7 Ch1/2- 2 39 133,67 93 17 71,21 -28,81 -7,95 47,31

The masses of the participating nodes (N2, N4, N5 and N7) are needed. The mass is attributed to the
end nodes of each member.

N

NI

NE

Calculation of mass X for N2:

Mass X (N2) = 2500 kg/m”3 x(2,5 x area (rect 150;150) + 3 x area (rect 300;150) + 1,5 x area (rect
300;150) = 646,875 kg.

The total mass matrix is:

node mass x mass y mass £
[ka] [kg] [ka]
N2 646,875 646,875 646,875
N4 646,875 646,875 646,875
N5 7875 7875 7875
N7 1537,5 1537,5 1537.5
total 3618,75 3618,75 3618,75

The modal participation factor is calculated as:

Teep = {¢'k }T Ty = {¢k }T {m}

Calculation of y_x for mode 1:

0 0
~0,001267 646,875

0 0
{#,0)} =1-0,000778 b and {m, } =+ 646,875
~0,001265 787,5

0 0
~0,000777 1537,5

190



= ¥y =—0,001267-647-0,000778-647-0,001265- 788 —-0,000777-1538 = -3,514

The participation factor matrix is:

(i Y_X Y ¥_Z
units [kg™0.5] [kgt0.5] [kgt0.5]

1 3,514 55,959 10,158

2 20,115 -3,812 5,614

Out of this matrix the effective masses can be calculated:

2
Mef, ;) = 7w

Calculation of Mef for mode 1 in direction x:
= My o) =—3,514° =12,346

il Mlef x hef vy Mef 7
units (k] (k] (k]

1 12,346 3131374 103,182

2 404 603 14 533 21,517

The formula for the participation mass ratio is as follows:

L — Md:k,(j)
DT Mitet
TR
©3618,75
) L_x L_y Lz
units [-] [-] []
1 0,0034 0,8653 0,0285
2 0,118 0,0040 0,0087

The acceleration response spectrum S has the constant value of 2 m/s"2:

il S Sy =5z
[misec?] [misec?] [misec?]

1 2 2 2

2 2 2 2

Calculation of mode coefficient in each direction:
_ S Ve

For example for direction x and mode 1:

2--3,514
= Gx,(l) = W = —0, 042
{0 G_x G_y G z G
(k0. 5] (k0. 5] [r™kg"0.5] [r™kg"0.5]
1 -0,042 0,673 0,122 0,7524
2 0178 -0,034 0,050 0,1941

Now, the lateral forces can be calculated in each node:

_ . ‘1 o . . . 2
Fcy = My Uiy = Miay “ Gy - by - )

As example, this is calculated for node 2 in direction X:
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= Fuyz. 0 = 646,875-0,7524-(~0.001267)-166,4 = ~102,6N

mode 1
node F_x(1) F w1y F_z(1)
[N] [M] [N]
2 -102.6 12273 34
4 -63.0 12273 -29
5 -124.7 15418 12711
7 -149.6 30100 0,2
SUMIM -439.9 70068,3 12718
mode 2
node F_x(1) F_w(1) F_z{1}
[N] (] [N]
2 3781 -558.3 -03
4 12,2 -558.3 0.6
5 4614 3218 2458
7 29,0 6278 -0.1
SUMIM §81.7 =167 1 2461

And also the shear forces in direction X, Y and Z:
For mode 1 in direction x:

Fem = ZFi,k,(j)l

Foy = 4399 _ 0, 4309kN
@ 1000

il F x F v F z
units [kM] [kM] [kt]

1 -0,4399 7.0063 1,2718

z 0,8817 -0,1671 0,2481
SUMm 0,99 7,01 1,30

The overturning moment in each node for each direction is:
N

I F z

i = Nk 2
=M NZx(D) = FNz]y’(l) -(height - overturning height)
=1227,3N - (5m—-0m) =-6136,4Nm

The other values are:

mode 1
node (1) h_y(1)
[MNm] [Mm]
2 -6136.4 5131
4 -6136.4 3151
5 -7709.0 6236
7 -15049,9 7479
mode 2
node M_x(2) M_y(2)
[MNm] [Mm]
2 27914 -18954
4 27914 -60.3
5 -1608,1 -2307 1
7 -3139.2 -145,2

The sum of the moments for each node gives the overturning moment in base:
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{3 M_x
Lnits [k]

1 -35,0317

2 0,8355 -4, 4085
SUmMm 35,04

The moments for each separate mode are combined with the SRSS-method.

Calculation of the modal displacement:

Uy =Gy " gy

For instance for node 2 in direction X and first mode:
{Gy}=1{0,7524} and {gy,, | ={-0,001267}
= Uy = (0,7524--0.001267) -1000 = -0, 95mm

Other values are:

mode 1
node Lix Uy UZ
[rm] [rm] [rm]
2 -0,05 11,40 0,03
4 -0,59 11,40 -0.03
5 -0,85 11,77 8,70
7 -0,58 11,77 0,00
mode 2
node Lix Uy UZ
[rom] [rm] [rmm]
2 260 -3,82 0,00
4 0,08 -3.82 0,00
5 258 1,81 1,38
7 008 1.81 0,00
summ
node Lix Uy Uz
[mm] [rm] [rnm]
2 276 12,03 0,03
4 058 12,03 0,03
5 276 11,40 9,80
7 054 11,80 0,00

Calculation of the modal acceleration:

i 2% *
Upin = @ " Gy

30

For instance for node 2 in direction X and first mode:
= Uy @ =—0,95-166,4 = —158,6mm/s’
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mode 1
node ax ay az
[mmisec?] [mmisec?] [mmésec?]
2 -158.6 18972 53
4 -97.4 18972 -4.5
5 -158.4 1957.8 1614,2
7 -97.3 19577 0.1
mode 2
node ax ay az
[mmisec?] [mmisec?] [mmisec?]
2 586,0 -863,0 -04
4 18.8 -863.0 1.0
5 5859 408 4 3121
7 18.9 4084 0.0
summ
node ax ay az
[mmisec?] [mmisec] [mmisec?]
2 5071 20843 53
4 99,2 2084,3 48
5 5069 2000,0 16441
7 99,1 19999 0.1

Next, the displacements are inputted on the structure by means of a load case, namely translation of

support:

Support in node | Load case Dyir Value - U Support in node | Load case Dyir Value - U

[mm] [mm]

Snd LC3 X -0,95 Snd LC4 X 2,60

5n7 LC3 X -0,95 5n7 LC4 X 2,60

5ng LC3 X -0,59 5n5 LC4 X 0,08

Snf LC3 X -0,59 ala] LC4 X 0,08

Snd LC3 Y 11,40 Snd LC4 Y -3,82

5ng LC3 Y 11,40 5n5 LC4 Y -3.82

5n7 LC3 Y 1,77 5n7 LC4 Y 1,81

Snf LC3 Y 1,77 Snf LC4 Y 1,81

Snv LC3 zZ 9,70 5n7 LC4 zZ 1,38
For these load cases the following internal forces are computed:
Linear calculation, Bxtreme - Member System © Principal
Selection ; All
Load cases : LC3
Member Case dx N Vy Vz Mx My Mz

[m] [kN] [kN] [kN] [kNm] [kNm] [kNm]

B1 LC3 0 4,38 -1,35) 0,36 0,01 -0,49 3,44
B1 LC3 5 4,39 -1,39) 0,38 0,01 1,29 -3,3
B2 LC3 0 -3,73 -1,35 -0,04 0,01 0,12 3,44
B2 LC3 5 -3,73 -1,3%) -0,04 0,01 -0,06 -3,3
B3 LC3 0 0,62 -4,32 0,78 0,28 6,54 18,85
B3 LC3 5 0,52 -4,32 -0,7§ 0,28 2,65 -2,73
B4 LC3 0 0| 0,35 0,08 4,43 -1,48 0,4
B4 LC3 3 0 0,35 0,08 -4 43 -1,24 0,63
B5 LC3 0 0| 0,12 -1,19 1,48 2,69 0,35
B5 LC3 [ 0) -0,12 -1.19 1,48 -4,43 0,4
B6 LC3 0) 0 0,12 0,54 1,49 -1,46 0,33
B6 LC3 [ 0) -0,12 0,54 1.49 1,78 -0,36
B7 LC3 0) 0 0,23 -3,19 -1,4 478 -0,35
B7 LC3 3 0 0,23 -3.19 =14 -4,8] 0,34
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Linear calculation, Extreme : Member, System : Principal
Selection - All
Load cases - LC4
Member Case dx N y b4 M x My Mz
[m] [kN] [kN] [kN] [kNm] [kNm] [kNm]
B1 L C4 0| -0,27 0,46 0,36 0,15 0,88 -1,17]
B1 L C4 5 -0,27 0,46 0,28 -0,15] 0,94 1,15
B2 L C4 0| 0,59 0,46 0,01 0,16 0,03 -1,17]
B2 L C4 5 0,59 0,46 0,01 -0, 18] 0,04 1,15
B3 L C4 0| -0,08 0,77 0,49 -2,26 -1,52 3,07
B3 L C4 5 -0,08 -0.77 0,49 -2,26) 0,94 0,76
B4 L C4 0| 0 0,55 -0,08 0,91 0,25 0,12
B4 L C4 3 0) -0 55 -0,08 -0,91 0,5 -1,78
E5 L C4 0| 0 0,05 -0,33 0,25 1,04 0,2
E5 L C4 B 0) -0.05] -0,33 0,25 0,91 0,12
B6 LC4 0 0 0,13 0,01 0,26 -0,08] 0,31
B6 LC4 B 0) -0.13 0,01 0,26 0,03 0,48
B7 LC4 0 0 0,08 0,6 0,1 0,9 -0,05
B7 LC4 3 0) 0,08 0.8 -0.1 0,89 0,14
According to the SRSS-method the following formula is used:
N 2
Reot = Z R
j=1
Take for instance the normal force in member B1:
2 2
Nt = \/(4, 38kN )" +(-0,27kN)” = 4.39kN
Member dx N Vy Vz Mx My Mz
[m] [kN] [kN] [kN] [kNm] [kNm] [kNm]
B1 0,00 4 30 1,43 0,51 0,15 1,01 363
B1 5,00 4 39 143 0,51 0,15 1,60 349
B2 0,00 3178 1,43 0,04 0,16 012 363
B2 5,00 378 143 0,04 0,16 0.07 349
B3 0,00 063 4,39 0,92 2,28 671 10,10
B3 5,00 063 4,39 0,92 2,28 281 263
B4 0,00 000 065 0.1 4,52 1.50 042
B4 3,00 000 065 0,11 4,52 1,34 1,89
BS 0,00 000 013 1.23 1,50 288 040
BS 5,00 000 013 1,23 1,50 4,52 042
B6 0,00 000 018 0,54 151 1486 045
B6 5,00 000 018 0,54 1,51 1,78 0,60
BY 0,00 000 024 3,25 1,40 4,86 035
B7 3,00 000 0,24 3,25 1,40 4,88 0,37
These values correspond with the internal forces for the seismic load case in the project.
The same can be done for the reactions:
Linear calculation, Extrerme : Node
Selection : All
Load cases ;| LIC3
Support Case Rx Ry Rz Mx My Mz
[kN] [kN] [kN] [kNm] [kNm] [kNm]
Sn1/N1 LC3 0,36 -1,35 -4,38 3,44 0,49 0,01
Sn2/NG LC3 0,78 -4,32 0,62 18,85 6,54 0,28
Sn3/N3 LC3 0,04 -1,35 373 3,44 0,12 0,01
Linear calculation, Extreme © MNode
Selection : All
Load cases : LC4
Support Case Rx Ry Rz Mx My Mz
[kN] [kN] [kN] [kNm] [kNm] [KNm]
Sn/M1 LC4 0,36 0,46 0,27 1,17 0,88 0,15
Sn2/NG LC4 0,49 0,77 0,08 3,07 -1,52 -2,26
SnaMa LC4 0,01 0,46 0,59 1,17 0,03 0,16

Calculation of the reaction for N1:

= R, =+/(~0,36kN)? +(~0,36kN)? = 0,51
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Support Case Rx Ry Rz Mx My Mz
[kN] [kN] [kN] [kNm] [kNm] [kNm]
Sn1/N1 LC2 0,51 1,43 4,39 3,63 1,01 0,15
Sn2/NG LC2 0,92 4,39 0,63 19,10 6,71 2,28
Sn3iN3 LC2 0,04 1.43 3.78 3.63 0,12 0,16

After verifying the results in ‘Spectral_analysis_participation mass only.esa’ for the seismic load case,
we can conclude that these values of the manual calculation correspond to the calculated values.
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Example D-2: Missing_mass_modes.esa

Consider the case that the following sum of masses is reached in direction X, Y and Z: respectively
30%, 80% and 10%.

With the option ‘missing mass in modes’, masses are added until a value of 100% is reached in each
direction. With other words, the missing mass is assigned to the known modes ( modes selected by the
user in the analysis) and then the modal deformations and forces can be computed. Afterwards it's
summed depending of the selected rule SRSS, CQC or MAX.

hass in analysis

Farticipation mass only .
bissing mass in modes ]
Fesidual mode .

Simply, in this case 70%, 20% and 90% masses are added.
This principle is explained on the previous example.
Instead of the option ‘participation mass only’ the option ‘missing mass in modes’ is checked.

As a result of the previous example, the values of the effective masses are:

) hWef x Mef v Mef 7
units [kal [kg] [kd]

1 12,346 3131,374 103,182

2 404,603 14 533 31,517

The masses in the free nodes are:

node MaASs x Mass i M&ss £
(kg] (kg] [kg]

N2 646,875 646,875 646,875

N 646,875 646,875 646,875
N5 7875 7875 7875

N7 1537.5 1537.5 1537.5

total 3618.75 3618.75 3618.75

After comparing the real masses and the effective masses in each direction, one can conclude that
there are ‘missing’ masses in the vibration analysis.
Take for instance the masses in direction X:

M, =3618,75kg — 416, 95kg = 3201,80kg

_ M, _320180kg _ o

R .
ST M, 416,95kg

M i1 = 7,679-12,346kg = 94,8kg
M i = 7,679-404,603kg = 3107kg
¥ Y z
htot 818,75 281875 281875
e ff 416,95 214591 134,70
hWmiss 3201.80 472,84 3484 05
r_miss 7679 0,150 25 865
(i hmis_x(j) rmis_y(il hmis_z(j)
[kd] [kd] [ka]
1 94,5 4707 2668,8
2 21070 2.2 8152
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Calculation of the participation factor for the missing mass:
Viiss k,j — sign {J/k,j}'(\/Mmiss,k,j + M _‘7k,j‘)

For instance for mode 1 in direction X:
= Vs = —(+/94,8kg +12,346kg —|-3,514|) = 6,8

() ymiss ]} ymiss_yl]) ymiss_Z{j)
[kg"D.5] [kgn0.5] [kg"0.5]

1 6.8 4.1 42,5

2 39.1 -0.3 235

To take the missing mass into account in the calculation, this participation factor is included in the
formula for the mode coefficient G:

G - 0 T T o T KD
kil = 5
(:)m

With Sa_cutoff: acceleration of ‘cut off’ frequency in direction k (i.e. last calculated frequency).
For mode 1 in direction X:

2--3,514+2--6,8

=Gy = =012
(i) G_x Gy Gz G
[M™kg"0.5] [M™kg"0.5] [M™kg"0.5] [M*kgh0.5]
1 -0,124 0,721 0,633 1,230
2 0,525 -0,038 0,258 0,746

From now on, the same procedure can be followed as in the normal method. The formula for the
lateral force in each node is:

Fiao = Minen Yy = My ©

. .2
W P “’UJ|

(646,875-1,23-(~12,67)-166,4)

= Fszxy(l) = 10000 =-167,7N
mode 1
node F x F oy Fz
[N] (] [M]
2 -167.7 20058 5.6
4 -103.0 20058 -4.8
5 -203,9 25199 20775
7 -244.5 4918 4 0,3
SUMIMm -719,0 11450,9 20786
mode 2
node F x F oy Fz
[M] (] [M]
2 1457 5 -2148.5 -1.1
4 48,8 2146 .5 24
5 17741 1236.6 9451
7 M7 24140 -0.3
SUMm 33901 -B42.5 9462

Next, the shear force in base is calculated:
. N
Fop = i Eripl
1

7

198



il F x F oy Fz
units [kM] [kM] (k]

1 -0,71490 11,4509 20786

? 3,290 -0,6425 0,9462
summ 347 11,47 2,28

Calculation of the overturning moment. The overturning height is 0:

™
Mi,kim = Fi,k,(]) Z
mode 1
node f 3 Ay
[Mm] [Mm]
2 -10029 .1 8386
4 -10029,1 5149
5 -12599.3 10193
7 -24597 0 12223
mode 2
node Ml x Wy
[Nrm] [Nrm]
2 107327 -T2687 8
4 107327 -233 0
5 -6182,9 -8870,5
7 -12070,1 -558 4

The sum of these moments gives the overturning moment in base:

(i) M_x M_Yy
units [KM] [kM]

1 -57,2545 23,5950

2 32,2124 -16,9504
sUmm 5734 17,33

Also the modal displacements can be calculated for each node:

Uiy = Sy ™ Prgpy
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mode 1
node LI Ly uz
[rnrm] [rnm] [rnm]
2 -1.56 18,63 0,05
4 -0,96 18,683 -0,04
5 -1,56 19,23 15,85
7 -0,96 19,23 0,00
mode 2
node LI Ly uz
[rrm] [rnrm] [rnrm]
2 998 -14,70 -0,01
4 0,32 -14,70 0,02
5 998 5,95 531
7 0,32 5,95 0,00
summ
node LI Ly uz
[rm] [rm] [rm]
? 10,10 2373 0,08
4 1,01 2373 0,05
5 10,10 2045 16,72
7 1.01 2045 0,00

The modal accelerations are:

o 2 * 4
Uigin =Dy "Gy Gy

mode 1
node ax ay az
[mmisec?] [mmisec?] [mmisec?]
2 -2549.3 31008 8,6
4 -159.2 31008 =74
5 -258.9 31998 26381
7 -158.0 31996 0,2
mode 2
node ax ay az
[mmisec?] [mmisec?] [mmisec?]
2 22832 -3318,3 -1.7
4 723 -3318,3 37
5 22528 15703 12002
7 726 15701 -0.2
summ
node ax ay az
[mmisec?] [mmisec?] [mmisec?]
2 22630 4541 .6 8.8
4 174.,9 45416 8,2
5 22677 35643 26953
7 174.8 35641 0,3

Analogous to the previous example, these displacements for each mode are transformed to 2 real load
cases. For these load cases the internal forces are analyzed:
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Member | Case dx N Vy Vz Mx My Mz
[m] [kN] [kN] [kN] [kNm] [kNm] [kNm]
B1 [C3 0 7,15 2,2 0,58 0,02 0,8 5,62
B1 [C3 5 715 27 0,58 0,02 2,1 5.4
B2 LC3 0 5,1 2,2 0,06 0,02 0,2 5,61
B2 LC3 B -6 1 272 0,06 0,02 0,1 5.4
B3 LC3 0 1,01 -7,05 1,26 0,46 10,62 30,8
B3 LC3 3 101 7,05 1,26 0,46 4,34 4,46
B4 LC3 0 0 0,57 0,13 7,24 2,41 0,66
B4 LC3 3 0 0,57 013 7,24 2,02 1,05
B5 LC3 0 0 0,21 1,94 2,41 4,39 0,57
B5 LC3 6 0 0,21 1,04 2,41 7,24 0,66
B6 LC3 0 0 0,19 0,88 2,44 2,39 0,55
B6 [C3 6 0 019 0,85 244 29 0,59
BY LC3 0 0 0,38 5,22 2,29 7,81 0,59
BY [C3 3 0 0,38 522 -2,29 7,84 0,57
Member Case dx N Vy Vz Mx My Mz
[m] [kN] [kN] [kN] [kNm] [kNm] [kNm]
B1 LC4 0 -1,04 1,78 1,39 0,59 -3,36 4,51
B1 LC4 B 1,04 173 1,39 0,59 36 4,42
B2 LC4 0 2,28 1,79 0,06 0,63 0,13 -4,51
B2 LC4 5 2,28 1,79 0,06 0,63 0,16 4,42
B3 LC4 0 0,29 2,93 1,93 8,65 5,01 11,76
B3 LC4 5 -0,29 293 1,93 -3 65 3,66 2,88
B4 LC4 0 0 2,1 0,31 3,52 0,96 0,5
B4 LC4 3 0 2.1 031 352 -1,89 5,8
BS LC4 0 0 0,21 1,25 0,96 4 0,79
BS LCH 3 0 0,21 1.2 0,96 3,52 0,5
BE LC4 0 0 0,51 0,02 0,98 0,24 1,2
BE LCH 3 0 051 0,02 0,98 0,14 -1,85
B7 LC4 0 0 0,26 23 0,4 3,45 0,21
B7 LC4 3 0 0,26 23 0.4 3,44 0,57
Calculation of the normal force for member B1 according to the principle of SRSS:
= N = /(7,15kN )’ + (<1, 04kN )’ =7,23kN
The other internal forces are calculated in the same way:
Member | Case dx N Wy vz Mx My Mz
[m] [kN] [kN] [kN] [kNm] [kNm] [kNm]
B1 LC2 0,00 7.08 2,85 1,51 0,59 345 7.21
B1 LC2 5,00 7.23 2,83 1,51 0,59 417 6,96
B2 LC2 0,00 6,51 2,84 0,08 0,63 0.24 7.20
B2 LC2 5,00 8.51 2,84 0.08 0,63 0.19 6,98
B3 LC2 0.00 1,05 7.63 2.30 5.66 12,20 32,07
B3 LC2 5,00 1,05 7.63 2,30 5,68 5,68 5,31
B4 LC2 0,00 0,00 2,18 0,34 5,05 2,59 0,83
B4 LC2 3,00 0,00 2,18 0,34 5,05 277 6,58
B5 LC2 0,00 0,00 0.30 2,31 2,59 594 0,97
B5 LC2 6,00 0,00 0.30 2,31 2,59 8,05 0,83
B6 LC2 0,00 0,00 0,54 0,88 2,63 240 1,32
B6 LC2 6,00 0,00 0,54 0,88 2,63 2,90 1,04
B7 LC2 0,00 0,00 0.46 570 2,32 §.54 0,63
B7 LC2 3,00 0,00 046 570 2,32 §.56 0,81

This corresponds to the results for the seismic load case in SCIA Engineer:
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Support | Case Rx Ry Rz Mx My Mz
[kN] [kN] [kN] [kNm] [kNm] [kNm]
SN LC3 0,58 -2,2 -7,15 5,62 0,8 0,02
Sn2iNE LC3 1,26 -7,05 -1,01 30,8 10,62 0,46
Sn3M3 LC3 0,06 -2,2 6,1 5,61 0,2 0,02
Support | Case Rx Ry Rz Mx My Mz
[kN] [kN] [kN] [kNm] [kNm] [kNm]
SN LC4 -1,39 1,78 1,04 -4.51 -3,36 -0,59
Sn2iNG LC4 -1,93 -2,93 0,29 11,76 6,01 8,65
Sn3M3 LC4 0,06 1,79 -2,28 -4,51 0,13 0,63
Support | Case Rx Ry Rz Mx My Mz
[kN] [kN] [kN] [kNm] [kNm] [kNm]
Sn/M LC2 1,51 283 723 7,21 345 0,59
Sn2/NE LC2 2,30 763 1,05 32,97 12,20 8,66
Sn3/MN3 LC2 0,08 2,84 5,51 7.20 0,24 0,63

This corresponds to the reactions in SCIA Engineer (Calculation of Rz for LC2):

B
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Example D-3: Residual_mode.esa

The principle of the residual mode method is analogous to the method of the missing mass:

if there is too less mass taken into account with the standard method, more mass will be added to
satisfy the prescriptions of the EC.

The aim of this method is to evaluate the missing mass as an extra mode which is computed as an
equivalent static load case. The static load case represents the weight of the missing mass under the
cut-off acceleration. Afterwards it's summed depending the selected rule SRSS, CQC, MAX.

This is possible with the following option:
bass in analysis

Farticipation mass anly i

hissing mass in modes i

.

Residual mode

The difference with regard to the previous method is that the missing mass is taken in the seismic
analysis as an extra mode which represents the weight of the missing mass. The modal result of this
mode is computed by a static equivalent load case.

The effective masses are calculated for each separate node. In the other method, the effective mass
was determined for each direction in each mode. Now, this parameter will be calculated for each
different node in direction X,Y and Z for each mode. Later, this missing mass will be taken into account
by means of an extra load case.

Effective mass in node:
M,; “Deiyi M
Meff,k,(j),i =
1000- 7 |

eff k(i)

Calculation of the effective mass in direction X for mode 1 and N2:
646,875kg - (—12,67)-12,346
= Mt nowy = =29
10000-(-3,514)

effective mass in node {direction k, mode j)

mode 1 mMass ¥ mass vy mass z
[kal [kal [kal
2 29 5485 0,3
N4 1.8 5485 -0,2
NS 35 639,1 1031
NT 4.2 13453 0,0
12,346 3131,374 103,182
mode2 MAass ¥ Mass Y mass Z
[ka] [ka] [ka]
N2 1740 48,6 0,0
[ 56 48,6 0,1
NS 2117 -28.0 31,5
NT 133 -54.6 0,0
404,60 14,63 31,52
mode 1 & 2
mass x mass y mass z
[ka] [kal [kol
N2 176.8 5971 0,2
[k T4 5971 -0,2
NS 2152 661,1 1346
T 17.5 12907 0,0
416,9494 3145,9065 1346994
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The missing mass is the difference between the total mass for each node minus the effective mass:

= Missing mass,, , = 646,9-176,8 = 470kg

mass X massy mass z
k] [kg] k]
N2 470,0 49,8 646,6
N4 639,5 49,8 647,0
N5 572,3 126,4 652,9
N7 1520,0 246,8 1537,5

Out of these missing masses, load cases are generated. This by the formula:

— Load case;, = Missing mass; , - S, )

Remark:

The cut-off acceleration is the acceleration of the cut-off frequency, this is the last calculated frequency.

F x Fy Fz

[kN] [ka] [kd]
N2 0,940 0,100 1,293
N4 1,279 0,100 1,294
N5 1,145 0,253 1,306
N7 3,040 0,494 3,075
summ 6,4036 0,9457 6,9681

Calculation of the mode coefficient:

Sa, iy X Vi
_ (i) K.(i)
G k() — 2
@)
2 n% .—3,514kg"?
=G, = 3166 ] =-0,042m-kg"?
1] AZ
0)] G_x Gy G z G
[m*kg"0.5] [m*kg"0.5] [m*kg"0.5] [m*kg"0.5]
1 -0,042 0,673 0,122 0,752
2 0,178 -0,034 0,050 0,194
Calculation of the lateral forces:
.. 2
Fi,k.(n =My Yikay = Mk 'G(J) '¢|,k,<J) @)
646,9Kkg - 0, 75m-kg1’2 -—12,67mm-166 /2
=F,0= S_=-102,6N

10000
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mode 1

node F x(1) F y(1) F z(1)
[N] [N] [N]
2 -102,6 1227,3 3,4
4 -63,0 1227,3 -2,9
5 -124,7 1541,8 1271,1
7 -149,6 3010,0 0,2
summ -439,9 7006,3 1271,8
mode 2
node F_x(1) F y(1) F z(1)
[N] [N] [N]
2 379,1 -558,3 -0,3
4 12,2 -558,3 0,6
5 461,4 321,6 245,8
7 29,0 627,8 -0,1
summ 881,7 -167,1 246,1
Calculation of the shear force in base:
Foy = Z Fool
)] F x Fy F z
units [KN] [KN] [KN]
1 -0,4399 7,0063 1,2718
2 0,8817 -0,1671 0,2461
R 6,4036 0,9457 6,9681
summ 6,5 7,1 7,1

The overturning moment in each node is calculated as follows:

M

i.ki(j)

=F

*
UMK

The height zi is equal to the height of the concerning node minus the overturning height. In this case,

the overturning height is equal to zero.

mode 1
node M_x(1) M_y(1)
[Nm] [Nm]
2 -6136,4 513,1
4 -6136,4 315,1
5 -7709,0 623,6
7 -15049,9 747,9
mode 2
node M_x(2) M_y(2)
[Nm] [Nm]
2 27914 -1895,4
4 2791,4 -60,8
5 -1608,1 -2307,1
7 -3139,2 -145,2

In this case, an extra overturning moment is calculated for the residual load case:
= My, @ =0,94kN - (5m—0m) = -4, 7Nm
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mode R
node M_x(1) M_y(1)
[Nm] [Nm]
2 0,0 -4,7
4 0,0 -6,4
5 0,0 -5,7
7 0,0 -15,2

The letter R stands for the residual mode.

For each mode the sum of the overturning moments are taken, afterwards the results are combined

with the SRSS method:

() M_x M_y
units [kN] [kN]
1 -35,0317 2,1997
2 0,8355 -4,4085
R 0,0000 -32,0180
summ 35,0 32,4

Calculation of the modal displacement:

Uiy = Gy " Py
mode 1
node ux uy uz
[mm] [mm] [mm]
2 -0,95 11,40 0,03
4 -0,59 11,40 -0,03
5 -0,95 11,77 9,70
7 -0,58 11,77 0,00
mode 2
node ux uy uz
[mm] [mm] [mm]
2 2,60 -3,82 0,00
4 0,08 -3,82 0,00
5 2,59 1,81 1,38
7 0,08 1,81 0,00

To calculate the deformations for mode R, the load cases - generated out of the missing masses - are
inputted as real load cases on the nodes of the structure. This gives the following table:
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2. Deformation of nodes

Linear calculation, Extreme : Node
Selection : All
Load cases : LC3
Node Case Ux Uy Uz
[mm] [mm] [mm]
N1 LC3 0 0 0
N2 LC3 4,14 4,91 0,03
N3 LC3 0 0 0
N4 LC3 1,46 4,91 0
N5 LC3 4,14 8,25 6,74
N6 LC3 0 0 0
N7 LC3 1,45 8,25 0
The deformations for each mode (namely mode 1, mode 2 and mode R) are combined with the SRSS-
formula:
summ
node ux uy uz
[mm] [mm] [mm]
2 4,98 12,99 0,04
4 1,58 12,99 0,03
5 4,98 14,48 11,89
7 1,57 14,48 0,00
The same for the modal acceleration:
" 2
ui,k,(i) = @) *G(J) *¢ky(j)
mode 1
node ax ay az
[mm/sec?] [mm/sec?] [mm/sec?]
2 -158,6 1897,2 53
4 -97,4 1897,2 -4,5
5 -158,4 1957,8 1614,2
7 -97,3 1957,7 0,1
mode 2
node ax ay az
[mm/sec2] [mm/sec?2] [mm/sec?2]
2 586,0 -863,0 -0,4
4 18,8 -863,0 1,0
5 585,9 408,4 312,1
7 18,9 408,4 0,0
For mode R the constant value of 2000 mm/s”2 is used:
mode R
node ax ay az
[mm/sec?] [mm/sec?] [mm/sec?]
2 2000,0 2000,0 2000,0
4 2000,0 2000,0 2000,0
5 2000,0 2000,0 2000,0
7 2000,0 2000,0 2000,0
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This gives through the SRSS-method:

summ
node ax ay az
[mm/sec2] [mm/sec2] [mm/sec?]
2 2090,1 2888,7 2000,0
4 2002,5 2888,7 2000,0
5 2090,1 2828,4 2589,0
7 2002,5 2828,3 2000,0

In the same way as for the ‘missing mass method’ the calculated deformations are put on the structure
as real load cases. This gives the following internal forces:

Mode 1:
Linear calculation, Extreme : Member, System : Principal
Selection : All
Load cases : LC3
Member [Case dx N Vy Vz Mx My Mz
[m]  [[kN] [kN] [kN] [kNm] [kNm] [kNm]
Bl LC3 0 4,38 -1,35 0,36 0,01 -0,49 3,44
B1 LC3 5 4,38 -1,35 0,36 0,01 1,29 -3,3
B2 LC3 0 -3,73 -1,35 -0,04 0,01 0,12 3,44
B2 LC3 5 -3,73 -1,35 -0,04 0,01 -0,06 -3,3
B3 LC3 0 0,62 -4,32 -0,78 0,28 6,54 18,85
B3 LC3 5 0,62 -4,32 -0,78 0,28 2,65 -2,73
B4 LC3 0 0 0,35 0,08 -4,43 -1,48 -0,4
B4 LC3 3 0 0,35 0,08 -4,43 -1,24 0,63
B5 LC3 0 0 -0,12 -1,19 1,48 2,69 0,35
B5 LC3 6 0 -0,12 -1,19 1,48 -4,43 -0,4
B6 LC3 0 0 -0,12 0,54 1,49 -1,46 0,33
B6 LC3 6 0 -0,12 0,54 1,49 1,78 -0,36
B7 LC3 0 0 0,23 -3,19 -1,4 4,78 -0,35
B7 LC3 3 0 0,23 -3,19 -1,4 -4,8 0,34
Mode 2:
Linear calculation, Extreme : Member, System : Principal
Selection : All
Load cases : LC4
Member Case dx N Vy Vz Mx My Mz
[m] [kN] [kN] [kN] [KNm] [KNm] [kNm]
Bl LC4 0 -0,27 0,46 0,36 -0,15 -0,88 -1,17
Bl LC4 5 -0,27 0,46 0,36 -0,15 0,94 1,15
B2 LC4 0 0,59 0,46 0,01 -0,16 -0,03 -1,17
B2 LC4 5 0,59 0,46 0,01 -0,16 0,04 1,15
B3 LC4 0 -0,08 -0,77 0,49 -2,26 -1,562 3,07
B3 LC4 5 -0,08 -0,77 0,49 -2,26 0,94 -0,76
B4 LC4 0 0 -0,55 -0,08 -0,91 -0,25 -0,12
B4 LC4 3 0 -0,55 -0,08 -0,91 -0,5 -1,78
B5 LC4 0 0 -0,05 -0,33 0,25 1,04 0,2
B5 LC4 6 0 -0,05 -0,33 0,25 -0,91 -0,12
B6 LC4 0 0 -0,13 0,01 0,26 -0,06 0,31
B6 LC4 6 0 -0,13 0,01 0,26 -0,03 -0,48
B7 LC4 0 0 0,06 0,6 -0,1 -0,9 -0,05
B7 LC4 3 0 0,06 0,6 -0,1 0,89 0,14
Mode R:

208



Linear calculation, Extreme : No, System : Principal
Selection : All
Load cases : LC3
Member Case dx N Vy Vz Mx My Mz
[m] [kN] [kN] [kN] [kNm] [kNm] [KNm]
B1 LC3 0 4,232 -0,575 0,824 -0,134 -1,804 1,47
B1 LC3 5 4,232 -0,575 0,824 -0,134 2,314 -1,402
B2 LC3 0 -0,061 -0,574 0,244 -0,144 -0,559 1,47
B2 LC3 5 -0,061 -0,574 0,244 -0,144 0,661 -1,401
B3 LC3 0 2,798 -3,078 5,79 -2,301 -22,431 13,299
B3 LC3 5 2,798 -3,078 5,79 -2,301 6,521 -2,093
B4 LC3 0 -1,406 -1,192 0,005 -4,714 -1,048 0,818
B4 LC3 3 -1,406 -1,192 0,005 -4,714 -1,033 -2,759
B5 LC3 0 0,159 0,242 -1,301 1,048 3,092 -0,632
B5 LC3 6 0,159 0,242 -1,301 1,048 -4,714 0,818
B6 LC3 0 -1,527 0,164 -0,282 1,061 -0,117 -0,525
B6 LC3 6 -1,527 0,164 -0,282 1,061 -1,807 0,457
B7 LC3 0 0,039 -0,478 -1,637 -0,778 2,45 0,766
B7 LC3 3 0,039 -0,478 -1,637 -0,778 -2,461 -0,669
Combination via SRSS-method gives:
Member |Case dx N Vy Vz Mx My Mz
[m] [KN] [kN] [KkN] [KNm] [KNm] [KNm]
B1 LC2 0,00 6,10 1,54 0,97 0,20 2,07 3,92
B1 LC2 5,00 6,10 1,54 0,97 0,20 2,81 3,77
B2 LC2 0,00 3,78 1,54 0,25 0,22 0,57 3,92
B2 LC2 5,00 3,78 1,54 0,25 0,22 0,66 3,77
B3 LC2 0,00 2,87 5,36 5,86 3,24 23,41 23,27
B3 LC2 5,00 2,87 5,36 5,86 3,24 7,10 3,52
B4 LC2 0,00 1,41 1,36 0,11 6,53 1,83 0,92
B4 LC2 3,00 1,41 1,36 0,11 6,53 1,69 3,34
B5 LC2 0,00 0,16 0,27 1,79 1,83 4,23 0,75
B5 LC2 6,00 0,16 0,27 1,79 1,83 6,53 0,92
B6 LC2 0,00 1,53 0,24 0,61 1,85 1,47 0,69
B6 LC2 6,00 1,53 0,24 0,61 1,85 2,54 0,75
B7 LC2 0,00 0,04 0,53 3,64 1,60 5,45 0,84
B7 LC2 3,00 0,04 0,53 3,64 1,60 5,47 0,76
The reactions are:
Mode 1:
Linear calculation, Extreme : Node
Selection : All
Load cases : LC3
Support Case Rx Ry Rz Mx My Mz
[kN] [kN] [kN] [kNm] [KNm] [KNm]
Sn1/N1 LC3 -0,36| -1,35 -4,38 3,44 -0,49 0,01
Sn2/N6 LC3 0,78 -4,32 -0,62 18,85 6,54 0,28
Sn3/N3 LC3 0,04 -1,35 3,73 3,44 0,12 0,01
Mode 2:
Linear calculation, Extreme : Node
Selection : All
Load cases : LC4
Support Case Rx Ry Rz Mx My Mz
[KN] [KN] [KN] [KNm] [KNm] [KNm]
Sn1/N1 LC4 -0,36 0,46 0,27 -1,17 -0,88 -0,15
Sn2/N6 LC4 -0,49| -0,77 0,08 3,07 -1,52 -2,26
Sn3/N3 LC4 -0,01 0,46 -0,59 -1,17 -0,03 -0,16

Mode R:
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Linear calculation, Extreme : Node
Selection : All
Load cases : LC3

Support Case Rx Ry Rz Mx My Mz
[KN] [KN] [KN] [KNm] [KNm] [KNm]
Sn1l/N1 LC3 -0,82| -0,575 -4,232 1,47 -1,804 -0,134
Sn2/N6 LC3 -5,79| -3,078 -2,798 13,299 -22,431 -2,301
Sn3/N3 LC3 -0,24| -0,574 0,061 1,47 -0,559 -0,144
Summarized by SRSS:
Support |Case Rx Ry Rz Mx My Mz
[KN] [[kN] [KN] [KNm] [KNm] [KNm]
Sn1l/N1 LC2 0,97 1,54 6,10 3,92 2,07 0,20
Sn2/N6 LC2 5,86 5,36 2,87 23,27 23,41 3,24
Sn3/N3 LC2 0,25 1,54 3,78 3,92 0,57 0,22
Note:

In case of CQC, we don’t assume any correlation with the other modes (i.e. absolute value is added)

The cut-off frequency is the frequency of the latest modes in the analysis. It is the responsibility of the

user to select the correct number of modes. This can be done in the Setup > Solver.
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